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Recording

 

Recording and Playback Basics

 

The basic procedures for recording and playback are described in the Get-
ting Started book. Here is a brief repetition:

 

➜

 

To activate recording, click the Record button on the Transport 
panel or press [*] on the numeric keypad.

 

If your computer keyboard lacks a numeric keypad, you can activate re-
cording by holding down [Command] (Mac) or [Ctrl] (Windows) and 
pressing [Return].

 

➜

 

Recording starts at the current song position.

 

➜

 

You can get a metronome click during recording by activating Click 
on the transport panel.

 

The volume of the metronome click can be adjusted with the Level knob.

 

➜

 

If the Loop is activated, the area between the Left and Right locators 
will be repeated, allowing you to add or replace material on each 
loop pass (depending on the Overdub/Replace switch - see below).

 

➜

 

To start playback from the current song position, click the Play but-
ton or press [Enter] on the numeric keypad.

 

To stop, click the Stop button, press [0] on the numeric keypad or press 
[Return]. You can also toggle between Play and Stop by pressing the 
Space bar.

 

➜

 

To move the song position, click in the ruler, use the Rewind/Fast 
Forward buttons or edit the position numerically on the transport 
panel.

 

You can also move the song position to the Left or Right Locator by 
pressing [1] or [2] on the numeric keypad.

 

Recording Notes

 

The Overdub/Replace switch

 

If you record over an area where there are notes recorded already, the result 
depends on the Overdub/Replace switch on the transport panel:

 

➜

 

In Overdub mode, the new recording is added to whatever was on 
the Track before. 

 

For example, this is useful for adding elements during loop recording or 
for adding controller data to recorded notes.

 

➜

 

In Replace mode, the new recording replaces any previously re-
corded notes.

 

Only the notes in the actual recording area are replaced. 

 

!

 

It’s probably best to use Overdub mode as your default mode, to 

 

avoid removing material by mistake.

 

Quantizing during Recording

 

If the Quantize Notes During Recording switch is activated on the sequencer 
toolbar, notes will automatically be quantized when you record them. This is 
described in detail on page 29.

 

Recording Controllers

 

In Reason, you can automate virtually all device parameters, creating com-
pletely automated mixes if you like. This is done by recording (or drawing) 
controllers in the sequencer.

 

Before you record automation

 

Before you start recording automation of a parameter, you may want to set it 
to a suitable “static value”. By this, we mean the value the parameter should 
have whenever it isn’t automated in the song. Here is why:

 

➜

 

When you first record a section of automation for a parameter, its 
original value will be inserted throughout the rest of the song.

 

This is explained in detail on page 8.

Let’s say you want to create a fade-out by recording your lowering a fader in 
the Mixer. Then it’s a good idea to first set the fader to the correct static value 
(i.e. the value the fader should be set to before you start the fade-out). 

The same thing is true if you want to create a filter sweep for a synthesizer, 
somewhere within the song: First set the filter frequency to the value it should 
have elsewhere in the song, then record the filter sweep.
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Recording automation of a device parameter

 

1. Make sure there is a sequencer track for the device.

 

For the instrument devices and the Matrix, sequencer tracks are auto-
matically added when you create the device. For a mixer or effect device, 
you need to add tracks manually, by selecting “Create Sequencer Track 
for...” from the device context menu. You can also select “Sequencer 
Track” from the Create menu and connect the created track manually to 
the desired device (in the Out column in the track list).

 

2. Click in the In column for the track in the track list, so that a MIDI 
connector symbol appears.

 

This indicates that the track will receive MIDI and is ready for recording.

 

3. Start recording from the desired position.

4. During recording, adjust the desired parameter(s), from the device 
panel or from a MIDI controller.

 

You can record automation for several parameters in the same recording 
pass. However:

 

➜

 

You can only record automation for one device at a time (the device 
whose track receives MIDI). 

 

If you want to record automation for parameters on another device, you 
need to click in the In column for the corresponding track, so that the 
MIDI connector symbol is moved there.

 

5. Stop recording.

 

On the device panel, each automated parameter will have a green frame. 

 

The parameters Feedback and Pan are automated. 

In the Arrange view, recorded controllers are indicated in blue (the pale blue “strip” 
indicates that the track contains any kind of controller automation).

 

If you play back the recorded section again, the parameters will change auto-
matically. Outside the recorded section, the parameters will have their origi-
nal settings (the values they had before you started recording).

 

Recording more for the same controller

 

If you need to redo a section of recorded automation, or add some automa-
tion of the same controller elsewhere in the song, proceed as follows:

 

!

 

The Overdub/Replace switch does not affect controller recording. 
However, you should make sure this is set to “Overdub”, to avoid 

 

accidentally deleting any notes on the track.

1. Set up and start recording in the same way as described above.

 

As long as you don’t touch the parameter, its automation data will be 
played back normally.

 

2. At the desired position, adjust the parameter.

 

As soon as you start changing the parameter value, the Punched In indi-
cator will light up on the transport panel. 

From this point on, the previously recorded automation will be replaced!

 

3. Stop recording when you are done.

 

You have now replaced the section from where you Punched In up to 
where you stopped recording.

 

➜

 

Any time after Punching In, you can click the Reset button below 
the Punched In indicator.

 

This turns off the Punched In indicator and “resets” the controller record-
ing (making the previously recorded automation active again, from that 
position). You are still in record mode, and as soon as you adjust the pa-
rameter again, the Punched In indicator will be lit. 
Basically, clicking the Reset button is the same as stopping recording 
and starting recording again.

 

Moving Automated Controllers during Playback - “Live Mode”

 

Even if you have automated a parameter, you can still “grab it” and adjust it 
during playback, overriding the automation. This can be very useful when 
playing Reason live, for example:

 

1. During playback, click and drag an automated parameter.

 

The Punched In indicator lights up on the transport panel. From this point 
on, the recorded automation for the parameter is disabled.

 

2. To activate the automation again, click the Reset button.

 

This returns control of the parameter to the sequencer.

 

➜

 

Automation override is automatically reset when you stop playback.
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Background: How recorded controllers are handled

 

Even though the recording procedures are practically the same, the se-
quencer handles controllers differently from notes. While each recorded note 
is a separate event, there are no “controller events” as such in the se-
quencer. Instead, it works like this:

Each sequencer track has a number of controller “subtracks” (one for each 
automatable parameter in the corresponding device). A controller subtrack 
can be viewed as a length of magnetic tape, which you can fill with controller 
data.

When you haven’t yet recorded any automation for a parameter, its subtrack 
is empty. The parameter is not automated.

As soon as you record anything for the controller, anywhere in the song, the 

 

whole subtrack

 

 is filled with controller data:

This makes it possible to set up a static mix first, and then add some auto-
mated parameter changes anywhere in the song while maintaining the static 
values elsewhere in the song.

 

Recording Pattern Changes

 

If your song contains pattern devices, you probably want to use more than a 
single pattern throughout the song. To facilitate this you can record pattern 
changes in the sequencer (or draw them in manually, as described on page 
25).

 

1. If you want to use the same pattern for the main part of the song 
(and only want to add some variation patterns here and there), make 
sure this “main pattern” is selected before you start recording.

 

When you first record a pattern change somewhere in the song, the orig-
inally selected pattern will be inserted throughout the rest of the song. 
This is similar to the way controller automation works - see page 6.

 

2. Locate the sequencer track for the device, and make sure MIDI is 
routed to the track.

 

That is, the MIDI connector symbol should be shown in the In column for 
the track in the track list.

 

3. Start recording from the desired position.

 

When playback starts, the pattern device will automatically start (pro-
vided the pattern section is enabled on the device).

 

4. During recording, change patterns with the Bank and Pattern but-
tons on the device panel.

 

Make sure to change the patterns slightly in advance - the actual pattern 
change will be recorded (and happen) on the next downbeat according to 
the main sequencer time signature.

 

5. When you are done, stop recording.

 

The green frame around the pattern buttons indicates that pattern changes are 
automated for the device.

In the Arrange view, recorded pattern changes are indicated as dark yellow bars 
(the pale yellow “strip” indicates that the track contains any pattern change data at 
all).

This is the section you recorded.

This is the original, static value for the parameter.
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➜

 

Each pattern change will be recorded on a downbeat (at the start of 
a new bar in the sequencer).

 

You can move pattern changes to other positions in the Edit View if 
needed (see page 26).

 

➜

 

You can punch in on recorded pattern changes, to replace a section 
of the track.

 

This works the same as punching in on controllers (see page 7).

 

➜

 

After recording the pattern changes, you can use the function Con-
vert Pattern Track to Notes, to transfer the notes in the patterns to 
the main sequencer.

 

This allows you to create unlimited variations by later editing the notes in 
the Edit View. See below.
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Copying REX loops and 
Patterns to Sequencer 
Tracks

 

As described on page 136, you need to use the “To Track” function when us-
ing the Dr.Rex Loop Player device. This creates sequencer notes on the se-
lected track, so that each slice in the REX loop gets a corresponding 
sequencer note. Playing back the sequencer track will then play all slices in 
the correct order, with the original timing of the loop.

Similar functions are available for the pattern devices (Redrum and Matrix). 

 

• By using the function Copy Pattern to Track on the Edit menu or de-
vice context menu, you can copy the contents of the current pattern 
to notes on the selected sequencer track. 

• The function Convert Pattern Track to Notes works in a similar way, 
but converts all patterns in a song to notes (taking pattern changes 
into account).

 

The procedures differ slightly for the different device types:

 

Using the “To Track” function for REX Loops

 

This assumes that you have loaded a REX loop into the Dr.Rex device. For 
details, see page 135.

 

1. Set the left and right locator to encompass the section you want to 
“fill” with notes for the REX loop.

2. Select the track connected to the Dr.Rex device.

 

To avoid confusion, make sure there are no events between the locators 
on the track.

 

3. Click the “To Track” button on the Dr.Rex device panel.

 

Notes are created for the slices in the loop, and added to the track.

 

➜

 

If the length of the area between the locators is greater than the 
length of the REX loop, the loop will be repeated on the track.

 

This function always creates an exact number of loops, meaning that the 
last loop may “stick out” after the right locator.

 

The “Copy Pattern to Track” function

 

This is available for the Redrum and the Matrix. It is useful when you have 
created a single pattern and want to use it as starting point for editing in the 
sequencer. You could also use this if you e.g. have created a drum pattern 
and want to have this pattern play back some other type of device.

Proceed as follows:

 

1. Set the left and right locator to encompass the section you want to 
“fill” with the notes in the pattern.

 

You may want to make sure the length of the area between the locators 
is a multiple of the pattern length, to avoid “cutting off” the pattern.

 

2. Select the track connected to the pattern device.

 

In fact, you can select any track. For example, if the device is a Matrix, it 
may make sense to copy the notes not to the Matrix track, but to the track 
for the device 

 

controlled

 

 by the Matrix (since the Matrix doesn’t produce 
any sound in itself, and thus can’t be played by the sequencer notes).

 

3. Select the device and select “Copy Pattern to Track” from the Edit 
menu or the device context menu.

 

➜

 

If you selected a track not connected to the pattern device, an alert 
will appear, asking if that’s really what you want.

 

Click OK to proceed, or Cancel to abort.
The pattern is converted to sequencer notes on the track (see the notes be-
low). If the length of the area between the locators is greater than the pattern 
length, the pattern will be repeated to fill out the area.

 

The created notes are automatically grouped (as indicated by the colored boxes). Read 
more about groups on page 16.

Here, the loop was 2 bars long. Since there are three bars between 
the locators, the second loop will stick out after the right locator.

The created notes are automatically grouped (as indicated 
by the colored boxes). Read more about groups on page 16.
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Redrum notes

 

When you use this function with the Redrum, you should note the following:

 

• The notes will have the pitch of the corresponding drum sound (see 
“Using Redrum as a Sound Module” on page 96) and the velocity 
depending on the Dynamic value.

 

Soft notes have velocity 30, medium notes have velocity 80 and hard 
notes have velocity 127.

 

• You probably want to turn off the “Enable Pattern Section” switch 
on the Redrum device panel. 

 

Otherwise, the drum sounds will be “double-triggered” when you start 
playback (once by the pattern section itself, once by the main se-
quencer).

 

Matrix notes

 

When you use this function for the Matrix, you should note the following:

 

• A note will be created for each pattern step with a gate value other 
than zero. 

 

The notes will have the pitch according to the key CV value for the step, 
and the velocity according to the gate value. 

 

• The curve CV is not copied.
• Make sure that the track is connected to the correct device! 

 

Having the track connected to the Matrix itself is pointless, since the Ma-
trix cannot produce any sound.

 

• You may want to disconnect or even remove the Matrix after per-
forming a “Copy Pattern to Track”. 

 

This is because you probably don’t want both the Matrix and the se-
quencer notes to play back at the same time.

 

The “Convert Pattern Track to Notes” function

 

If you have recorded or drawn pattern changes on a Redrum or Matrix track, 
you can have the whole track converted to notes, in the following way:

 

1. Select the track with the pattern changes.

2. Select “Convert Pattern Track to Notes” from the Edit menu or the 
context menu for the track.

 

For each bar, the corresponding pattern is converted to notes on the 
track (following the same rules as for the “Copy Pattern to Track” func-
tion). The track will play back just the same as when you played the pat-
tern device with the pattern changes (including the Pattern Enabled/Mute 
switch).

 

➜

 

All pattern changes are automatically removed from the track after 
the operation.

 

Redrum notes

 

• The “Enable Pattern Section” switch is automatically turned off 
when you use this function.

 

Matrix notes

 

• After performing “Convert Pattern Track to Notes”, you need to 
move the contents to another track, or re-route the track to another 
device.

 

Having the track connected to the Matrix itself is pointless, since the Ma-
trix cannot produce any sound.

 

• You may want to disconnect or even remove the Matrix after per-
forming this function. 

 

This is because you probably don’t want both the Matrix and the se-
quencer notes to play back at the same time.

In these sections, the pattern 
was muted (Pattern Enable off) 
in the pattern track.
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Editing - About Snap

 

When you select and edit material (both in the Arrange View and the Edit 
View), the Snap (Snap to Grid) function determines the result. By activating 
Snap, editing becomes “restricted” to the note values selected on the Snap 
pop-up menu (the Snap value). The Snap button and pop-up menu are lo-
cated on the sequencer toolbar:

 

!

 

Note that you can select different Snap values for the Arrange View 

 

and the Edit View.

 

Snap has an effect on the following operations:

 

➜

 

Moving the Song position, Locators and End marker.

 

When you adjust these markers with Snap activated, they will be “mag-
netic” to the Snap value.

 

➜

 

Selecting events by enclosing them in a selection rectangle.

 

Since the selection rectangle is magnetic to the snap value, this deter-
mines the smallest “block” you can select. 
However, selecting by clicking directly on notes in the Edit View (or 
Groups in the Arrange View - see page 17) is not restricted by Snap.

 

➜

 

Moving and duplicating events.

 

When you move one or several Events with Snap activated, they will 
keep their relative distance to the Snap value positions. In the example 
below, Snap is set to 1/4 (quarter notes):

 

➜

 

Drawing Groups in the Arrange View.

 

When you create Groups with the Pencil tool, their start and end posi-
tions will be magnetic to the snap value positions. See page 16.

 

➜

 

Drawing events in the Edit view.

 

The Snap value determines the smallest note position on which you can 
draw a note or insert a controller value or pattern change. Furthermore, 
the Snap value determines the smallest length of the events when you 
draw. See page 20.

Use this pop-up menu to select the Snap value.

Click here to turn Snap on or off.
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Editing in the Arrange 
View

 

The Arrange View allows you to view several tracks at the same time, and 
provides a good overview of the song. This view is best suited for large-scale 
editing, such as rearranging blocks of music, adding or removing bars or ap-
plying quantizing and editing functions to events on different tracks at the 
same time.

 

➜

 

To select the Arrange View, click the Arrange View button in the top 
left corner of the sequencer area.

 

You can also toggle between Arrange View and Edit View by pressing 
[Shift]-[Tab] or [Command]/[Ctrl]-[E].

 

!

 

On the following pages we will use the word “event” as a collective 

 

name for notes, controller changes and pattern changes.

 

!

 

The procedures below apply to separate events in the Arrange 
View. Some techniques are different for Grouped events, as de-

 

scribed on page 16.

 

Selecting Events

 

Each track in the Arrange View is divided vertically into three “lanes”, in 
which events are shown as thin vertical lines. The top lane shows notes (in-
cluding drum notes and REX slices) in red, the middle lane shows pattern 
changes in yellow and the lower lane shows controller value changes in blue.

To select events in the Arrange view, click and drag a selection rectangle.

 

➜

 

If Snap is activated, the selection rectangle will be magnetic to the 
Snap value.

 

➜

 

You can drag a selection rectangle covering only one lane, thereby 
selecting only the notes, pattern changes or controllers.

 

You can also draw a selection rectangle covering several tracks.

 

➜

 

If you hold down [Shift] when you select events, any already se-
lected events remain selected.

 

This allows you to make multiple, non-contiguous selections: first select 
some events, then press [Shift] and select some more events, and so on.

 

➜

 

You can also use the “Select All” function on the Edit menu.

 

This selects all events, controllers and pattern changes in the song.

 

➜

 

The selection you make in the Arrange View will be maintained if 
you select the Edit View.

 

See page 21.

 

➜

 

To de-select events, just click anywhere in an empty area.

 

Moving Events

 

To move the selected events, click in the selection, and drag and drop it on a 
new position.

 

➜

 

When you move the selection, it is “magnetic” to the lanes.

 

That is, you cannot drag notes to a controller lane, etc.

 

➜

 

If you hold down [Shift] and drag, movement is restricted to hori-
zontal or vertical only.

 

➜

 

If Snap is activated, you will only be able to drop the selection so 
that it maintains its relative distance to the Snap value positions.

 

See page 12.
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Duplicating Events

 

To duplicate the selected events, hold down [Option] (Mac) or [Ctrl] (Win-
dows) and proceed as when moving events.

 

➜

 

You can also use the Duplicate Track function on the Edit menu or 
the track context menu.

 

This creates a copy of the selected track, complete with all events. The 
duplicated track will appear below the original track in the track list.

 

Using Cut, Copy and Paste

 

You can move or duplicate events using the Cut, Copy and Paste commands 
on the Edit menu. When you Paste, the events appear at the song position, 
on their original track(s).

 

!

 

If you have deleted the original tracks, or if you Paste into another 

 

Reason song document, new tracks will be created as needed.

 

➜

 

See the note below about Copying and Pasting whole tracks!

 

Using Copy and Paste to repeat a section

 

When you Cut or Copy a selection, the song position will automatically move 
to the end of the selection (or, if Snap is activated, to the closest Snap value 
position after the end of the selection). This allows you to quickly repeat a 
section, in the following way:

 

1. Make sure playback is stopped.

2. Set the Snap value to “Bar” (or to the length of the section you want 
to repeat, if is smaller than one bar).

3. Activate Snap.

4. Select the section you want to repeat.

 

Since you can make selections over several tracks, this is a quick way to 
copy entire song sections.

 

!

 

Note that Snap doesn’t apply in quite the same way when selecting 
Groups (see page 17). Make sure the selection contains exactly 

 

what you want before proceeding.

5. Select Copy from the Edit menu.

 

The song position is moved to the closest snap value after the end of the 
selection (provided that playback is stopped).

 

6. Select Paste from the Edit menu.

 

The copied section is pasted in, and the song position is moved to the 
end of pasted section.

 

7. Paste again, as many times as you want to repeat the section.

 

Using Cut, Copy and Paste with Tracks

 

You can select one or several tracks by clicking or [Shift]-clicking in the track 
list. This allows you to use Cut or Copy on the track, complete with contents.

 

➜

 

If you Paste the track(s) into their original song, this simply dupli-
cates the tracks.

 

However, the Pasted tracks will not be connected to any devices in the 
rack.

 

➜

 

You can also Paste the track(s) into another song.

 

Note that only the tracks (complete with contents) are copied and pasted 
- not their respective devices. You may want to separately copy and 
paste the devices to the other song.

 

Deleting Events

 

To delete events in the Arrange view, select them and press [Delete], [Back-
space] or select Delete from the Edit menu.
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Inserting and Removing Bars

 

When editing the overall structure of a song, you may need to rearrange the 
order and length of whole sections (e.g. make the “verse” two bars shorter, 
add a few bars to the intro, etc.). On the Edit menu or sequencer context 
menu you will find two useful functions for this:

 

Insert Bars Between Locators

 

This function inserts an empty area between the locators. All events after the 
left locator are moved to the right to “make room” for the inserted area.

 

Remove Bars Between Locators

 

This function removes all material between the locators. All events after the 
right locator are moved to the left to “fill out” the gap after the removed sec-
tion.

 

✪

 

The “Remove Bars Between Locators” function will automatically 
shorten any Groups intersected by the locators. This can be used 

 

as a feature in itself, as described on page 18.

 

Other Editing Functions in the Arrange View

 

You can also apply quantizing (see page 28) and use the Change Events 
function (see page 29) in the Arrange View. This is useful since it allows you 
to edit events on several tracks in one go.

 

➜

 

Note that you can select one or several tracks and have quantizing 
or Change Events apply to all events on the selected tracks.

 

Selecting several tracks is done by [Shift]-clicking in the track list.
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Using Groups

 

Sometimes it is practical to work with a section of events as one entity. This 
is done by Grouping the events. You may for example have a two-bar bass 
line that you want to move or repeat in the song - by Grouping the events, 
you can select, move and handle the bassline as a single object.

 

!

 

This applies to the Arrange View only - you can still edit individual 

 

events in a Group in the Edit View.

 

Appearance and Color

 

In the Arrange View, Groups appear as colored boxes. 

The color of the Groups depends on their contents:

 

!

 

Groups with the same color contain the same events. 

 

This makes it easy to get an overview of the song, since variations will ap-
pear as Groups in another color.

 

Creating Groups

 

There are two main ways to create Groups:

 

By using the Group command

 

1. Select the events that you want to Group.

 

It doesn’t matter which lanes you select - all notes, pattern changes and 
controllers within the area will be included in the Group.

 

➜ If you select events on several tracks, one Group for each track will 
be created.
Each Group can only contain events on one track.

2. If you want the Group to have a specific length, activate Snap and 
select an appropriate Snap value.
Often it is practical to create Groups that are one or several whole bars 
long.

3. Select Group from the Edit menu or the sequencer context menu.
Or, hold down [Command] (Mac) or [Ctrl] (Windows) and press [G].

The events are Grouped.

By drawing with the Pencil tool

1. Select the Pencil tool.
You can also select the Pencil tool momentarily by holding down [Com-
mand] (Mac) or [Alt] (Windows).

2. If you want the Group to have a specific length, activate Snap and 
select an appropriate Snap value.
Often it is practical to create Groups that are one or several whole bars of 
length.

3. Click where you want the Group to start, drag to the right and re-
lease the mouse button.
A Group is created, containing the enclosed Events. It is also possible to 
create empty Groups this way.

✪ Groups are also automatically created when you use the “To 
Track”, “Copy Pattern to Track” and “Convert Pattern Track to 
Notes” functions. See page 10.

These Groups are “variations”
- all the others have the same contents.
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Selecting Groups
To select a Group, just click on it in the Arrange View.

This Group is selected.

➜ If you hold down [Shift] and click, you can select multiple Groups.
You can de-select individual Groups by [Shift]-clicking them again.

➜ You can also select Groups by clicking and dragging a selection 
rectangle, just as with events.
If Snap is on, the selection rectangle will be magnetic to the Snap value 
positions. However, note that a Group doesn’t have to be fully enclosed 
by the rectangle to be selected - the selection rectangle only needs to in-
tersect or touch the Group.

✪ Note that it’s possible to select Groups and “loose events” at the 
same time with this method. Make sure the selection rectangle en-
closes the elements you want!

➜ Another way of selecting Groups is to use the arrow keys on the 
computer keyboard.
Pressing the right arrow key selects the next Group on the track, pressing 
the down arrow key selects the closest Group on the track below, etc. 
Holding down [Shift] and using the arrow keys allows you to make multi-
ple selections.

➜ If you select a Group and go to the Edit View, all events in the Group 
will be selected.

➜ To de-select the selected Group(s), click anywhere in an empty part 
of the Arrange View.

Resizing Groups
When a Group is selected, a handle appears on its right edge. You can click 
on this handle and drag to make the Group smaller or larger. The following 
rules apply:

➜ If you drag to the left to make the Group smaller, any events that 
end up outside the Group boundary are no longer included in the 
Group.
As a consequence, if you drag the handle all the way past the start of the 
Group, all events are Ungrouped (see below).

➜ If you drag to the right to make the Group larger, any events you en-
close will become part of the Group.

➜ Note: Groups cannot overlap! 
This means that if you enlarge a Group so that it partially covers another 
Group, this will automatically resize the other Group as well:

The second Group now starts here!
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Dividing Groups
You can divide a Group into two by clicking with the Pencil tool at the desired 
position and dragging to the end of the Group.

Actually, this is just a consequence of the fact that Groups cannot overlap. 
As soon as you create a Group that overlaps another Group, the other Group 
is automatically resized. For example, if you were to draw a small Group 
within a larger Group, you would end up with three Groups:

Tip: Splitting Groups on several Tracks

If you have Groups on several tracks and want to split these at the same po-
sition, you can use the following method:

1. Set both the Left and the Right Locator to the desired split position.

2. Select “Insert Bars Between Locators” from the Edit menu.
The Groups are split.

Combining Groups
There are two main ways to combine two or more Groups into one:

By using the Group command

1. Select the first and the last Group that you want to combine.
All Groups in between these will be included as well.

2. Select Group from the Edit menu.
You will now have one larger Group.

By Resizing

1. Click the size handle of the first Group and drag to the right.

2. Release the mouse button at the end of the last Group.
All Groups in between are combined to one larger Group.

Find Identical Groups
This command on the Edit menu helps you locate all Groups with the same 
contents:

1. Select a Group.

2. Select “Find Identical Groups” from the Edit menu.
All Groups with the same contents are selected in the Arrange View.

Ungrouping
There are two ways to dissolve a Group:

➜ Select it and select Ungroup from the Edit menu or sequencer con-
text menu,

or

➜ Click on the Group size handle and drag it all the way to the left.

Neither of these methods affect the events in the Group, they just remove the 
Grouping.

Editing with Groups
You can work with Groups much like you edit selected events in the Arrange 
view:

➜ To move a Group, click on it and drag it to a new position, taking the 
Snap value into account.
If you move the Group so that it partially overlaps another Group, the 
other Group will automatically be resized. If the moved Group overlaps 
the other Group completely, you will get one large Group containing the 
events from both.

➜ To duplicate a Group, hold down [Option] (Mac) or [Ctrl] (Windows) 
and proceed as when moving.
This duplicates the Group and all its contents. You can also use Copy 
and Paste for this, following the same rules as for selected events.

➜ To delete a Group, select it and press [Delete], [Backspace] or se-
lect Delete from the Edit menu.
This deletes the Group and all its contents.
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The Edit View
The Edit View allows you to perform detailed editing to the events on a single 
track. This is also where you create notes, pattern changes and controller 
values from scratch by drawing.

➜ To select the Edit View, click the Edit View button in the top left cor-
ner of the sequencer area.

You can also toggle between Arrange View and Edit View by pressing 
[Shift]-[Tab] or [Command]/[Ctrl]-[E].

Selecting a Track for Editing
The Edit View shows the events of the track that has the focus in the track 
list.

➜ If one track is selected when you enter Edit View, that track will have 
the focus and its events will be shown.

➜ If more than one track is selected in the track list when you select 
Edit View, the track you last clicked on will have focus.

➜ You can change edit track at any time, by clicking in the track list.
This way you can stay in the Edit View and select different tracks for ed-
iting, without having to go back to the Arrange View.

About the Lanes
The Edit View is (or can be) divided vertically into lanes. There are six differ-
ent lanes, suitable for editing different types of events. Any combination of 
lanes can be shown. You show and hide lanes by clicking their respective 
buttons in the sequencer toolbar:

➜ If you hold down [Option] (Mac) or [Alt] (Windows) and click a Lane 
button, only that lane will be shown (all other lanes are hidden).

By default, the lanes that are shown when you select Edit View depends on 
the device type to which the track is connected (and whether the track con-
tains controller data). For Redrum tracks, the Drum lane, Velocity lane and 
Pattern lane are shown, for Dr.Rex tracks, the REX lane and Velocity lane 
are shown, and so on. 

However, once you show or hide lanes, the new combination of lanes will be 
stored individually for each track. The next time you select Edit View for that 
track, the lane configuration will be the same.

Resizing and Zooming

➜ You can resize lanes by dragging the dividers between them.

➜ Where applicable, the lanes have individual zoom controls and 
scrollbars.

Key lane Drum lane

Controller lane

REX lane

Pattern lane

Velocity lane



THE SEQUENCER20

➜ For extensive editing, you may want to maximize the sequencer 
area so that it fills the window. 
This is done by clicking the Maximize Sequencer button or by holding 
down [Command] (Mac) or [Ctrl] (Windows) and pressing [2] on the left 
part of the computer keyboard.

About the Ruler and the Group strip

At the top of the Edit View you will find the ruler. Just like the ruler in the Ar-
range View, this shows meter positions (bars and beats), helping you find the 
right positions in the song.

➜ You can adjust the horizontal zoom individually for the Edit View 
and the Arrange View.
This makes sense, as you will probably work with a larger magnification 
when performing fine editing.

Just below the ruler is a narrow empty strip. This shows the Groups (if any) 
as colored bars, providing additional means of orientation in the Edit view.

✪ When you edit events within a Group, you will note that the Group 
indicator changes color. This is because the color of a Group de-
pends on its contents, as described on page 16.

Drawing and Editing Notes
Notes are drawn and edited in one of three lanes: the Key lane, the Drum 
lane and the REX lane:

The Key lane. The piano keyboard to the left indicates the pitch of the notes, covering 
the whole MIDI note range (C-2 to G8). Note that the black and white keys are reflected 
in the background colors of the grid, making it easier to find the right pitch when drawing 
and moving notes!
This is the lane to use when editing Subtractor or Sampler tracks.

The Drum lane. This is divided vertically into ten pitches, corresponding to the ten drum 
sound channels on a Redrum device (and named accordingly, if the track is connected 
to a Redrum device). Use this for editing drum tracks.

The REX lane. This is divided vertically into pitches (from C3 and up), corresponding to 
the slices in a Dr.Rex loop player device. Use this for editing Dr.Rex tracks.

➜ In all three lanes, the actual notes are shown as “boxes”, with the 
note length indicated by the width of the box and the velocity values 
indicated by the color of the box (the darker the color, the higher the 
velocity).
The basic note editing procedures are the same for all three lanes.

The Maximize Sequencer button.

Groups
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Drawing notes

1. If you want to restrict note input to certain note values (e.g. six-
teenth notes), set the Snap value accordingly and activate Snap.

2. Select the Pencil tool.
You can toggle temporarily between the Arrow tool and the Pencil tool by 
holding down [Command] (Mac) or [Alt] (Windows).

3. If needed, click in the piano keyboard display, drum sound list or 
slice list to find the correct pitch.
If the track is connected to a device, this will play the corresponding note.

4. Click in the note display part of the lane, at the desired position.
A note will be inserted at the closest Snap value position.

➜ If you just click, the note will get the length of the Snap value.
This is true regardless of whether Snap is activated or not.

➜ If you instead click and keep the mouse button pressed, you can 
drag to the right to set the length of the note.
If Snap is on, the length will be a multiple of the Snap value (unless you 
hold down [Shift] while you drag). Also, see the note about drum note 
lengths below.

Selecting notes

To select notes in the Edit View, use one of the following methods:

➜ Click on a note with the Arrow tool to select it.

➜ To select several notes, hold down [Shift] and click.
You can de-select individual notes by [Shift]-clicking them again.

➜ You can also click and drag a selection rectangle around the notes 
you want to select.
If Snap is on, the selection rectangle will be magnetic to the nearest snap 
value positions. For example, if Snap is set to “Bar”, dragging a rectangle 
will select all notes within an exact range of bars (and within the pitches 
enclosed by the rectangle).

➜ You can select the next or previous note on the track by pressing 
the right or left arrow key on the computer keyboard.
Holding down [Shift] and using the arrow keys allows you to make multi-
ple selections.

➜ To select all notes on the track, use the Select All function on the 
Edit menu.
Make sure that the correct lane (Key, Drum or REX) has focus first - oth-
erwise you may select all controllers or pattern changes. To set focus to 
a lane, click somewhere in it (focus is indicated by a thin extra border 
within the lane).

➜ To deselect all notes, click somewhere in an empty area.

Moving notes

➜ To move a note, click and drag it to a new position. 
If several notes are selected, all will be moved. The individual distance 
between the moved notes will be kept.

➜ If Snap is on, the moved events will keep their relative distance to 
the Snap value positions. 
For example, if Snap is set to “Bar”, you can move the selected notes to 
another bar without affecting their timing.

➜ If you hold down [Shift] when you drag, movement is restricted to 
horizontal or vertical only.
This helps you move notes without accidentally transposing them, or 
transposing notes without accidentally changing their meter position.

Duplicating notes

To duplicate the selected notes, hold down [Option] (Mac) or [Ctrl] (Win-
dows) and proceed as when moving notes.

Using Cut, Copy and Paste

You can move or duplicate events using the Cut, Copy and Paste commands 
on the Edit menu.

➜ When you Cut or Copy, the song position is automatically moved to 
the end of the selection (or, if Snap is activated, to the closest Snap 
value position after the end of the selection).
You can use this for repeating events, as described on page 14.

➜ When you Paste, the events appear at the song position, on their 
original track(s).
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Resizing notes

When you select a note, a handle appears on its right edge. You can click on 
this handle and drag to make the note shorter or longer.

➜ If Snap is on, the end of the note will be magnetic to the Snap value 
positions.
You can disable this function temporarily by pressing [Shift] when you 
drag. This allows you to resize the note to any length, regardless of the 
Snap value.

➜ If several notes are selected, all will be resized by the same amount.

About resizing drum notes

Drum notes can be resized as any other notes. However, the result of this 
depends on the settings of the Decay/Gate switch and the Length knob for 
the drum sound on the Redrum panel:

➜ If Decay mode is selected, the drum sound will play to its end, re-
gardless of the note length.
Or rather, it will fade out according to the Length setting.

➜ If Gate mode is selected, the note length affects the resulting 
sound.
However, the maximum length of the sound is set by the Length knob - 
the sound will be cut off after this length, regardless of the note length. 
Finally, even if the Length knob is set to its maximum value, the sound 
will not play longer than the length of the drum sample.

Deleting notes

To delete notes, select them and press [Backspace] or [Delete], or select De-
lete from the Edit menu.

Editing velocity

The velocity values of notes are edited in the Velocity lane.

The velocity values are shown as bars, with higher bars indicating higher velocity. Note 
also that the color of the notes and bars reflect the velocity.

To change the velocity of a note, click on its velocity bar with the Pencil tool 
and drag the bar up or down. You can also edit the velocity of several notes 
by dragging the pencil across the bars, at the desired height.

Drawing a velocity ramp.

However, note the following feature:

! If you hold down [Shift] when you edit velocity values with the Pen-
cil tool, only the selected notes will be affected!

This can be very useful, especially in “crowded” sections with lots of notes. 
Consider for example if you have a busy drum beat, and want to adjust the 
velocity of the hi-hat notes only. Simply dragging with the pencil tool would 
change the velocity of all other drum notes in the area, but if you first select 
the hi-hat notes in the Drum lane and press [Shift], you can edit their velocity 
without affecting any other notes!
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Editing Controllers
Controllers are shown and edited in the Controller lane. This lane in turn is di-
vided into several “subtracks”, one for each automatable parameter for the 
corresponding device.

The Controller lane for a Subtractor track, with three controllers shown.

Showing and Hiding Controllers

For each track, you can select which controllers should be shown. This can 
be done in several ways:

➜ Hold down [Option] (Mac) or [Alt] (Windows) and click on a parame-
ter on a device panel in the rack.
This sets focus to the first sequencer track connected to the device, 
opens Edit View, brings the Controller lane and shows the automation 
subtrack for the specified parameter, all in one go.

➜ You can do the same thing by selecting “Edit Automation” on the 
context menu for the parameter.
You bring up the parameter context menu by [Ctrl]-clicking (Mac) or right-
clicking (Windows) on the parameter on the device panel. 

✪ If you use a Mac with a two-button mouse, it’s a good idea to assign 
[Ctrl]-click to the right mouse button, allowing you to bring up con-
text menus by right clicking.

➜ By using the Controller pop-up menu on the sequencer toolbar, you 
can hide or show individual controllers from the sequencer.
Shown controllers are indicated by a tick mark on the pop-up menu - se-
lect a controller to show it or hide it. 
Controllers for which there is data (automation) in the track are indicated 
with an asterisk next to the controller name.

➜ Click the “Show All Device Controllers” button to show all control-
lers available for the track’s device.

➜ Click the “Show All Automated Controllers” button to show all con-
trollers for which you have recorded or drawn automation in the 
Track.

➜ Click the “Hide All Controllers” to hide all controllers.
This will leave the Controller lane empty.
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Drawing and Editing Controllers

Regardless of whether you’re editing recorded controllers or creating control-
ler changes from scratch, you do it by drawing with the Pencil tool.

Note:

➜ If Snap is on, the controller value change you enter will snap to the 
nearest Snap value position. 
Also, the length of the changed section will be a multiple of the Snap value.

In this example, Snap is set to 1/4. Thus, the controller changes you enter will be in 
“steps”, one or more quarter notes in length.

➜ If the controller hasn’t been automated yet (the words “Not Auto-
mated” are shown in the Controller lane), it is a good idea to first set 
the parameter to a good “default value” on the device panel.
The reason is that as soon as you enter a controller value, the rest of the 
track will be filled with the original value of the parameter (the value set 
on the device panel). This works exactly the same as when recording 
controllers - see page 6.

Selecting sections of a controller track

To select a section of the “subtrack” for a controller, click and drag a selec-
tion rectangle with the Arrow tool. If Snap is on, the selection will be magnetic 
to the Snap value positions, just as when selecting notes.

The selected section is shown as a shaded rectangle.

➜ By holding down [Shift] and dragging, you can select multiple, dis-
continuous sections of the controller subtrack.

✪ If you select Groups or sections of the controller lane in the Arrange 
View, this section will be selected when you got to Edit View and 
vice versa.

Moving and Duplicating Controller sections

➜ To move a selected controller section, click and drag it to another 
position on the same subtrack.
Snap is taken into account as usual.

➜ To duplicate a selected controller section, hold down [Option] (Mac) 
or [Ctrl] (Windows), click and drag it.

! Moving or duplicating controllers will replace the controller values 
at the new position (just as if you had edited them with the Pencil 
tool).

Using Cut, Copy and Paste

You can move or duplicate selected controller sections using the Cut, Copy 
and Paste commands on the Edit menu.

➜ When you Cut or Copy, the song position is automatically moved to 
the end of the selection (or, if Snap is activated, to the closest Snap 
value position after the end of the selection).
You can use this for repeating events, as described on page 14.

➜ When you Paste, the controller section appears at the song posi-
tion, on its original subtrack.
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Deleting Controller sections

You can delete the selected controller section by pressing [Backspace] or 
[Delete] or by selecting Delete from the Edit menu. The result is this:

The controller value just before the deleted selection will remain until the end of the 
selection.

! You can´t remove all automation using this method - there will al-
ways be at least one controller value left. To remove all automation, 
use the Clear Automation function:

Clearing Automation

To remove all automation for a controller, select “Clear Automation” from one 
of the following menus:

➜ The context menu for the controller subtrack.
This appears when you [Ctrl]-click (Mac) or right-click (WIndows) in the 
subtrack.

➜ The Edit menu.
Requires that the controller subtrack has focus. Click in the subtrack if 
you are uncertain.

➜ The parameter context menu.
This appears when you [Ctrl]-click (Mac) or right-click (WIndows) on the 
parameter on the device panel. 
Note that this clears all automation for the parameter, on all tracks!

Selecting “Clear Automation” will remove all controller values from the sub-
track, and the text “Not Automated” will be shown.

Inserting and Editing Pattern Changes
Pattern changes are viewed and edited in the Pattern lane:

A pattern change is shown as a yellow “tab” with the Bank and Pattern num-
ber. From the tab, a bar stretches to the right, for as long as the selected pat-
tern is “active”, i.e. to the next pattern change.

! When you record pattern changes, they are automatically posi-
tioned on downbeats (at the beginning of new bars).

Inserting Pattern Changes

To insert a Pattern change, proceed as follows:

1. If you haven’t automated any pattern changes for the track yet (the 
words “Not Automated” are shown in the Pattern lane), it is a good 
idea to first select a “default pattern” in the pattern device.
This is especially useful if you are using a main pattern and want to insert 
changes to variation pattern here and there. 
The reason is that just like when you record pattern changes, the rest of 
the track will be “filled” with the original value as soon as you enter a pat-
tern change somewhere on the track.

2. Activate Snap and set the Snap value to the note position where you 
want to insert pattern changes.
It is probably a good idea to set Snap to “Bar”, at least if you are working 
with patterns of a length corresponding to the time signature (e.g. 16 or 
32 step patterns and 4/4 time signature). However, if you are working 
with patterns of another length, it can make sense to use other Snap val-
ues.

! Don’t insert pattern changes with Snap turned off, unless you want 
chaotic rhythm changes!
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3. Pull down the Pattern pop-up menu to the left in the Pattern lane, 
and select the pattern you want to insert.
The selected pattern is shown next to the pop-up menu.

The patterns are listed with the bank letter and pattern number (A1, A2, A3, and so 
on).

4. Click with the Pencil tool at the position where you want the pattern 
change to happen, and keep the mouse button pressed.

5. Drag to the right.
When you drag, you will see the previous or original pattern being re-
placed by the pattern you insert.

6. Release the mouse button at the position where you want the pat-
tern change to “end”.

! The “Pattern Enable/Mute” switch (the button above the pattern se-
lection buttons on the device panel, used for temporarily silencing 
the pattern playback) is automated using controller automation. The 
controller is called “Pattern Enabled”.

Selecting Pattern Changes

To select a section of Pattern lane, click and drag a selection rectangle with 
the Arrow tool. If Snap is on, the selection will be magnetic to the Snap value 
positions, just as when selecting notes.

The selected section is shown as a shaded rectangle.

➜ By holding down [Shift] and dragging, you can select multiple, dis-
continuous sections of the Pattern lane.

✪ If you select Groups or sections of the pattern lane in the Arrange 
View, this section will be selected when you got to Edit View.

Moving and Duplicating Pattern Change sections

You can move and duplicate selected sections of the Pattern lane, just as 
when moving controller sections. Just like when inserting pattern changes, it 
is recommended that Snap is activated (and in most cases set to “Bar”) when 
you do this.

You can also move or duplicate sections using the Cut, Copy and Paste 
commands on the Edit menu. Again, the same rules apply as when editing 
controllers.
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Deleting Pattern Change sections

You can delete the selected section of the Pattern Lane by pressing [Back-
space] or [Delete] or by selecting Delete from the Edit menu. The result is 
this:

The pattern before the deleted section will remain selected until the end of the section.

! Again, make sure Snap is activated.

! You can´t remove all pattern change data using this method. To re-
move all pattern automation, use the Clear Automation function:

Clearing Automation

To remove all pattern changes, proceed as follows:

1. [Ctrl]-click (Mac) or right-click (WIndows) in the Pattern lane.
The context menu appears.

2. Select “Clear Automation”. 
This will remove all pattern changes from the track, and the text “Not Au-
tomated” will be shown.
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Quantizing
The Quantize function moves recorded notes to (or closer to) exact note 
value positions. This can be used for correcting errors, “tightening up” re-
corded music or changing the rhythmic feel.

Applying Quantizing
In Reason, you use the Quantize function in the following way:

1. Select the notes you want to quantize.
Only notes will be affected, so you can select Groups or complete Tracks 
if you like.

2. Pull down the Quantize pop-up menu on the sequencer toolbar and 
select a Quantize value.
This determines to which note values the notes will be moved when you 
quantize. For example, if you select sixteenth notes, all notes will be 
moved to (or closer to) the closest sixteenth note position.

The Quantize pop-up menu.

3. Select a value from the Quantize Strength pop-up menu.
This is a percentage, governing how much each note should be moved. If 
you select 100%, notes will be moved all the way to the closest Quantize 
value positions; if you select 50%, notes will be moved half-way, etc.

4. Click the Quantize button or select “Quantize Notes” from the Edit 
menu.
The selected notes are quantized.

In this example, a sloppily recorded hi-hat pattern is quantized to straight sixteenth 
notes (Quantize value 1/16, Strength 100%).

Quantizing to Shuffle
On the Quantize pop-up menu, you will also find an option called “Shuffle”. If 
this is selected when you quantize, the notes are moved towards sixteenth 
note positions, but with the Shuffle applied. 

As described in the Getting Started book, Shuffle creates a “swing feel” by 
delaying the even-numbered sixteenth notes (the sixteenth notes that fall in 
between the eighth notes). The amount of Shuffle is set with the Pattern 
Shuffle control on the transport panel.

The Pattern Shuffle control.

Quantizing to Shuffle is useful if you want to match the timing of recorded 
notes with pattern devices in the song (if Shuffle is activated in the patterns).

➜ The Quantize Strength setting applies as when quantizing to regular 
Quantize values.

The Quantize 
button
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Quantizing to Grooves
The Quantize pop-up menu also contains three items named “Groove 1-3”. 
These are three different, slightly irregular rhythmic patterns. If you select 
one of these as Quantize value and apply Quantize, your notes will be 
moved towards the note positions in the Groove pattern, creating different 
rhythmic feels.

Creating your own Groove

You can create your own groove and apply this using Groove Quantize:

1. Create or record a rhythmic note “pattern” of some kind.
You may for example record a drum pattern, or use the notes playing the 
slices in a REX loop.

2. Select the notes you want to include in the user groove.
The groove can be of any length, but it’s usually most practical to make it 
one or two bars long.

3. Select “Get User Groove” from the Edit menu or sequencer context 
menu.
Your pattern is stored as the User groove.

4. Select any notes that you want to quantize, make sure “User” is se-
lected as Quantize value, and quantize as usual.
The rhythmic feel of your groove is applied to the notes.

! The User Groove is only stored temporarily - it isn’t included when 
you save your Song.

Quantizing during recording
You can have Reason quantize notes automatically when they are recorded. 
This is done by activating the “Quantize Notes during Recording” button on 
the sequencer toolbar, before you start recording.

The Quantize value and Strength settings apply as usual.

The Change Events 
Dialog
The Change Events dialog contains some special editing functions. Proceed 
as follows:

1. Select the events to which you want to apply the editing functions 
(in the Arrange view or Edit view).
The Change Events functions are mainly used with notes, but the Scale 
Tempo function will also affect controllers and pattern changes (see be-
low).

2. Select Change Events from the Edit menu or the context menu for 
the selected events.
The Change Events dialog appears.

3. Make settings for one of the functions in the dialog and click the Ap-
ply button next to the settings.
All settings can be made by clicking the spin controls or by clicking in a 
value field and entering a value numerically. The functions are described 
below.

4. If you like, use other settings in the same way.
You can use the transport controls as usual while the dialog is open. This 
allows you to play back the events to check out the changes.

5. When you are done, close the dialog.
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Transpose

This function transposes the selected notes up or down, by the specified 
number of semitones.

Velocity

Adjusts the velocity of the selected notes.

➜ The Add field lets you add a fixed amount to the velocity values.
To subtract, enter a negative amount. Note that the possible velocity 
range is 1-127. Adding an amount to a note with velocity 127 will not 
make any difference.

➜ The Scale field allows you to scale velocities by a percentage factor.
Scaling with a factor above 100% will increase the velocity values, but 
also make the difference between soft and hard notes bigger.
Scaling with a factor below 100% will decrease the velocity values, but 
also make the difference between soft and hard notes smaller.

➜ By combining the Add and Scale functions, you can adjust the “dy-
namics” of the notes in various ways.
For example, by using a Scale factor below 100% and Add a suitable 
amount, you can “compress” the velocity values (decreasing the differ-
ence between the velocity values without lowering the average velocity).

Scale Tempo

This function will make the selected events play back faster (Scale factor 
above 100%) or slower (Scale factor below 100%). This is achieved by 
changing the position of the events (starting from the first selected event) 
and adjusting the length of the notes accordingly.

The result of applying Scale Tempo with the Scale factor 200% (double speed).

➜ The buttons [*2] and [/2] are “shortcuts” to Scale factors 200% and 
50%, respectively.
These are probably the most common values used, simulating double 
tempo and half tempo.

! This function affects all types of events: notes, controllers and pat-
tern changes! 

Alter Notes

This function alters the properties pitch, length and velocity of the selected 
notes, in a random fashion. 

➜ The function will only “use” values that already exist among the se-
lected notes.
For example, if you have selected notes within a specific pitch interval, 
the altered notes will remain within this pitch interval. Similarly, only ve-
locity values and note lengths that were already used in the selection will 
be applied by the Alter function. You could say that the function “shuffles” 
the existing properties in a selection and redistributes them among the 
notes.

! This means that the less variation there is among the selected 
notes, the less the effect of the Alter function.

➜ You can adjust the amount of Alteration with the Amount value.

✪ This function is especially useful for experimenting with REX loops. 
Select some notes on a Dr.Rex track and use Alter Notes to create 
instant variations, without losing the timing and rhythmic feel of the 
loop!
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Importing and Exporting 
MIDI Files
Reason can import and export standard midi files (SMF). This allows you to 
transfer MIDI data between Reason and other applications.

Importing a MIDI File
To import a Standard MIDI File, select “Import MIDI File” from the File menu 
In the file dialog that appears, locate and open the MIDI file.

➜ Under Windows, MIDI files have the extension “.mid”.
On a Macintosh, MIDI files are recognized if they have the file type “Midi”.

Now, a number of new tracks are created in Reason’s sequencer. The tracks 
will have their original name, with their original MIDI channel added.

➜ If the imported MIDI file is of “Type 1”, there will be one sequencer 
track for each track in the MIDI file.

➜ If the imported MIDI file is of “Type 0” (that is, it contains one track 
with MIDI events on multiple channels), there will be one sequencer 
track for each used MIDI channel.

➜ Any tempo changes in the MIDI file are disregarded.
The tempo in Reason will be set to the first tempo in the MIDI file.

➜ The new tracks will not be connected to devices in the rack.
You will need to connect the tracks manually to the proper devices, by 
using the Out pop-up menu in the track list.

➜ All controller data in the MIDI file is included.
This means that pitch bend, volume and modulation wheel data are pre-
served properly. However, some controllers may “mean” different things 
for the original MIDI instruments used when creating the MIDI file and the 
devices in Reason. When you have connected a sequencer track to a de-
vice, you may therefore need to remove some unwanted automation 
from the track.

Green frames will appear for the automated parameters in the device panels. This 
helps you locate any unwanted controller data.

Exporting a MIDI File
To export your Reason song as a MIDI file, proceed as follows:

1. Set the End (E) marker at where you want the MIDI file to end.
The MIDI file will contain all events on all tracks from the start of the song 
to the End marker.

2. Select “Export MIDI File” from the File menu. 

3. In the file dialog that appears, specify a name and location for the 
file.
Under Windows, the file will automatically get the extension “.mid”. Under 
MacOS, this is not required. However, if you want the MIDI file to be rec-
ognizable under Windows (and by some hardware sequencers), you may 
want to activate the option “Add Extension to File Name” before saving.

4. Click Save.

MIDI files exported by Reason will have the following properties:

➜ The MIDI file will be of Type 1, with one MIDI track for each track in 
the Reason sequencer.
The tracks will have the same names as in the Reason sequencer.

➜ Since the Reason sequencer doesn’t use MIDI channels as such, all 
tracks will be set to MIDI channel 1.

➜ The sequencer tempo is included in the MIDI file.
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About the various signals 
that can be routed
This chapter describes the various ways you can route signals in Reason. 
The following signal types are used:

Audio
Apart from the Matrix Pattern Sequencer, all devices have audio connectors 
on the back. The audio connectors carries audio signals to or from devices 
via virtual “cables”. 

➜ Audio connectors are shown as large “quarter inch” jacks.

➜ Audio Effects devices, which are used to process audio, have both 
audio inputs and outputs.

➜ Instrument devices, which generate audio, have either mono or ste-
reo left/right audio output connectors.
You do not have to use both outputs for devices with stereo outputs. Use 
the left output to get a mono signal from a stereo device.

➜ To monitor audio outputs from devices, the signals can be either be 
routed via a mixer - or directly- to the physical outputs of your audio 
hardware. 
Typically, if you are using audio hardware with standard stereo outputs, 
you will most probably use one or several mixers in Reason to mix the 
audio signals to the master outputs.

CV/Gate
CV (control voltage) signals are used to modulate parameter values, and do 
not carry audio. Gate signals are also a type of control voltage, but are “nor-
mally” used for slightly different purposes.

➜ CV/Gate connectors are shown as smaller “mini” jacks.

➜ CV is typically used for modulation purposes.
For example you could modulate one parameter with the value produced 
by another parameter. 

➜ Gate outputs/inputs are typically used to trigger events, such as 
note on/off values, envelopes etc.
Gate signals produce on/off values, plus a “value” which could be likened 
to (and used as) velocity.

➜ You can only route CV/Gate signals from an output to an input (or 
vice versa).
You cannot route an input to another input or an output to another output.

MIDI Routing
There are several ways you can route MIDI from external MIDI devices to 
Reason devices. This is described in the chapter “Routing MIDI to Reason”.

About Cables
Hiding and Showing
If you have made many connections in Reason, the cables can sometimes 
obscure the view, making it difficult to read the text printed on the back pan-
els of the devices. You can hide all cables in the following way:

➜ To hide all cables, press [Command]+[L] (Mac) or [Ctrl]+[L] (Win-
dows), or (de)select “Show cables” on the Options menu.
When cables are hidden, connections are indicated by a colored connec-
tor. Repeating the above procedure make the cables appear again.

Cables hidden

➜ When hidden, you can still connect or disconnect cables in the 
same way as when they are shown.
See page 36 for a description of the available routing methods.

Checking Connections
It is possible to check to which device a jack is connected (useful if the ca-
bles are hidden, or if the connected devices are located far apart in the rack):

➜ Positioning the pointer over a connector. 
A tool tip appears after a moment, showing the device and the specific 
connector at the other end.
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Color Coding
Cables are color coded in the following way, making it easier to discern be-
tween the various connections:

• Audio connections are different shades of red.
• CV connections are different shades of yellow.
• Connections to and from Effects devices are different shades of 

green.

Automatic Routing
Auto-routing is when devices are automatically routed according to default 
rules. Auto-routing is performed in the following circumstances:

• When a new device is created.
• When moving, duplicating or pasting devices with [Shift] pressed.

Automatic Routing Rules

Reason Mixer Device

➜ The first created mixer device will be routed to the first available in-
put pair in the Hardware Device.
If more mixers are created they will be connected via the mixers Chaining 
connectors (see the Mixer chapter).

Routing Devices to the Mixer

➜ When an Instrument Device is created, it is auto-routed to the first 
available mixer channel(s).

Routing a Send Effect to the Mixer

➜ When you have a mixer selected and create an effect device, it will 
be connected as a send effect (to the first free Aux Send/Return).
Examples of effects that lend themselves well for use as send effects are 
reverb, delay and chorus.

Routing an Effect Directly to a Device (Insert)

➜ When you have an instrument device selected and create an effect, 
that effect will be connected as an insert effect. That is, the signal 
from the device will pass through that effect and to the mixer (or to 
another effect).

CV/Gate Auto-route

➜ The only instance of CV/Gate auto-routing in Reason is when you 
create a Matrix Pattern Sequencer with either a Subtractor or NN-19 
Sampler selected.
The Matrix Note and Gate CV outputs are automatically connected to the 
Sequencer Control CV and Gate inputs on the instrument device, respec-
tively.

Auto-routing Devices after they have been Created

Here follows some additional rules about auto-routing devices that are al-
ready in the rack:

➜ To reroute a device already in the rack, you can select it and use 
Disconnect Device and Auto-route Device, both on the Edit menu.

➜ If you delete a device connected between two devices, the connec-
tion between the two remaining devices is automatically preserved.
A typical example would be if you have an effect device, connected as an 
insert effect between a synth and a mixer. If you delete the effect, the 
synth will be routed directly to the mixer.

➜ When you move a device, connections are not affected.
If you instead would like the program to re-route the device according to 
its new location in the rack, hold down [Shift] when you move it.

➜ When you duplicate devices (by dragging) or use copy and paste, 
the devices are not auto-routed at all.
If you would like them to be automatically routed, hold down [Shift] when 
you perform the operation.

These cables are green, indicating effect device connections.

This cable is yellow, 
indicating a CV connection.

These cables are red, indicating connections 
between instruments and mixer devices.
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Bypassing Auto-Routing

➜ If you wish to create a new device, without any auto-routing taking 
place, press [Shift] when creating the device.

Manual Routing
By selecting “Toggle Rack Front/Rear” from the Options menu or pressing 
[Tab] you turn the rack around. On the back of each device you will find con-
nectors of two different types: audio and CV. As mentioned before, audio in-
puts and outputs are shown as large “quarter inch” jacks, while CV input and 
output jacks are smaller.

There are two ways to route audio from one device to another: 

• By connecting “virtual patch cables” between inputs and outputs.
• By selecting connections from a pop-up menu.

Using Cables

! For the cables to be visible, the option “Show Cables” must be acti-
vated on the Options menu. See below.

1. Click on the desired input or output jack on one of the devices, and 
drag the pointer away from the jack (with the mouse button 
pressed).
A loose cable appears.

2. Drag the cable to the jack on the other device.
When you move the cable end over a jack of the correct type (audio/CV, 
input/output) it will be highlighted to show that a connection is possible. 

3. Release the mouse button.
The cable is connected. If both input and output are in stereo and you 
connect the left channels, a cable for the right channel is automatically 
added.

➜ You can change an existing connection in the same way, by clicking 
on one end of the cable and dragging it to another connector.

Using pop-up menus
1. Click (or right-click) on a connector.

A pop-up menu appears, listing all devices in the rack. 

2. Move the pointer to the desired device (the device to which you 
want to create a connection).
A submenu appears, listing all suitable input/output connections. For ex-
ample, if you clicked on an audio output on a device, the hierarchical sub-
menus will list all audio inputs in all other devices.

➜ If a device is greyed out on the pop-up menu, there are no connec-
tions of the suitable kind.

3. Select the desired connector from the submenu.
The connection is created.

Disconnecting Devices
Again, there are two ways to disconnect devices:

➜ Click on one end of the cable, drag it away from the jack and drop it 
anywhere away from a jack.

or 

➜ Click on one of the connectors and select “Disconnect” from the 
context menu that appears.
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Using CV and Gate
CV/Gate is used for modulating and triggering device parameters. Each sep-
arate Device chapter lists the available CV/Gate connections, the parame-
ters that can be modulated or be used for modulation outputs for the device.

Routing CV and Gate
There are not really any hard and fast “rules” applicable to CV/Gate routing. 
A few points should mentioned:

➜ The specific “Sequencer Control” inputs present on the Subtractor 
and NN-19 sampler devices are primarily intended for controlling 
these devices as (monophonic) instruments from the Matrix Pattern 
Sequencer.
If your intention is to use the Matrix CV/Gate outputs to create melodic 
patterns using these Instrument devices, you should use the Sequencer 
Control inputs. 

✪ The Matrix Pattern Sequencer can be used in many other ways, be-
sides creating melodic patterns. For example you could use it to 
modulate any CV controllable parameter, with the added advantage 
of the modulation being synchronized to the tempo.

➜ Conversely, if you would like to apply Gate or CV modulation to 
more than one voice, you should not use the Sequencer Control in-
puts, as these only function monophonically.

➜ Feel free to experiment: Use Gate signals to control parameter val-
ues and CV signals to trigger notes and envelopes, if you like.
See the chapter “Matrix Pattern Sequencer” for more tips about using 
CV.

About the Voltage Trim Knobs
All CV inputs have an associated Trim knob. This is used to set the CV “sen-
sitivity” for the associated parameter. The further clockwise a voltage trim 
knob is set, the more pronounced the modulation effect. 

• Turned fully clockwise, the modulation range will be 100% of the pa-
rameters range (0-127 for most parameters). 

• Turned fully anti-clockwise, no CV modulation will be applied.
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About the Various MIDI 
Inputs
All MIDI Inputs are set up in the Preferences-MIDI dialog. This chapter de-
scribes the various ways you can set up how incoming MIDI is received.

Sequencer Input

The Sequencer is the “standard” port for receiving MIDI input. This is what 
you should be using if you intend to use the Reason sequencer.

Once you have selected your MIDI interface on the Sequencer Port pop-up 
(and which channel it should receive on), you can direct incoming MIDI to 
any device by just clicking the “In” column to the left of a track name in the 
track list.

External Control Bus Inputs

The External Bus inputs provide up to 64 MIDI input channels divided into 
four buses, each with 16 channels.

➜ These MIDI inputs are primarily for controlling Reason Devices from 
an external sequencer.

This could be an external hardware sequencer or sequencer software that is 
installed on the same computer as Reason. You should preferably use a 
multiple port MIDI interface, so you can select separate ports for Reason and 
the other MIDI devices to use, although this isn’t strictly required. See “Send-
ing MIDI Data to Reason” below for further information.

Remote Control Input

The Remote Control input is used for assigning a MIDI port for receiving MIDI 
Controller messages for “live” remote control. How to use Remote Control is 
described in the chapter “MIDI and Keyboard Remote Control”.

MIDI Clock Input

Using MIDI Clock, you can slave (synchronize) Reason to hardware devices 
(tape recorders, drum machines, stand alone sequencers, workstations etc.) 
and other computer programs running on the same or another computer. 
MIDI Clock is a very fast “metronome” that can be transmitted in a MIDI Ca-
ble. As part of the MIDI Clock concept there are also instructions for Start, 
Stop and locating to sixteenth note positions.

➜ By first selecting the appropriate MIDI input using the MIDI Clock 
pop-up and then selecting “MIDI Clock Sync” on the Options menu, 
Reason is ready to receive MIDI Clock sync. 
See the “Synchronization” chapter for more information.
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Sending MIDI Data to 
Reason
Setting up MIDI Inputs under Mac OS
Reason requires OMS to receive MIDI. How to install OMS is described in 
the chapter “Installation”. OMS uses a concept of Devices, which basically 
means an external MIDI keyboard or sound module etc.

➜ Each of Reasons’ seven MIDI inputs can receive data from one OMS 
device.
Use OMS Setup to create the devices needed (for example one per in-
put).

➜ One OMS device can be used for several of Reason’s MIDI inputs.
However, note that this may lead to some confusion about what MIDI sig-
nals go where.

✪ We recommend that you use separate OMS Devices to each MIDI In-
put in Reason.

➜ If you have several MIDI programs running at the same time, they 
can share MIDI ports between them. Again, this might lead to con-
fusing results and is probably best avoided.

! Please try make sure that MIDI data sent to Reason is sent to Rea-
son only, and not to any other application running at the same time.

Setting up MIDI Inputs under Windows
In the Preferences-MIDI dialog, each MIDI input pop-up will show all MIDI in-
put ports currently installed in your system.

Each of Reasons’ seven MIDI inputs can receive data from any port. It is pos-
sible to route several MIDI inputs so that they receive data from the same 
physical MIDI In port, but you should generally avoid this as it can easily get 
confusing.

➜ Reason only “grabs” the MIDI inputs you are actually using. MIDI in-
puts not selected in the Preferences – MIDI dialog are available to 
other programs.

➜ Note that other MIDI programs may “grab” all MIDI ports in your 
system when you launch them! If no MIDI inputs are available to 
Reason on startup a warning alert will appear. 
However, some of these programs allow you to disable the use of a par-
ticular MIDI input. If for example you have two MIDI interfaces, you may 
be able to set things up so that one of them is used by Reason and the 
other by the other application. Please consult the documentation for the 
other application for details.

Sending MIDI Data from another Application 
under MacOS
To send MIDI from another application installed on the same computer as 
Reason, you need to have the OMS IAC (Inter Application Communication) 
driver installed.

! Note that the IAC driver is not installed with the “Easy Install” op-
tion in the OMS installer. If you have installed OMS using this op-
tion, you need to perform a Custom install, where the IAC driver can 
be selected (ticked) separately.

Installing more than one IAC Port

Once the IAC driver is installed, it is shown in your OMS Studio Setup dialog. 
Up to four IAC ports can be defined.

1. Double click on the IAC Driver symbol.

2. Name as many ports as you require (up to four).

3. Close the dialog.
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4. Save your OMS Studio Setup.

The OMS IAC port naming dialog.

Selecting IAC busses in Reason’s MIDI Preferences.

Setting up communication between two applications

Proceed as follows:

1. Open the OMS MIDI Setup dialog in OMS Setup and make sure that 
“Run MIDI In Background” is enabled.

2. Launch Reason.
It is important that you launch Reason after making changes to OMS, or 
the changes you have made will not be available.

3. Set up the other program so that it transmits MIDI to an OMS IAC 
port.

4. In Reason, open the MIDI section of the Preferences dialog.

5. Open the MIDI input pop-up for the MIDI Input port(s) that should re-
ceive the incoming MIDI, and select the IAC port that you set up in 
step 3.
Note that the Sequencer Port only receives MIDI on one selected chan-
nel at a time.

Sending MIDI Data from another Application 
under Windows
To send MIDI from another application installed on the same computer as 
Reason, you need to install HLD (Hubi’s Loopback Device) which is included 
on your program CD.

! Note that there are other MIDI routing utilities available apart from 
HLD. These may work just as well, so if you have such a utility al-
ready installed you could try using that instead.

! HLD will not run under NT/2000. 

➜ To install, locate the folder “HLD” on your program CD, open the 
“How to install HLD.hlp” file inside the folder, and follow the in-
structions given.
During the final stage of the installation process you can activate as 
many buses as you need (up to four). When you are done, a computer 
reboot is required.

Setting up communication between two applications

Proceed as follows:

1. Launch Reason.

2. Set up the other program so that it transmits MIDI to a HLD port (by 
default named “LB” plus a number).

3. In Reason, open the MIDI section of the Preferences dialog.
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4. Open the MIDI input pop-up for the MIDI Input port(s) that should re-
ceive the incoming MIDI, and select the LB port that you set up in 
step 3.
Note that the Sequencer Port only receives MIDI on one selected chan-
nel at a time.

Selecting a HLD port.

Controlling Devices 
directly via MIDI
Routing MIDI to Devices
Depending on your MIDI interface, up to four separate ports, each with 16 
channels, can be routed to Reason’s External Control inputs. The following 
applies regarding setting up the External Control buses:

➜ One port/device can be routed to each separate Bus input.
Simply select the port/device using the appropriate Bus pop-up menu in 
the External Control section. One port/device can be routed to several 
Bus inputs.

➜ When you have routed several MIDI ports/devices to corresponding 
External Buses, you use the Bus Select switch in the MIDI In Device 
to select a Bus (A-D) for editing the channel to device routing etc.

If you would like to use an external sequencer to control Reason, there are 
basically two scenarios that could apply:

➜ You have a “stand-alone” hardware sequencer or sequencer soft-
ware installed on another computer.
In this case, you should route the MIDI output from the sequencer (or the 
MIDI interface on the “other” computer) to the MIDI input on the interface 
connected to Reason. You should choose the External Control bus in-
puts for the incoming MIDI. This data is then routed to devices via Rea-
son’s MIDI In device.

➜ You have sequencer software installed on the same computer as 
Reason.
This requires the “OMS IAC Driver” under MacOS, or Hubi’s Loopback 
Device (or similar) under Windows, as explained in the previous section 
of this chapter.



ROUTING MIDI TO REASON44

➜ If you want to manually play (i.e not recorded MIDI data) Reason de-
vices in real time from inside another sequencer program, MIDI thru 
must be activated.
MIDI thru is when incoming MIDI is echoed out via the MIDI output. If you 
don’t know how to do this, refer to the program’s documentation. You will 
also need to make sure that the other application is “thruing” it’s data to 
the correct MIDI port and on the right MIDI channel.

Bypassing the sequencer completely
It is possible to use Reason devices purely as “sound modules”, bypassing 
the Reason sequencer completely. To do this, you should use the External 
Control busses to receive MIDI, and deselect the Sequencer port in the Pref-
erence dialog.

Once you have set up communication between Reason and the other device 
or application, you can hide the sequencer from view, by clicking the “maxi-
mize rack” button at the top of the rack’s vertical scrollbar.

Sending Controller Data via MIDI
It is possible to send controller data from an external sequencer to control 
Reason parameters. Just set up your external device to transmit the correct 
MIDI controller messages on the right MIDI channel.

To find out which MIDI Controller number corresponds to which control on 
each device, please see the “MIDI Implementation Charts.pdf” document.

Once you have located the controller numbers and set everything up, you 
can record and edit the controller data in the external sequencer as you nor-
mally do, and the Reason parameters will react correspondingly.

✪ Do not confuse Remote Control and direct MIDI control. MIDI Re-
mote allows you to map any MIDI Controller to any control on the 
front panel, but is primarily intended for “live” tweaking of parame-
ters during playback.

Recording Pattern changes
As specified in the MIDI Implementation, MIDI Controller #3 can be used to 
switch patterns in a device. However, pattern changes activated this way oc-
cur immediately (not at the end of the bar), which may or may not be what 
you prefer.

Please see page 8 for information on recording and editing pattern changes.
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About this Chapter
This chapter describes how to use Reason as a ReWire slave, that is with 
Reason delivering audio to another ReWire compatible application. It does 
not deal with using ReBirth and Reason together; that is described on page 
156.

Why use Reason with 
ReWire?
While Reason is a complete music tool in its own right, you might want to add 
other elements to the music, such as:

• Vocals.
• Instrumental recordings.
• Hardware synthesizers (controlled via MIDI).

Connecting Reason to another application allows you to do just this, inte-
grate your Reason songs with any other type of music, external MIDI and 
acoustic recordings. By recording Reason onto audio Tracks in an audio se-
quencer you can also continue processing your Reason tracks with other in-
ternal and external effects.

Introducing ReWire!
To make this integration between two audio programs possible, Propeller-
head Software has developed ReWire. This technology provides the follow-
ing possibilities and features:

In ReWire version 1

• Real time streaming of separate audio channels, at full bandwidth, 
into another audio program.

• Automatic, sample accurate, synchronization between the audio in 
the two programs.

• The possibility to have the two programs share one sound card.
• Linked transport controls that allows you to play, rewind etc, from 

either program.
• Less total system requirements than when using the programs to-

gether in the conventional way.

In ReWire 2

A number of features were added in Reason version 2. The following are the 
most important:

• Up to 256 audio channels (previously 64).
• Bi-directional MIDI communication of up to 4080 MIDI channels (255 

devices with 16 channels each)
• Automatic querying and linking features that (among other things) 

allow a host to display the slave’s devices, controllers, drum 
sounds etc. by name.

About ReWire 2
As of this writing there were no applications other than Reason supporting 
ReWire 2. Hence, as we write this, teaming up Reason with another program 
would only give you the features of ReWire version 1.

This chapter describes the ReWire version 1 feature set. As ReWire 2 imple-
mentations will start to appear in other audio applications we will post up-
dated information on our web site, www.propellerheads.se.

How Does it Work?
Basically the key to ReWire is the fact that Reason is divided into three com-
ponents:

• The Reason application.
• The Reason Engine (a DLL on the PC and a Shared Library file on 

the Macintosh)
• ReWire (also a DLL on the PC and a Shared Library on the Macin-

tosh).

ReWire and the Reason Engine are common resources to the two programs 
(the other application and Reason) that generate the audio and passes it 
onto the other audio application.

Terminology
In this text we refer to Reason as a ReWire slave and the application receiv-
ing audio from Reason (Steinberg Cubase, Emagic Logic Audio and Mark of 
the Unicorn Digital Performer for example) as the host application.

About System Requirements
To run Reason together with another audio application of course raises the 
demands on computing power. However, adding ReWire to the equation 
does not in itself require a more powerful computer. On the contrary, it is 
likely that ReWiring two programs requires less power than for example run-
ning them with one audio card each.



USING REASON AS A REWIRE SLAVE 47

Still, you should be aware that running two powerful audio applications on 
one computer will require a fast processor and most of all a healthy amount 
of RAM.

Preparations for Using 
ReWire - Macintosh only
When you use ReWire, some of the system resources normally occupied by 
Reason are “transferred” to the other audio application: More specifically, the 
RAM required for loading samples in Reason, must now be provided by host 
application instead. Therefore, when using ReWire we recommend you to 
make the following changes to your memory settings for the two programs 
(for details, see your Macintosh manual):

1. If you have raised the maximum memory setting in Reason (to be 
able to use more samples) lower it back to the recommended value, 
but make a mental note of how much it was set to.

2. Raise the Maximum memory for the host application by at least the 
amount that you just lowered for Reason.

Launching and Quitting
When using Rewire, the launch and quit order is very important:

Launching for normal use with ReWire

1. First launch the host application.

2. Then launch Reason.

Quitting a ReWire session

When you are finished, you also need to Quit the applications in a special or-
der:

1. First quit Reason.

2. Then quit the host application.

Launching the host application for use without Reason/
ReWire

If you don’t plan to run Reason, just launch the host application as usual. We 
recommend that you then also deactivate all ReWire channels if required 
(see the relevant section for your program, below). But this is not completely 
critical, ReWire does not use up very much processing power when it isn’t 
used.

Launching Reason for use without the host application

If you want to use Reason as it is, without ReWire, just launch it as you nor-
mally do.

Launching both programs without using ReWire

We don’t know exactly why you would want to run Reason and a Rewire host 
application at the same time on the same computer, without using ReWire, 
but you can:

1. First launch Reason.

2. Then launch the host application.

You may get a warning message in the host application, regarding ReWire, 
but you can safely ignore it. Please also note that the two programs now 
compete for system resources such as audio cards, just as when running ei-
ther with other, non-ReWire, audio applications.
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Steinberg Cubase VST
Cubase Versions
In this description we assume you are using Cubase VST 5.0 on the MacOS 
or Windows platforms.

! For Cubase VST under Windows, please make sure you use 5.0rc2. 
Earlier versions have some technical problems with ReWire con-
nections.

OMS – Very Important information for MacOS 
Users!
l If you have OMS installed, Cubase VST must be set to use OMS as well.

➜ The OMS Compatibility setting in the MIDI System Setup dialog 
must be set to “IN & OUT”!

➜ “Run MIDI In Background” must be enabled in the OMS MIDI Setup!

Activating ReWire Channels in Cubase VST

! Do not deactivate Play in Background (on the Options menu in Cu-
base VST). If you do, the communication between the two programs 
will be lost.

To activate the desired inputs from Reason, in Cubase VST, proceed as fol-
lows:

1. Pull down the Panels menu and select ReWire.

2. Click on the green buttons to activate/deactivate the desired chan-
nels.
The 64 channels correspond to the 64 audio inputs on the Hardware De-
vice in Reason. Please note that the more ReWire channels you activate, 
the more processing power is required.

3. If desired, double click on the labels in the right column, and type in 
another name.
This is the label that will be used in VST to identify the ReWire channel.

The ReWire window in Cubase VST. Here, four channels are activated.

4. Connect devices in Reason to the activated channels on the Hard-
ware Device and the audio will appear in the Mixer in Cubase VST 
(se below).
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How the ReWire Channels are handled in 
Cubase VST
When you activate ReWire channels in the ReWire window in VST, as de-
scribed above, new channels are added to the VST Channel Mixer.

A few ReWire channels in the VST Channel Mixer.

These channels have the following properties:

➜ The ReWire channel strips are red and appear between regular 
channels and group channels.

➜ Stereo outputs from Reason appear as stereo channels in Cubase 
VST.

➜ The name of the ReWire channel is printed at the bottom of each 
strip, for identification.

➜ These channels are identical to regular VST audio Channel Mixer 
strips, except that they have no input. That is, they have all the fx, 
EQ, bussing and automation facilities provided by regular hard disk 
recording channels.

➜ For information about how to set levels, panning, EQ, fx and bus-
sing, and how to create automation, see the Cubase VST documen-
tation.
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Emagic Logic Audio
In this description we assume you are using a version of Logic Audio that is 
later than 4.6.

Activating ReWire Channels in Logic Audio
To activate the desired inputs from Reason, in Emagic Logic Audio, proceed 
as follows:

1. Open the Audio Mixer window from the Audio menu.
Locate the first channel that you want to use for ReWire input and select 
it by clicking at its name at the bottom of the channel strip.

2. In the inspector to the left, pull down the “Cha” menu and select the 
desired ReWire input.
In the list that appears, all ReWire inputs are listed one after the other. 
This list does not display the name of the application, so if you have more 
than one ReWire application installed (for example both Reason and Re-
Birth) be careful to select the correct input.

3. Continue to select more channels and activate ReWire inputs for 
these.
Logic Audio presents all ReWire inputs as mono, so to set up a stereo 
pair, like the Left and Right outputs from Reason you need to use two 
channels.

The ReWire channels as they appear in Emagic Logic. Here, the stereo channels L 
and R are connected to audio channel 1 and 2 in Logic’s mixer window.

4. Connect devices in Reason to the corresponding channels on the 
Hardware Device and the audio from these outputs will appear in 
the Mixer in Emagic Logic.

How the ReWire Channels are handled in 
Emagic Logic
When you activate ReWire channels in Logic Audio, as described above, 
channels in the Audio Mixer will play the audio coming in via ReWire.

These channels have the following properties:

➜ Just above the pan control you can see the name of the ReWire in-
put.

➜ These channels are identical to regular audio channels. That is, 
they have all the fx, bussing and automation facilities provided for 
regular hard disk recording channels.

➜ The ReWire channels are all in mono. To set up a stereo pair, use 
two adjacent channels. If you want to make identical settings for the 
two channels (for example perform a stereo fade), select both chan-
nels by holding down [Shift] and move the desired control on either 
of them.

➜ For information about how to set levels, panning, EQ, fx and bus-
sing, and how to create automation, see the Logic Audio documen-
tation.
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Mark of the Unicorn 
Digital Performer
Performer Versions
In this description we assume you are using Digital Performer version 2.72 or 
later.

OMS
Since Reason requires OMS we recommend that you set up Digital Per-
former to also use OMS. In that way you can for example use OMS’s IAC 
feature to send MIDI between the programs.

Activating ReWire Channels in Digital Performer
To activate the desired inputs from Reason, in Digital Performer, proceed as 
follows:

1. Make sure you have the Tracks window up on screen.

2. Create as many audio tracks as you need ReWire inputs. For each 
one decide whether you want it to use a mono or stereo voice.
For example, you might want to set the track assigned to the Left/Right 
output in Reason to use a stereo voice and other tracks to use mono 
voices. Note that you can always add or remove channels later as will, 
the system is completely dynamic.

3. Pull down the Input menu for a track and select the desired Reason 
input.

4. Click the record enable button for the track(s).

5. Connect devices in Reason to the corresponding channels on the 
Hardware Device.
Now when you play back, the audio from Reason will appear on the cor-
responding voices in Digital Performer.

Here the Digital Performer Mixing Board is displayed with three Reason inputs 
selected, one stereo and two mono.

How the ReWire Channels are handled in Digital 
Performer
When you set up tracks to receive audio from ReWire, as described above, 
the corresponding tracks are added to the track list in the Mixing Board win-
dow. 

➜ The tracks have generic names by default. to rename them hold 
down [Option] and click on the name at the bottom of the channel 
strip.

➜ These channels are identical to regular audio channels. That is, 
they have all the fx, bussing and automation facilities provided for 
regular hard disk recording channels.

➜ For information about how to set levels, panning, EQ, fx and bus-
sing, etc, see the Digital Performer documentation.
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Using the Transport and 
Tempo Controls
Basic Transport Controls
When you run ReWire, the transports in the two programs are completely 
linked. It doesn’t matter in which program you Play, Stop, Fast Forward or 
Rewind. Recording, however, is still completely separate in the two applica-
tions.

Loop Settings
The Loop in Reason and the corresponding feature (Loop, Cycle etc) in the 
host application are also linked. This means that you can move the start and 
end point for the Loop/Cycle or turn the Loop/Cycle on/off in either program, 
and this will be reflected in the other.

Tempo Settings
As far as tempo goes, the host application is always the Master. This means 
that both program will run in the tempo set in the host application.

However, if you are not using automated tempo changes in the host applica-
tion, you can adjust the tempo on the transport in either program, and this will 
immediately be reflected in the other.

! If you are using the automated tempo changes in the host applica-
tion, do not adjust the tempo on the Reason transport, since that 
tempo the doesn’t have any effect on playback!

MIDI Control With ReWire
If you are using a host application that is not Rewire 2 compatible, you will 
need to send MIDI via OMS IAC (MacOS) or a MIDI routing utility such as 
HLD (Windows) This is described on page 41.

Converting ReWire 
Channels to Audio Tracks
If you want to “convert” your ReWire channels into hard disk tracks, use the 
facilities in your host application. Basically there are two ways that this can 
be done. Exactly which one applies to you depends on which type of host ap-
plication you are using:

➜ Record the audio in real time onto audio tracks in the host applica-
tion.

➜ Export your song as an audio file, by using a feature named Export 
Audio or similar in the host application.
See the host application documentation for details.

Synchronization
All synchronization to other equipment is handled from the host application, 
not Reason. In fact there are no special synchronization issues. All that is 
said in the host application’s documentation about synchronizing audio chan-
nels is true for ReWire channels as well.
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Introduction
It is possible to assign computer keyboard commands and/or MIDI controller 
messages to most Reason device parameters or functions. Both methods al-
low you to use a “learn” function to instantly assign the parameter knob, 
slider or button to a keyboard command or a controller on an external device.

MIDI Remote Mapping
If you want to control one or several Reason parameters in real time from an 
external MIDI device, you can use MIDI Remote Mapping. The external de-
vice could be a dedicated MIDI performance controller, for example. 

Setting Up

! If you are using a single MIDI interface with only one MIDI Input, 
there are certain restrictions to how you can use MIDI Remote Map-
ping. See “Example MIDI Setups” below for an explanation. 

To set up Reason for MIDI Remote Mapping, proceed as follows:

1. Open the Preferences dialog from the Edit menu and select the MIDI 
page.

2. Open the Remote Control pop-up in the Miscellaneous section, and 
select your MIDI input.
This should be a preferably be a separate port that you “dedicate” to 
sending controller messages, see below.

3. Close the Preferences dialog.
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Example MIDI Setups
There are several possible variables when it comes to what type of MIDI 
setup you are using. Please read on. 

“Ideal” Setup

The ideal setup is a computer with two MIDI interfaces or one MIDI interface 
with multiple, separate inputs, a MIDI keyboard used for playing/recording 
and a separate MIDI Controller device (“fader box”) used for remote control.

1. Connect your MIDI keyboard to one MIDI Input. 

2. Connect your MIDI remote device to the other MIDI Input.

3. Open the Preferences – MIDI dialog and set things up so that the 
MIDI keyboard is used for playing and the fader box is used for MIDI 
Remote control.

If You are Using a Single MIDI Interface with one MIDI Input 
only

In this scenario we assume you have your MIDI keyboard and external MIDI 
controller connected to the same MIDI Input on your computer. In this case 
it’s a little bit trickier to get things to work correctly. Here’s the problem:

If you are using the sequencer input for playing a device, the device will react 
to MIDI controller messages via this input, since all devices are always set up 
to react to MIDI controller messages (see page 197 for details).

Now, if you happen to set things up so that a control on a device reacts to the 
same MIDI Controller message as is used for remote control of another con-
trol (maybe even on another device) both controls will move simultaneously 
on screen!

The solution is to separate things via MIDI Channel messages. Proceed as 
follows:

1. If you are using the MIDI sequencer input to play your devices, open 
the Preferences - MIDI dialog and make a note of which MIDI Chan-
nel is used for sequencer input.

2. If you are instead using one of the direct MIDI buses A to D, check 
the Hardware Interface to find out which MIDI Channels are already 
taken by devices in the rack.

3. Set up your MIDI Controller (that you plan to use for MIDI Remote 
control) to transmit on any MIDI channel that is not already occu-
pied (as described above).

4. When you then set up MIDI remote Control, only use the MIDI Chan-
nel on which your MIDI Controller is now set to transmit on.
This will ensure that remote control doesn’t conflict with other MIDI.

If you only have one MIDI Device

If you only have one MIDI Device that you plan to use both for playing/record-
ing and for remote control, there are severe restrictions. Actually there ‘s only 
one sensible way to avoid conflicts.

1. Open the “MIDI Implementation Charts.pdf” document.
This can be found in your program folder.

2. Make a note of the controller numbers that are not used for direct 
control of any device at all.

3. Set up your MIDI remote control so that it only uses these unused 
MIDI Controller numbers.

! Please note that you can only assign a MIDI Controller number for 
remote control of one parameter at a time. If you try to assign a sec-
ond parameter to a MIDI Controller number already used, the previ-
ously assigned parameter is overridden by the new one. 

Enabling MIDI Remote
To enable MIDI Remote, select “Enable MIDI Remote Mapping” from the Op-
tions menu.
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Editing MIDI Remote Mapping
1. To get an overview of which parameters are MIDI remote controlla-

ble select “Edit MIDI Remote Mapping” from the Options menu. 
When done, each device you select will show a green arrow symbol be-
side every parameter that can be assigned a MIDI remote.

A section of a mixer with MIDI Remote enabled.

2. If you click on a assignable parameter, a dialog appears allowing 
you to select a MIDI controller (or a Note number) to control that pa-
rameter.
Note numbers function exactly like Keyboard remote - they can only con-
trol on/off or min/max values (see page 57).

The MIDI Remote dialog.

3. Make sure that the “Learn from MIDI Input” box is ticked.

4. Simply turn the knob (or slider etc.) that you wish to use to remote 
control the parameter.
The “MIDI Received” field momentarily flickers as you turn the knob, and 
then the dialog shows the controller number and the channel it is trans-
mitted on.

5. Click “OK” to exit the dialog.
The selected parameter now has a tag, displaying the controller number, 
and the MIDI channel used.

6. To exit Edit MIDI Remote Mapping mode, deselect it from the Op-
tions menu.
You do not always have to use this method - see below.

About the two Edit MIDI Remote Mapping Modes

If Edit MIDI Remote Mapping is enabled (ticked) on the Options menu, as-
signed parameters are “tagged”, and the arrow indicators show the assign-
able parameters. In this mode, however, you cannot operate Reason 
normally, as every parameter you click on will open the MIDI Remote dialog. 
The Edit mode is primarily for overview of available parameters and the cur-
rent assignments.

➜ Another way to assign keyboard remote commands is to have “Edit 
MIDI Remote Mapping” deselected on the Options menu, and to 
simply [Ctrl]-click (Mac) / right-click (PC) the parameter you wish to 
remote control.
This opens a pop-up menu, where one of the options will be “Edit MIDI 
Remote Mapping”. Selecting this opens the MIDI Remote dialog. Thus, 
you do not have to select Edit mode from the Options menu if you already 
know that a parameter is free and assignable.
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Keyboard Remote
Assigning keyboard remote commands is very similar to MIDI remote map-
ping. However, as there is no MIDI involved, there is no special setting up re-
quired. Keyboard commands can be assigned the same parameters as when 
using MIDI remote mapping, but the functionality differs in one central as-
pect:

➜ Keyboard Remote commands can only be used to toggle on/off or 
min/max values for an assigned parameter.

Hence, if you assign a keyboard remote command for a knob, slider or spin 
control, it will only switch between the minimum and maximum values for that 
parameter. The only exception to this are the multi-selector buttons used for 
various parameters such as envelope destination, for example. These will 
cycle through the available options when using keyboard remote.

Enabling Keyboard Remote
To enable Keyboard Remote, select “Enable Keyboard Remote” from the 
Options menu, or press [Command]+G (Mac) or [Ctrl]+G (PC).

Editing Keyboard Remote
➜ To get an overview of which parameters are remote controllable se-

lect “Edit Keyboard Remote” from the Options menu. 
When done, each device you select will show a yellow arrow symbol be-
side every parameter that can be assigned a keyboard remote.

A section of a drum machine with Keyboard Remote enabled.

➜ If you click on a assignable parameter, a dialog appears allowing 
you to select a key command for that parameter.
You may use any key except the Space bar, Tab, Enter or the Numeric 
keypad (which is reserved for Transport functions) or a combination of 
[Shift] + any key (with the same aforementioned exceptions).

The Keyboard Remote dialog.

➜ Simply press the key (or key combination) you wish to use to re-
mote control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the 
keystroke(s), and then the dialog displays the name of the key you have 
pressed. If [Shift] was used, the box beside the word Shift in the dialog is 
ticked. 
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About the two Edit Keyboard Remote Modes

If Edit Keyboard Remote is enabled (ticked) on the Options menu, assigned 
parameters are “tagged”, showing the remote key for that parameter. In this 
mode, however, you cannot operate Reason normally, as every parameter 
you click on will open the Key Remote dialog. This mode is primarily for over-
view of available parameters and the current assignments.

➜ Another way to assign keyboard remote commands is to have “Edit 
Keyboard Remote” deselected on the Options menu, and to simply 
[Ctrl]-click (Mac) / right-click (PC) the parameter you wish to remote 
control.
This opens a pop-up menu, where one of the options will be “Edit Key-
board Remote”. Selecting this opens the Key Remote dialog. Thus, you 
do not have to enable/disable Edit mode from the Options menu if you 
know that a parameter is assignable.

! If you try to assign a Remote Key that is already in use, you will get 
an alert asking if you wish to change the current assignment.

Saving Remote Setups
MIDI or Keyboard Remote setups are always stored with the song. But per-
haps you wish to be able to recall this setup for use in a new song, or perma-
nently use a specific remote setup. 

➜ This could be done by saving a song document containing all the 
devices that are affected by the remote setup together with the re-
lated Key or MIDI mapping, but without any sequencer data. 
This song document could then be used as a starting point for any new 
song, by simply loading it, and immediately using “Save As” to save it un-
der a new name.
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ReWire users – Read 
This!
This chapter does not apply to users of ReWire. If you are using Reason to-
gether with a ReWire compatible application, ReWire handles all synchroni-
zation issues for you, automatically. See the ReWire chapter for details.

What is Synchronization 
and MIDI Clock?
Synchronization, in this context, is when you make Reason play at the same 
tempo as another device; where both start, stop and can locate to certain po-
sitions, together. This is done by transmitting MIDI Clock signals between 
Reason and the other device. MIDI Clock is a very fast “metronome” that can 
be transmitted in a MIDI cable. As part of the MIDI Clock concept there are 
also instructions for Start, Stop and locating to sixteenth note positions.

You can set up synchronization between Reason and hardware devices 
(tape recorders, drum machines, stand alone sequencers, workstations etc.) 
and other computer programs running on the same or another computer.

Master/Slave
In a synchronized system there is always one master and one or more 
slaves. In our case, the master is the one that controls the tempo. In other 
words, it is only the tempo setting on the master device that is of any rele-
vance, since the slaves slavishly follow the master's tempo.

➜ Reason always acts as a slave. That is it receives MIDI Clocks, it 
never transmits them.

! Before you create any serious projects that require sync, try out the 
features described below and check out “Synchronization Consid-
erations” on page 117.

Slaving Reason to an 
External Device
This example assumes that you have an external device, such as a drum 
machine, hardware sequencer, another computer, tape recorder etc., that 
transmits MIDI Clocks that you want to synchronize Reason to. 

1. Connect a MIDI Cable from the MIDI Out on the other device to a 
MIDI In on the computer running Reason.

2. Set up the other device so that it transmits MIDI Clock signals to the 
MIDI Out you just connected to the computer running Reason.

3. In Reason, pull down the Edit menu and open the Preferences dia-
log. Select the MIDI page.

4. Pull down the MIDI Clock pop-up and select the MIDI Input to which 
you connected the MIDI cable from the other device.
On the Macintosh, if you do not understand which Input this is, or if that 
MIDI input doesn’t appear in the list, consult your OMS documentation for 
information on MIDI interfaces, MIDI ports and naming.

Reason Mac set up to sync to MIDI Clock coming in from a MPC-60 drum machine 
connected to an external MIDI interface.
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Under Windows, if you can’t find the MIDI Input you want to use, there is ei-
ther something wrong with the installation of the interface, or some other pro-
gram is holding on to it. Consult the documentation for the MIDI interface, the 
other program and Windows, for more information.

Reason Windows set up to sync to MIDI Clock coming in via the MIDI interface on an 
AWE 64 card.

5. Close the dialog.

6. Activate MIDI Clock Sync from the Options menu in Reason.
This can also be set on the Transport panel.

7. Activate playback on the other device.
Reason will start playing ‘in sync’ with it and the Sync LED on the Trans-
port will light up.

Slaving Reason to 
Another Program on the 
Same Computer
This sections describes how to synchronize Reason to another application 
running on the same computer. This text is based on the following assump-
tions:

• Under MacOS, that the other program has full support for OMS (if 
not see page 62) and that you have read and understood the in-
structions on MIDI via OMS in general, described in the chapter 
“Routing MIDI to Reason”.

! Note that this makes the two programs play at the same time, that 
is, they both “run” when you “hit play”. It does not means they can 
both play audio at the same time. See page 193 for details about 
“sharing audio”.

• Under Windows that you have read and understood the instructions 
on using a MIDI routing utility such as Hubi’s Loopback Device, as 
described on page 42.

Proceed as follows:

1. Set up the other program, so that it transmits MIDI Clock to Reason:
Under MacOS this is done by selecting the OMS IAC port. Under Win-
dows this is done by selecting one of the MIDI routing utility ports.

2. In Reason, pull down the Edit menu and open the Preferences dia-
log. Select the MIDI page.
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3. Pull down the MIDI Clock pop-up and select the corresponding MIDI 
routing utility port (IAC, HLD etc.).

Windows: Reason set up to sync to MIDI Clock coming in via HLD port number 1.

Mac OS: Reason set up to sync to MIDI Clock coming in via OMS IAC.

4. Close the dialog.

5. Activate MIDI Clock Sync from the Options menu in Reason.

6. Activate playback on the other device.
Reason will start playing ‘in sync’ with it and the Sync LED on the Trans-
port will light up.

MacOS: Slaving Reason 
to a non-OMS Program
If the MIDI program you use does not support the common standard for MIDI 
on Macintosh computers, OMS, you can still set up synchronization, but this 
requires two MIDI interfaces, each connected to one of the serial ports on 
your computer.

1. Set up OMS so that it uses only one of the MIDI interfaces installed.

2. Set up the other application so that it uses the other MIDI interface.

3. Connect a MIDI cable from an output on the “other application” in-
terface to an input on the OMS-controlled interface.

4. Set up the other application so that it transmits MIDI Clock signals 
to the output you connected the cable to.

5. In Reason, pull down the Edit menu and open the Preferences dia-
log. Select the MIDI page.

6. Pull down the MIDI Clock pop-up and select the MIDI Input to which 
you connected the MIDI cable from the other device.
On the Macintosh, if you do not understand which Input this is, or if that 
MIDI input doesn’t appear in the list, consult your OMS documentation for 
information on MIDI interfaces, MIDI ports and naming.

7. Close the dialog.

8. Activate MIDI Clock Sync from the Options menu in Reason.

9. Activate playback on the other device.
Reason will start playing ‘in sync’ with it and the Sync LED on the Trans-
port will light up.
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Synchronization 
Considerations
Adjusting for Latency

Latency compensation (MacOS version)

Because of the latency problem described on page 194, you might need to 
adjust Reason’s playback in relation to the sync master, so that they are in 
perfect time. The tempo will not differ between the two, but Reason might 
play ahead or behind the other application. You might need to adjust this. 
However, this is something you only need to do once. The setting is stored 
with your other preferences, so you don’t need to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for 
example quarter or eighth notes, preferably with a special sound on 
the downbeat.
This click can either come from an internal metronome or from a MIDI 
source. If you use a MIDI source, make sure you pick one that has solid 
MIDI timing.

2. Set up Reason so that it plays a similar rhythm as the other applica-
tion.
You might for example use the Metronome or Redrum drum computer for 
this.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in Reason and select the Audio page.

6. Trim the “Latency compensation” setting until the “clicks” from the 
both sources sound at exactly the same time.

7. Close the Preferences dialog in Reason.

If Latency Compensation isn’t enough
There might be situation s where you can’t compensate enough in Reason to 
make two software applications run in sync. This might especially be true if 
the other application is an audio sequencer, that is if it can both record and 
playback audio and MIDI.

This problem an indication to the fact that the other application has not been 
set up properly and that its audio playback is not in sync with its own MIDI 
playback.

! This is not something that you can or should compensate for in 
Reason. Instead, follow the instruction included with the other ap-
plication to make sure its MIDI playback and audio playback or cor-
rectly locked to each other.

About the beginning of the Song
Due to the latency phenomenon, described on page 194, Reason needs 
some time to correct it’s playback speed when it first receives the Start com-
mand. This can be noted as a small glitch in the audio playback, when the 
program starts. If this is a problem, you need to insert a couple of empty 
measures at the beginning of the Song. Proceed as follows: 

1. Set the Left Locator to “1 1 1” and the right Locator to “3 1 1“.

2. Click somewhere in the main sequencer area to move the menu fo-
cus to the sequencer.

3. Select “Insert Bars Between Locators” from the Edit menu.

4. Set up the other device/application, so that it also plays two empty 
bars at the beginning.

About MIDI Song Position Pointers
MIDI Clock actually consists of five type of messages: The actual clock (the 
metronome that establishes the tempo), Start, Stop and Continue commands 
and Song Position Pointers. This last type of message contains information 
about positions, so that a program for example “knows” where in a Song to 
start playback from.

Normally, this ensures that you can locate to any position and activate play-
back from there. In older devices, Song Position Pointers might not be imple-
mented. This means that you will be able to synchronize properly only if you 
start both devices from the absolute beginning of the song.
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About Tempo Changes
Again, due to the latency phenomenon, Reason needs a bit of time to adjust 
to changes in tempo. If there are abrupt changes in the MIDI Clock, due to 
drastic tempo changes on the master, you will note that Reason will require 
up to one measure to adjust itself to the change. How long this actually takes 
also depends on the precision of the incoming MIDI Clock. The more precise 
it is, the faster Reason can adjust to it. 

If this adjustment is a problem, try to use gradual tempo changes rather than 
immediate ones.

! When Reason is synchronized to MIDI, there is no Tempo readout.
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Introduction
Reason is a program of infinite possibilities. You can create as complex 
songs as you like, using endless racks of devices. While this is one of the 
most exciting properties of the program it does have a drawback – it means 
that you must be careful with how you manage your computer processing 
power.

Each device you add to the rack uses up a bit of computer processing power 
– the more devices the faster the computer has to be. However, you can set 
up your devices to require more or less processing power. For example a 
sound on the Subtractor synthesizer that only uses one oscillator and one fil-
ter requires much less processing power than one using both dual oscillators 
and dual filters.

Samples used in your songs also require RAM - memory - to load properly. 
The use of RAM can also be managed, as described at the end of this chap-
ter.

When creating songs for other people, for example for publishing in the Rea-
son song archive (see www.propellerheads.se for more information), you 
should do what you can to reduce the requirements for playing back a certain 
song, both in terms of processing power and in terms of RAM requirements. 
Other users may not have as powerful a computer as you do!

Checking Processing Power
On the transport you will find a meter labelled CPU. This indicates how much 
processing power is used at any given moment.

The CPU meter.

The higher this meter goes, the higher the strain on your computer proces-
sor. You will note that when your processor is heavily loaded that graphics 
will update slower. Finally, when there’s too little power left to create the au-
dio properly, the sound will start breaking up.

Optimization and Output 
Latency
There is s a certain connection between output latency and the demands on 
your computer (for more information on latency see page 194):

When your computer doesn’t have enough resources to play back a song, 
audio playback will start breaking up. One way of reducing the overhead on 
the computer is to raise the latency. There are two ways to do this:

➜ If you are using an ASIO driver, open its control panel (from the 
Preferences – Audio dialog) and raise the buffer setting.
This is mainly effective if you are currently using very small buffers, 64 to 
256 samples. If the buffers are already big (1024 or 2048 samples) you 
will not notice much difference.

➜ If you are using an MME or DirectX driver, adjust the Output Latency 
slider in the Preferences – Audio dialog.

✪ Please note that raising these values introduces more delay when 
playing devices in real time.

For more information on various driver types, see the chapter “About Audio 
on Computers”.
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Optimizing Your 
Computer System
In this manual we do not have the possibility to give you detailed procedures 
for optimizing your computer for maximum power. This is a subject that we 
could write complete books on! However, we’d like to share a couple of im-
portant tips:

➜ Quit other programs that are running at the same time as Reason.

➜ Remove background tasks on your computer.
This might be any background utilities you have installed as well as net-
working, background internet activities etc.

➜ Under Windows, make sure you use the latest and most efficient 
driver for your audio card.
Generally, ASIO drivers are the most efficient, followed by DirectX and 
last MME.

➜ Only work on one Reason document at a time.
Songs that are open in the background do consume some processing 
power even though they’re not playing.

➜ Lower the sample rate setting on the Preferences dialog.
While this also reduces sound quality, it is a very quick and convenient 
way to try to play a song that your computer otherwise can’t handle.

➜ Make sure your computer display is set to 16-bit colors.
Under Windows, this mode is called “High Color”; under MacOS it is 
called “Thousands of colors”.

Optimizing Songs
Below follows things you can check and change to make sure your song 
uses as little computer processing power as possible:

Global
➜ Delete unused devices.

If a device isn’t actually doing anything, delete it from the rack.

➜ Use fewer devices.
For example, instead of using several reverbs as insert effects, replace 
them all with one, set up as a send effect. By the same token, try to use 
one sampler playing several different samples instead of numerous sam-
plers playing one sample each.

➜ Don’t use stereo unless it is required.
For example, if your NN19 sampler or Dr. Rex player is playing mono ma-
terial, only connect the Left output and leave the Right output uncon-
nected.

Sample Players – NN19, Dr. Rex and Redrum
➜ Only activate High Quality Interpolation when it is required.

Listen to the sound in a context and determine whether you think this set-
ting makes any difference. However, note that on a Macintosh G4, High 
Quality Interpolation does not require any more processing power.

➜ If you are playing back a sample at a much higher pitch than it was 
recorded at, consider sample rate converting the actual sample file 
to a lower sample rate.
This will require an external sample editor with good sample rate conver-
sion facilities.

➜ Try to refrain from using stereo samples.

Filters – Subtractor, NN19 and Dr. Rex
➜ Deactivate filters that are not used.

Observe that if the Cutoff is all the way up or the envelope is set to open 
the filter fully, then the filter doesn’t affect the sound. Conserve process-
ing power by disabling the filter altogether.

➜ Use the12dB lowpass filter instead of the 24dB lowpass filter. 
See if you can get the same sonic result by using the 12dB filter, since it 
uses up less processing power.
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Polyphonic Devices – Subtractor, NN19, Dr. Rex 
and Redrum
➜ Try making the device play fewer voices.

This can be done for example by lowering the release and setting the Po-
lyphony setting to exactly the maximum number of notes played simulta-
neously by this device.

✪ Please note that just lowering the polyphony setting has no effect. 
Unused voices do not consume processing power.

➜ Try the Low Bandwidth (Low BW) setting.
This will remove some high frequency content from the sound of this par-
ticular device, but often this is not noticeable (this is especially true for 
bass sounds).

Subtractor
➜ Try avoiding using Oscillator 2 altogether.

If you can create the sound you need with only one oscillator, this saves 
considerable amounts of processing power.

➜ Do not use the oscillator Phase mode if you don’t need it.
In other words, set the Oscillator Mode switches to “o”, not “*” or “–”.

➜ Do no activate Noise unless required.

➜ Do not activate Filter 2 unless required.

➜ Do not use FM unless required.
In other words, set the oscillator FM knob to “0” and make sure no modu-
lation source is routed to FM.

Redrum
➜ Do not use the Tone feature available on channel 1, 2 and 9.
In other words, make sure the Tone controls and their accompanying Vel 
knobs are set to “0” (“twelve o’ clock”).

Mixer
➜ Avoid using stereo inputs when not required.

For example, if your sampler or Dr. Rex player is playing mono material, 
only connect it to the Left input on a mixer channel. Leave the Right input 
unconnected.

➜ Do not activate EQ unless required.
If a channel doesn’t make use of EQ, make sure it’s EQ button is deacti-
vated.

Reverb
➜ If you are running out of processing power, try the Low Density al-

gorithm.
This uses up much less power than other algorithms.

Send Effects
➜ When you are using mono effects as send effects, you can connect 

the effect returns in mono as well (disconnect the cable to Aux Re-
turn Right on the Mixer).
This is true for the following effects:

• D-11 Distortion.
• ECF-42 Envelope Controlled Filter.
• COMP-01 Compressor.
• PEQ-2 Parametric EQ.
• DDL-1 Delay (provided the Pan parameter is set to center position).
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Songs and Memory 
Requirements
Songs not only use up system resources in terms of processing power, they 
also require RAM (memory) to load at all.

The amount of RAM required for loading a song, is directly proportional to 
the amount of samples used in the song. For example, a song only using 
Subtractors and effects requires very little RAM.

If you are running out of RAM try the following:

➜ Close other song documents.
All open songs compete for RAM

➜ Under MacOS; raise the memory setting for Reason.
This is done in the FInder by selecting the Reason application and open-
ing the Get Info window.

➜ Under Windows, terminate other applications.
All running application compete for the RAM available in the computer.

➜ Use mono samples instead of stereo.
Mono samples require half the amount of RAM.

➜ Try sample rate converting sample files to a lower sample rate.
Note that this will affect sound quality negatively. Also note that it will re-
quire an external sample editor with good sample rate conversion facili-
ties.
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Overview
The transport panel has standard controls for the sequencer transport, but also features controls for setting tempo, metronome click, locator points etc. The 
main controls in the central area of the transport panel are as follows:

Main Transport Controls
The main transport controls function just like standard controls on tape recorders etc. There are also fixed computer keyboard combinations for the most impor-
tant transport functions:

You can also use the following transport related key commands:

| Function | Key command | Comments

Stop [0] on the numeric keypad or 
[Return]

Pressing Stop during playback stops the sequencer. Pressing stop again, sets the position to the left 
locator (if this is located before the current position). Pressing stop a third time sets the position to the 
start of Bar 1. The Stop button also sends out a “Reset” message, in case of stuck notes or other re-
lated problems.

Play [Enter] on the numeric keypad Starts playback of the sequencer.

Rewind [7] on the numeric keypad Clicking once moves the position backward one Bar. If you press and hold this button on the transport 
(not using key command) it will start scrolling faster after about 2 seconds. 

Fast Forward [8] on the numeric keypad Clicking once moves the position forward one Bar. If you press and hold this button on the transport 
(not using key command) it will start scrolling faster after about 2 seconds.

Record [*] on the numeric keypad, or 
[Command]/[Ctrl]-[Return]

Activates “Record ready” mode if sequencer is stopped. If activated during playback it will start re-
cording immediately (“punch in”).

| Function | Key command | Comments

Toggle Stop/Play Space bar Switches between stop and play mode.

Go to Left Locator (Loop Start) [1] on the numeric keypad Sets the position to the left locator.

Go to Right Locator (Loop End) [2] on the numeric keypad Sets the position to the right locator.

Stop

Play

Rewind

Fast Forward

Song Position Overdub/Replace switch

Loop on/off

Left and Right Locator 

Record

Time Signature

Tempo
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Tempo and Time Signature

The tempo and time signature settings can be adjusted on the transport 
panel. The left tempo field sets the tempo in bpm, and the tempo field to the 
right allows you to fine tune the tempo, in steps of 1/1000 bpm.

➜ You can specify any tempo between 1 and 999.999 bpm (beats per 
minute).

➜ You can also adjust the tempo (in bpm steps) by using the [+] and 
[–] keys on the numeric keypad.

➜ You set the time signature by specifying a numerator (left value 
field) and a denominator (right value field).
The numerator is the number of beats per bar, and the denominator gov-
erns the length of a beat.

Song Position

The song position in Bars, Beats and 16th notes is shown (in that order) in 
the three fields below the transport controls. You can set the positions by us-
ing the spin controls.

➜ You can also set the position by double clicking on a Pos value box, 
typing in a new position (in the format “Bars.Beats.16th notes”) and 
pressing [Return].
If you only type one or two numbers, the remaining numbers will be set to 
their lowest values (e.g. type “5” to set the position to “5.1.1”)

Left and Right Locator Positions

The left and right locators are used for several things, like setting the bound-
aries of a loop or inserting/removing bars. You can set the positions for both 
locators by using the spin controls on the transport panel or by double click-
ing and typing a position value.

Loop On/Off

In loop mode, the sequencer will repeat a section over and over again, during 
playback or recording. You specify the section to be looped by setting the left 
and right locator.

Overdub/Replace Switch

When recording over a previously recorded section, this switch governs the 
following:

➜ In Overdub mode, the new recording is added to whatever was on 
the Track before. 

➜ In Replace mode, the new recording replaces any previously re-
corded notes.

! Note that controllers and pattern changes aren’t affected by this - 
recording controllers will always replace any previously recorded 
controller values. However, you may still want to set the switch to 
Overdub mode, to avoid accidentally removing some recorded 
notes in the area.
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Additional Transport Panel Items

Click

When this is activated, you will hear a click on each beat, with an accent on 
the downbeat of each bar. The click is played back during recording and 
playback. You can adjust the volume of the click by using the Level knob.

MIDI Sync and Focus

This section of the Transport Panel contains items relating to MIDI sync. 

➜ The “Enable” button puts Reason into MIDI sync mode. 
The transport controls will be disabled, and Reason will not run unless 
MIDI sync data is provided from an external device. 

The MIDI and Play Focus buttons relate to how incoming MIDI and MIDI sync 
should be handled if there are several open Song documents. If you have 
two or more Songs opened, and no MIDI sync is used, the currently selected 
Song (the document “on top”) always has MIDI focus. If MIDI Sync is enabled 
(which is global for all currently open Song documents), this functionality 
changes in the following way:

➜ If both “Play” and “MIDI” are activated for a Song, incoming MIDI 
data and MIDI sync will be sent to this Song, regardless of whether 
another Song is currently in focus.

➜ If only “MIDI” is activated for Song, and another Song has “Play” fo-
cus, incoming MIDI will be sent to the former and MIDI sync to the 
latter (i.e this Song will play back), regardless of which Song is cur-
rently in focus.

Automation Override

Automation override is activated when you manually “grab” a parameter that 
is being automated. If you change the setting of an automated parameter, 
the “Punched In” indicator lights up, and the automation data is temporarily 
overridden, until you either click the “Reset” button or press stop on the 
transport. As soon as you click Reset, the automation regains control.

See also page 7.

Audio Out Clipping Indicator

All signals that are being fed into the Hardware Interface (to your audio hard-
ware’s physical outputs) are monitored for clipping (signal overload) at the 
output stage. 

If clipping occurs this indicator will light up, and stay lit for several seconds. If 
this happens, you should reduce the output level, in one of the following 
ways:

➜ If the signals are being sent to your Hardware Interface via a Mixer, 
you should reduce the Master output level from the Mixer.
This will ensure that the relative levels of the mix are kept intact. Alterna-
tively, if the current mix doesn’t represent a “final balance”, and the clip-
ping seems to be caused by individual channels in the mixer, you could 
also try reducing the output of the connected device(s), or pulling down 
the channel faders a bit for the “offending” channels.

! Clipping can only occur in the output stage of the Hardware Inter-
face, not in the Reason mixer or in any other Reason device. How-
ever, it is good practice to keep all mixer channel and master levels 
as high as possible within the normal range, for best results. For ex-
ample, having to compensate channel levels by drastically reducing 
the Master output to avoid clipping is indicative of the mixer chan-
nel levels being set too high.
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➜ If the Audio Out Clipping indicator lights up, and the signals are be-
ing sent directly (not via a Mixer) to your Hardware Interface, you 
can check the meters in the Hardware Interface. If the red segment 
of any of these meters are momentarily lit, this indicates at which 
output(s) the clipping is occurring.
Reduce the output level of all devices connected to outputs whose 
meters show red.

CPU Meter

This bar graph shows the current CPU (processor) load. Note that this mea-
sures how much of the total processor power the Reason “audio engine” cur-
rently is using up. Graphics, MIDI and the “rest” of the Reason program is 
allotted the CPU power not used by the audio engine, so audio always has 
priority. See the chapter “Optimizing Performance” for more information.
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Introduction

The Hardware Interface is where you connect Reason with the “outside 
world”. This is where MIDI is received, and where audio signals are routed to 
ReWire channels or to the physical outputs of your audio hardware. The 
Hardware Interface is always present at the top of the rack, and cannot be 
deleted. This chapter is meant to serve as a panel reference, describing the 
various sections of the device. How to set up your MIDI interface and audio 
hardware is described in Getting Started book and in the chapter “About Au-
dio on Computers”. 

The Hardware interface is divided into two sections: MIDI In Device and Au-
dio Out.

MIDI In Device
Reason’s Hardware Interface can accommodate up to 64 channels of MIDI, 
divided into 4 buses, each with 16 MIDI channels. There are two basic ways 
you can route incoming MIDI to Reason devices, which is set in the Prefer-
ences - MIDI dialog:

➜ Via the Sequencer.
If you choose this option, the selected track’s destination device automat-
ically receives incoming MIDI data. This means that you only have to 
send MIDI over the same port and channel as the sequencer is set to use 
(in the MIDI Preferences), to access any audio device in Reason. This is 
the easiest way of routing MIDI if you are using the built in sequencer. 
There are no settings you need to make in the Hardware Interface if you 
use the Sequencer input.

➜ By using the MIDI “External Control” inputs.
This is also set in the MIDI Preferences. You can select up to four buses 
(if your MIDI interface supports it), each with 16 MIDI channels. If this 
mode is used, you use the pop-up menu for each MIDI channel in the 
MIDI In device to select the destination device you would like to route the 
MIDI to. If you want to send MIDI to Reason over several channels simul-
taneously, you have to use the external control inputs.

Using External MIDI Control 
For each MIDI channel, the MIDI In Device contains the following items:

➜ The Device Pop-Up menu is used to select which device the channel 
should send MIDI to.
Only existing devices are available on the menu.

➜ The Name field displays the name of the device connected to the 
channel.
This is blank if no device is selected.

➜ A note on indicator shows if MIDI is received on this channel.

Bus Select Buttons

These four buttons labeled A, B, C and D are used to select which of the four 
buses is currently displayed in the MIDI In device. If you have a multiple port 
interface you can use up to four buses (or ports), each with 16 MIDI chan-
nels. The Bus Select buttons determine which of the buses is currently in 
view in the MIDI In device.
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Audio Out
Reason supports up to 64 audio output channels.

➜ Each output features a meter and a green indicator which will be lit 
for each channel that is available.

! Remember that the Hardware Interface is where any possible audio 
clipping will occur in Reason. Keep an eye on the clipping indicator 
on the transport panel, and also on the individual meters in the Au-
dio Out panel. If a channel pushes the meter into the red, the output 
level of the device should be reduced.

Using ReWire
If you have ReWire compatible software (like Cubase, Logic, Digital Per-
former etc.) installed, you can port any Reason device output to a ReWire 
channel. In ReWire mode, all 64 channels are available and any device out-
put routed to a ReWire channel will appear in the ReWire host application on 
it’s own channel. See the chapter “Using Reason as a ReWire Slave”.
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Introduction

The Mixer 14:2 allows you to control the level, stereo placement (Pan), tone 
(EQ) and effect mix (AUX Sends) of each connected audio device.

If you have ever used a conventional hardware audio mixer, you will most 
likely find the Mixer very straightforward to use. It is configured with 14 (ste-
reo) input channels, which are combined and routed to the Left and Right 
Master outputs. The vertical channel “strips” are identical and contain - from 
the top down - four Auxiliary Sends, an EQ section, Mute and Solo buttons, 
Pan control, and a Level fader.

Every mixer parameter can of course be automated, and should the need 
arise for more mixer channels, you can simply create another mixer! 

! Note that if you haven’t created a mixer prior to creating an audio 
device, the audio device output will be auto-routed to your audio 
hardware outputs via the Reason Hardware Interface (Audio Out de-
vice). 

The Channel Strip

Each channel strip in the Mixer 14:2 contains the items listed on the next 
page:

AUX Sends 1-4

EQ Treble and Bass controls

EQ On/Off button

Mute (M) and Solo (S) buttons

Pan control

Channel fader

Channel meter

Channel label
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Channel Strip Controls:

| Item | Description |Value Range

Channel Fader The channel fader is used to control the output level of each corresponding channel. 
By adjusting the faders, you can set the desired mix (balance) between different devices connected to the Mixer. 

0 - 127 

Channel Label Each channel in the mixer that has a device connected to it, displays a read-only label with the name of the device to the 
left of the fader.

N/A

Channel Meter The meter is a graphical representation of the channel output level. If the signal level pushes the meter into the range of 
the red area, try lowering either the output level of the device connected to the channel, or the channel fader itself, to 
avoid distortion.

N/A

Pan Control Use this control to set the left/right position of the channel in the stereo field. [Command]/[Ctrl]-click the Pan knob to set 
Pan to the default “0” (center position).

-64 – 0 – 63

Mute (M) and 
Solo (S) Buttons

Clicking a channel’s Mute button silences the output of that channel. Click the button again to unmute the channel.
Clicking a channel’s Solo button silences all other mixer channels, so that you only hear the soloed channel. Several 
channels can be soloed at the same time, but if this is the case, note that soloed channels can’t be muted with the Mute 
button. To mute one of several channels in solo mode you simply “unsolo” it.

On/Off

EQ Treble and 
Bass controls

The EQ Treble and Bass controls is used to cut or boost the higher and lower frequencies of the signal, respectively. 
Click on the EQ button to activate the EQ.
If you need more advanced EQ, you can always use a PEQ2 parametric EQ as an insert effect for a device.

Treble: +/- 24 dB 
at 12 kHz.

Bass: +/- 24 dB 
at 80 Hz.

Auxiliary (AUX) 
Effect Send 1-4

The four independent AUX Sends control the amount of channel signal that is to be sent to other devices - typically ef-
fect processors. The effect output is then normally returned to the Mixer via the AUX Return inputs (see page 84) where 
it is mixed with the dry (non-processed) signal. If you create an effect device when the Mixer is selected, the effect is 
auto-routed to the first available Send/Return connectors. You can then control the amount of effect that is to be applied 
to any device connected to a Mixer channel via the corresponding AUX Send knob. The AUX Send outputs are taken 
post channel fader, and the AUX Send connectors are mono. 

0 - 127
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The Mixer Signal Flow
The basic signal flow of the Mixer 14:2 is as follows:

Note that the Solo function is true “in-place” solo, meaning that if the channel 
uses Auxiliary sends routed to effect devices, the soloed output signal will 
also include the Aux Return signals (from the soloed channel(s) only). 
Hence, you will hear the soloed channel(s) including any Aux Send effects.

The Auxiliary Return 
Section

The Auxiliary Returns provide an “extra” four stereo inputs in addition to the 
Mixer’s 14 stereo channels. The main function of Return channels is to pro-
vide inputs for connected Send effects devices. Each Aux Return channel 
has a level control, and a read-only tape label that display the name of the 
device connected to the Return channel.

The Master Fader

The Master L/R fader controls the summed output level of all channels in the 
Mixer. Use this to change the relative level of all channels, to make fade-outs 
etc.

MuteFader Pan/EQ AUX Sends

Solo Master L/R Output

Effects DevicesAUX Returns 

Input
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Connections
All input and output connectors are as usual located on the back panel of the 
Mixer 14:2. Special connectors are used for “chaining” two or more Mixers 
together. This is described on page 86.

Mixer Channel Connections

➜ Each mixer channel features stereo left/right inputs for connecting 
audio devices. 
Use the left input when manually connecting a mono signal source.

➜ In addition, there are two Control Voltage (CV) inputs (with associ-
ated voltage trim pots), for voltage controlling channel Level and 
Pan from other devices.

Auxiliary (AUX) Send Out

➜ There are four mono Send Out connectors, which normally are used 
to connect to the inputs of effect devices. 
When a Send is connected to an effects device, the corresponding AUX 
Send knob determines the level of the signal sent to the effect device for 
each channel. The Send Output is taken post-channel fader. 

! Note that some effects (for example the Comp-01 compressor or the 
PEQ2 parametric EQ) are effect types which are not designed to be 
used as AUX Send effects, but rather as insert effects, where the 
whole signal is passed through the effect. 

Auxiliary (AUX) Returns

➜ There are four stereo Return input connectors.
These are normally connected to the left and right outputs of effect de-
vices. 

Master Left/Right Outputs

➜ The Master outputs are auto-routed to the first available input pair 
on the Audio Hardware interface. 
This in turn sends the audio to the outputs of your audio hardware.

✪ Note that the Master outputs don’t have to be routed directly to the 
Audio Hardware Interface. You could for example route the Master 
outputs to an effect, and then route the effect outputs to the Hard-
ware Interface instead.

➜ In addition, there is a Control Voltage (CV) input (and an associated 
trim pot), for voltage controlling the Master Level from another de-
vice.
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Chaining Mixers

Two chained Mixers are connected like this, the top Mixer being the “Master” Mixer.

If you need more Mixer channels, you can simply create a new Mixer. If you 
do this, the Mixers are automatically connected via the “Chaining Master” 
and “Chaining Aux” connectors.

➜ The newly created Mixer’s Master Output is connected to the origi-
nal Mixer’s Chaining Master input.
The Master Out Level for the new Mixer is now controllable from the orig-
inal Mixer’s Master fader - so that this fader now controls the Master out-
put level of both mixers.

➜ The newly created Mixer’s four Aux Send outputs is connected to 
the original Mixer’s Chaining Aux connectors.
The new Mixer will now have access to any Aux Send effects connected 
to the original Mixer, via the same corresponding Aux Send(s).

This way, the two Mixers operate as “one”. 

! One exception is the Mute/Solo function, which is not chained. 
Thus, soloing a channel in one of the Mixers, will not mute the chan-
nels in the other Mixer.

You can create as many Mixers as you like, they will be chained in the same 
way, with one Mixer remaining the “master” (i.e. it controls the Master level of 
all chained Mixers and supplies the Aux Send effect sources).

Partially or Non-Chained Mixers

You can also have several Mixers that are only partially or not chained at all. 

➜ You may for example wish to have different Aux Send effects for 
one Mixer. 
Then simply disconnect one or more of the Send Out to Chaining Aux 
connectors, and assign new Send effects.

➜ You could for example send the Master output of one Mixer to an-
other Input pair on the Audio In Hardware interface, instead of the 
Chaining Master inputs.
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Introduction

At first glance, Redrum looks styled after pattern-based drum machines, like 
the legendary Roland 808/909 units. Indeed, it does have a row of 16 step 
buttons that are used for step programming patterns, just like the aforemen-
tioned classics. There are significant differences, however. Redrum features 
ten drum “channels” that can each be loaded with an audio file, allowing for 
completely open-ended sound possibilities. Don’t like the snare - just change 
it. Complete drumkits can be saved as Redrum Patches, allowing you to mix 
and match drum sounds and make up custom kits with ease.

About File Formats
Redrum reads two basic types of files:

Redrum Patches

A Redrum patch (Windows extension “.drp”) contains all settings for all ten 
drum sound channels, including file references to the used drum samples 
(but not the actual drum samples themselves). Switching patches is the 
same as selecting a new drum kit.

Drum Samples

Redrum can read and play back sample files of the following formats:

• Wave (.wav) or AIFF (.aif)
• Any bit depth
• Any sample rate
• Stereo or Mono

! All samples are stored internally in 16-bit format, regardless of their 
original bit depth or sample rate.

Wave and AIFF are the standard audio file formats for the PC and Mac plat-
forms, respectively. Any audio or sample editor, regardless of platform, can 
read and create audio files in at least one of these formats, and some of 
them in both formats.
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Using Patches
When you create a new Redrum device it is empty. Before it can play back 
any audio you must first load a Redrum patch (or create one from scratch, by 
loading individual drum samples). A Redrum patch contains settings for the 
ten drum sound channels, complete with file references to the drum samples 
used.

! Redrum patterns are not part of the patch! 

Loading a Patch
To load a patch, use one of the following methods:

➜ Use the browser to locate and open the desired patch.
To open the browser, select “Browse Redrum Patches” from the Edit 
menu or device context menu, or click the folder button in the patch sec-
tion on the device panel.

➜ Once you have selected a patch, you can step between all the 
patches in the same folder by using the arrow buttons next to the 
patch name display.

➜ If you click on the patch name display on the device panel, a pop-up 
menu will appear, listing all patches in the current folder.
This allows you to quickly select another patch in the same folder, without 
having to step through each one in turn.

Checking the Sounds in a Patch
There are two ways you can listen to the sounds in a patch without program-
ming a pattern:

➜ By clicking the Trigger (arrow) button at the top of each drum sound 
channel.

➜ By playing the keys C1 to A1 on your MIDI keyboard.
C1 plays drum sound channel 1 and so on. See also page 96.

Both these methods play back the drum sample for the corresponding drum 
sound channel, with all settings for the sound applied.

Creating a new Patch
To create a patch of your own (or modify an existing patch), you use the fol-
lowing basic steps:

1. Click the folder button for a drum sound channel.
The Redrum sample browser opens.

2. Locate and open a drum sample.
You will find a large number of drum samples in the Factory Sound Bank 
(in the folder Redrum Drum Kits/xclusive drums-sorted). You can also 
use any AIFF or Wave file for this.

3. Make the desired settings for the drum sound channel.
The parameters are described on page 93.

4. Repeat steps 1 and 3 for the other drum sound channels.

5. When you’re satisfied with the drum kit, you can save the patch by 
clicking the Floppy Disk button in the patch section on the device 
panel.
Note however, that you don’t necessarily need to save the patch - all set-
tings are included when you save the song.

Creating an Empty Patch
To “initialize” the settings in the Redrum, select “Initialize Patch” from the Edit 
menu or the device context menu. This removes all samples for all drum 
sound channels, and sets all parameters to their default values.
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Programming Patterns
About Pattern Selection
As described in the Getting Started book, each pattern device (such as the 
Redrum) has 32 pattern memories, divided into four banks. To select a pat-
tern, click a Pattern button (or, if the desired pattern is in another bank, first 
click the Bank button and then click the Pattern button).

➜ If you select a new pattern during playback, the change will take ef-
fect on the next downbeat (according to the time signature set in the 
transport panel).
If you automate pattern changes in the main sequencer, you can make 
them happen at any position - see page 25.

➜ Note that you cannot load or save patterns - they are only stored as 
part of a song.
However, you can move patterns from one location to another (even be-
tween songs) by using the Cut, Copy and Paste Pattern commands. This 
is explained in the chapter “Using Pattern Devices” in the Getting Started 
book.

Pattern Programming Basics
If you are unfamiliar with step programming patterns, the basic principle is 
very intuitive and easy to learn. Proceed as follows:

1. Load a Redrum patch, if one isn’t already loaded.

2. Make sure an empty pattern is selected.
If you like, use the Clear Pattern command on the Edit menu or device 
context menu to make sure.

3. Make sure that the “Enable Pattern Section” and the “Pattern” but-
tons are activated (lit).

4. Press the “Run” button.
There will be no sound, as no pattern steps have been recorded yet. But 
as you can see, the LEDs over the Step button light up consecutively, 
moving from left to right, and then starts over. Each Step button repre-
sents one “step” in the Pattern. 

5. Select a Redrum channel, by clicking the “Select” button at the bot-
tom of the channel.
The button lights up, indicating that this channel and the drum sound it 
contains is selected.

6. While in Run mode, press Step button 1, so that it lights up.
The selected sound will now play every time Step 1 is “passed over”.

7. Clicking other Step buttons so they light up will play back the se-
lected sound as the sequencer passes those steps.
Clicking on a selected (lit) step button a second time removes the sound 
from that step and the button goes dark again. You can click and drag to 
add or remove steps quickly.

8. Select another Redrum channel to program steps for that sound.
Selecting a new sound or channel also removes the visual indications 
(static lit buttons) of step entries for the previously selected sound. The 
step buttons always show step entries for the currently selected sound.

9. Continue switching between sounds, and programming steps to 
build your pattern.
Note that you can erase or add step entries even if Run mode isn’t acti-
vated.

Setting Pattern Length
You may want to make settings for Pattern length, i.e the number of steps the 
pattern should play before repeating:

➜ Use the “Steps” spin controls to set the number of steps you wish 
the pattern to play.
The range is 1 to 64. You can always extend the number of steps at a 
later stage, as this will merely add empty steps at the end of the original 
pattern. You could also make it shorter, but that would (obviously) mean 
that the steps “outside” the new length won’t be heard. These steps 
aren’t erased though; if you raise the Steps value again, the steps will be 
played back again.
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About the “Edit Steps” Switch

If you set the pattern length to more than 16 steps, the pattern steps follow-
ing after the 16th won’t be visible, although they will play back. To view and 
be able to edit the next 16 steps, you have to set the Edit Steps switch to 17-
32. To see and edit steps beyond 32 you set the switch to 33-48, and so on.

Setting Pattern Resolution

Redrum always follows the tempo setting on the transport panel, but you can 
also make Redrum play in different “resolutions” in relation to the tempo set-
ting. Changing the Resolution setting changes the length of each step, and 
thereby the “speed” of the pattern.

This is explained in the chapter “Using Pattern Devices” in the Getting 
Started book.

Step Dynamics 
When you enter step notes for a drum sound, you can set the velocity value 
for each step to one of three values: Hard, Medium or Soft. This is done by 
setting the Dynamic switch before entering the note.

The color of the step buttons reflect the dynamics for each step. Soft notes are light 
yellow, Medium notes are orange and Hard are red.

➜ When the Medium value is selected, you can enter Hard notes by 
holding down [Shift] and clicking.
In the same way, you can enter Soft notes by holding down [Option] 
(Mac) or [Alt] (Windows) and clicking. Note that this doesn’t change the 
Dynamic setting on the device panel - it only affects the notes you enter.

➜ When you use different dynamics, the resulting difference in the 
sound (loudness, pitch, etc.), is governed by the “VEL” knob set-
tings for each drum channel (see page 93). 
If no velocity amount is set for a drum channel, it will play back the same, 
regardless of the Dynamic setting.

➜ To change the dynamics for an already programmed step, set the 
switch to the dynamic value you wish to change it to and click on 
the step.

! Note that if you are triggering Redrum via MIDI or from the main se-
quencer, the sounds will react to velocity like any other audio de-
vice. The Dynamic values are there to offer velocity control when 
using the built-in pattern sequencer.

Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced 
swing feel. It works by delaying all sixteenth notes that fall in between the 
eighth notes.

You can activate or deactivate shuffle individually for each Redrum pattern 
by clicking the Shuffle button on the device panel.

However, the amount of shuffle is set globally with the Pattern Shuffle control 
on the transport panel.
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Flam

A flam is when you double-strike a drum, to create a rhythmic or dynamic ef-
fect. Applying flam to a step entry will add a second “hit” to a drum sound. 
The flam amount knob determines the delay between the two hits.

To add a flam drum note, proceed as follows:

1. Activate flam by clicking the Flam button.

2. Click on a step to add a note (taking the Dynamic setting into ac-
count as usual).
A red LED is lit above the step to indicate that flam will be applied to that 
step.

3. Use the Flam knob to set the desired amount of flam.
The flam amount is global for all patterns in the device.

➜ To add or remove flam to or from an existing step note, click directly 
on the corresponding flam LED.
You can also click and drag on the LEDs to add or remove several flam 
steps quickly.

➜ Applying flam to several consecutive step entries is a quick way to 
produce drum rolls.
By adjusting the Flam knob you can create 1/32 notes even if the step 
resolution is 1/16, for example.

The Pattern Enable switch

If you deactivate the “Pattern” button, the pattern playback will be muted, 
starting at the next downbeat (exactly as if you had selected an empty (silent) 
pattern). For example, this can be used for bringing different pattern devices 
in and out of the mix during playback.

The Enable Pattern Section switch
If this is deactivated, Redrum will function as a pure “sound module”, i.e. the 
internal Pattern sequencer is disengaged. Use this mode if you wish to con-
trol Redrum exclusively from the main sequencer or via MIDI (see page 96).

Pattern Functions
When a Redrum device is selected, you will find some specific pattern func-
tions on the Edit menu (and on the device context menu):

Chaining Patterns
When you have created several patterns that belong together, you most 
probably want to make these play back in a certain order. This is done by re-
cording or inserting pattern changes into the main sequencer. See page 25.

Converting Pattern Data to Notes
You can convert Redrum Patterns to notes in the main sequencer. This al-
lows you to edit the notes freely, create variations or use Groove quantizing. 
This is described on page 10.

| Function | Description

Shift Pattern Left/Right These functions move all notes in the pattern one 
step to the left or right.

Shift Drum Left/Right The Shift Drum functions move all notes for the 
selected drum channel (the channel for which the 
Select button is lit) one step to the left or right. 

Randomize Pattern Creates a random pattern. Random patterns can 
be great starting points and help you get new 
ideas.

Randomize Drum Creates a random pattern for the selected drum 
sound only - the notes for the other drum sound 
channels are unaffected.

Alter Pattern The Alter Pattern function modifies the selected 
pattern by “shuffling” the current pattern notes 
and redistributing them among the drum sounds 
at random. This creates a less chaotic pattern 
than the “Randomize Pattern” function.
Note that there must be something in the pattern 
for the function to work on - using an Alter func-
tion on an empty pattern will not do anything.

Alter Drum Works like the “Alter Pattern” function, but affects 
the selected drum sound only.
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Redrum Parameters
Drum Sound Settings
Redrum features ten drum sound channels that can each be loaded with a 
Wave or AIFF sample. Although they are basically similar, there are three 
“types” of drum sound channels, with slightly different features. This makes 
some channels more suitable for certain types of drum sounds, but you are 
of course free to configure your drum kits as you like.

On the following pages, all parameters will be listed. If a parameter is avail-
able for certain drum sound channels only, this will be stated.

Mute & Solo

At the top of each drum sound channel, you will find a Mute (M) and a Solo 
(S) button. Muting a channel silences its output, while Soloing a channel 
mutes all other channels. Several channels can be muted or soloed at the 
same time.

You can also use keys on your MIDI keyboard to mute or solo individual 
drum sounds in real time. 

➜ The keys C2 to E3 (white keys only) will mute individual drum chan-
nels starting with channel 1.
The sounds are muted for as long as you hold the key(s) down.

➜ The keys C4 to E5 (white keys only) will solo individual drum chan-
nel, starting with channel 1.
The sounds are soloed for as long as you hold the key(s) down.

This is a great way to bring drum sounds in and out of the mix when playing 
Reason live. You can also record the drum channel Mutes in the main se-
quencer, just like any other controller (see “Drawing and Editing Notes” on 
page 20).

The Effect Sends (S1 & S2)

On the back panel of Redrum you will note two audio connections labeled 
“Send Out” 1 and 2. When you create a Redrum device, these will by default 
be auto-routed to the first two “Chaining Aux” inputs on the Mixer device (pro-
vided that these inputs aren’t already in use).

This feature allows you to add effects to independent drum sounds in the Re-
drum.

➜ Raising the S1 knob for a drum sound channel will send the sound 
to the first send effect connected to the mixer.
Similarly, the S2 knob governs the send level to the second send effect in 
the mixer.

➜ Note that there must be send effects connected to the AUX Sends 
and Returns in the mixer for this to work.

➜ Another way to add independent effects to drum sounds is to use 
the independent drum outputs.
See page 97.

Pan

Sets the Pan (stereo position) for the channel.

➜ If the LED above the Pan control is lit, the drum sound uses a stereo 
sample.
In that case, the Pan control serves as a stereo balance control.

C2 C3 C4 C5

1 2 3 4 5 6 7 8 9 10 1 2 3 4 5 6 7 8 9 10

Mute Solo
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Level and Velocity

The Level knob sets the volume for the channel. However, the volume can 
also be affected by velocity (as set with the Dynamic value, or as played via 
MIDI). How much the volume should be affected by velocity is set with the 
“Vel” knob.

➜ If the Vel knob is set to a positive value, the volume will become 
louder with increasing velocity values.
The higher the Vel value, the larger the difference in volume between low 
and high velocity values.

➜ A negative value inverts this relationship, so that the volume de-
creases with higher velocity values.

➜ If the Vel knob is set to zero (middle position), the sound will play at 
a constant volume, regardless of the velocity.
When Vel is set to zero, the LED above the knob goes dark.

Length and the Decay/Gate switch

The Length knob determines the length of the drum sound, but the result de-
pends on the setting of the Decay/Gate switch:

➜ In Decay mode (switch down), the sound will decay (gradually fade 
out) after being triggered. The decay time is determined by the 
Length setting.
In this mode, it doesn’t matter for how long a drum note is held (if played 
back from the main sequencer or via MIDI) - the sound will play the same 
length for short notes as for long notes. This is the traditional “drum ma-
chine” mode.

➜ In Gate mode (switch up), the sound will play for the set Length, and 
then be cut off.
Furthermore, if a sound set to Gate mode is played from the main se-
quencer, from a CV/Gate device or via MIDI, the sound will be cut off 
when the note ends or after the set Length, depending on which comes 
first. Or in other words, the sound plays for as long as you hold the note, 
but the Length setting serves as the maximum length for the sound.
There are several uses for the Gate mode:
• For “gated” drum sounds, when the tail of the sound is abruptly cut off 

as an effect.
• For when you want to use very short sounds, and don’t want them to 

“lose power” by being faded out.
• For when you play the Redrum from the sequencer or via MIDI, with 

sounds for which the length is important (e.g. when using the Redrum 
as a sound effects module).

! Audio samples sometimes contain a “loop”, which is set by editing 
the audio in a sample editor. This loop repeats a part of the sample 
to produce sustain as long as you hold down a note. Drum samples 
usually don’t contain loops, but who is to say that Redrum should 
only play drum samples? 
Note that if a sample contains a loop, and Length is set to maxi-
mum, the sound will have infinite sustain, in other words it will 
never become silent, even if you stop playback. Decreasing the 
Length setting solves this problem. 

Pitch

Sets the pitch of the sound. The range is +/- 1 octave.

➜ When the pitch is set to any other value than 0, the LED above the 
knob lights up to indicate that the sample isn’t played back at its 
original pitch.
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Pitch Bend

By setting the Bend knob to a positive or negative value, you specify the start 
pitch of the sound (relative to the Pitch setting). The pitch of the sound will 
then be bent to the main Pitch value. Thus, selecting a positive Bend value 
will cause the pitch to start higher and bend down to the original Pitch, and 
vice versa.

➜ The Rate knob determines the bend time - the higher the value, the 
slower the bend.

➜ The Vel knob determines how the Bend amount should be affected 
by velocity.
With a positive Vel value, higher velocity results in wider pitch bends.

➜ The Bend and Vel knobs have LEDs that light up when the functions 
are activated (i.e. when a value other than zero is selected).

! Pitch bend is available for drum sound channels 6 and 7 only.

Tone

The Tone knob determines the brightness of the drum sound. Raising this 
parameter results in a brighter sound. The Vel knob determines whether the 
sound should become brighter (positive Vel value) or darker (negative Vel 
value) with higher velocity.

➜ The Tone and Vel knobs have LEDs that light up when the functions 
are activated (i.e. when a value other than zero is selected).

! The Tone controls are available for drum sound channels 1, 2 and 
10 only.

Sample Start

The Start parameter allows you to adjust the start point of the sample. The 
higher the Start value, the further the start point is moved “into” the sample. If 
you set the Start Velocity knob to a positive amount, the sample start point is 
moved forward with higher velocities. A negative Start Velocity amount in-
verts this relationship.

➜ When Start Velocity is set to any other value than zero, the LED 
above the knob lights up.

➜ A negative Start Velocity amount is only useful if you have set the 
Start parameter to a value higher than 0.
By raising the Start value a bit and setting Start Velocity to a negative 
value, you can create rather realistic velocity control over some drum 
sounds. This is because the very first transients in the drum sound will 
only be heard when you play hard notes.

! The Sample Start settings are available for drum sound channels 3-
5, 8 and 9.

Global Settings

Channel 8 & 9 Exclusive

If this button is activated, the sounds loaded into drum channels 8 and 9 will 
be exclusive. In other words, if a sound is played in channel 8 it will be si-
lenced the moment a sound is triggered in channel 9, and vice versa. 

The most obvious application for this feature is to “cut off” an open hi-hat with 
a closed hi-hat, just like a real one does.
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High Quality Interpolation

When this is activated, the sample playback is calculated using a more ad-
vanced interpolation algorithm. This results in better audio quality, especially 
for drum samples with a lot of high frequency content.

➜ High Quality Interpolation uses more computer power - if you don’t 
need it, it’s a good idea to turn it off!
Listen to the drum sounds in a context and determine whether you think 
this setting makes any difference.

! If you are using a Macintosh with a G4 (Altivec) processor, turning 
High Quality Interpolation off makes no difference.

Master Level

The Master Level knob in the top left corner of the device panel governs the 
overall volume from Redrum.

Using Redrum as a Sound 
Module
The drum sounds in Redrum can be played via MIDI notes. Each drum 
sound is triggered by a specific note number, starting at C1 (MIDI note num-
ber 36):

This allows you to play Redrum live from a MIDI keyboard or a MIDI percus-
sion controller, or to record or draw drum notes in the main sequencer. If you 
like, you can combine pattern playback with additional drum notes, such as 
fills and variations. However:

! If you want to use Redrum purely as a sound module (i.e. without 
pattern playback) you should make sure that the “Enable Pattern 
Section” button is deactivated.
Otherwise, the Redrum pattern sequencer will start as soon as you 
start the main sequencer.

C1 C2

1

2

3

4

5 6

7

8

9

10
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Connections

On the back of the Redrum you will find the following connections:

For each drum sound channel:

Others

| Connection | Description

Audio Outputs There are individual audio outputs for each drum sound 
channel, allowing you to route a drum sound to a sepa-
rate channel in the mixer, possibly via insert effects, etc. 
For mono sounds, use the “Left (Mono)” output (and pan 
the sound using the Pan control in the mixer).
When you use an individual output for a sound, the sound 
is automatically excluded from the master stereo output.

Gate Out This sends out a gate signal when the drum sound is 
played (from a pattern, via MIDI or by using the Trigger 
button on the device panel). This lets you use the Re-
drum as a “trig sequencer”, controlling other devices.
The length of the gate signal depends on the Decay/Gate 
setting for the sound: In Decay mode, a short “trig pulse” 
is sent out, while in Gate mode, the gate signal will have 
the same length as the drum note (see page 94).

Gate In Allows you to trigger the sound from another CV/Gate de-
vice. All settings apply, just as when playing the drum 
sound conventionally.

Pitch CV In Lets you control the pitch of the drum sound from another 
CV device.

| Connection | Description

Send Out 1-2 Outputs for the send signals controlled with the S1 and 
S2 knobs, as described on page 93.

Stereo Out This is the master stereo output, outputting a mix of all 
drum sounds (except those for which you use individual 
outputs).
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Introduction
Subtractor is an analog-type polyphonic synthesizer based on subtractive 
synthesis, the method used in analog synthesizers. This chapter will go 
through all parameters of each section of Subtractor. In addition to the pa-
rameter descriptions, the chapter also includes a few tips and tricks to help 
you get the most out of the Subtractor synthesizer.

! It is recommended that you start with default settings (an “Init 
Patch”) if you intend to follow the examples in this chapter, unless 
otherwise is stated. An Init Patch is created by selecting “Initialize 
Patch” from the Edit menu. If you wish to keep the current settings, 
save them before initializing.

The Subtractor has the following basic features:

➜ Up to 99 Voice Polyphony.
You can set the number of voices for each Patch.

➜ Dual Filters.
A combination of a multimode filter and a second, linkable, lowpass filter 
allows for complex filtering effects. See page 106.

➜ Two Oscillators, each with 32 waveforms.
See page 100.

➜ Frequency Modulation (FM). 
See page 104.

➜ Oscillator Phase Offset Modulation.
This is an unique Subtractor feature that generates waveform variations. 
See page 103.

➜ Two Low Frequency Oscillators (LFO:s)
See page 112.

➜ Three Envelope Generators.
See page 110.

➜ Extensive Velocity Control.
See page 114.

➜ Extensive CV/Gate Modulation possibilities.
See page 117.

! Loading and saving Patches is described in the chapter “Working 
with Patches” in the Basics book.

The Oscillator Section

Subtractor provides two oscillators. Oscillators are the main sound genera-
tors in Subtractor, the other features are used to shape the sound of the os-
cillators. Oscillators generate two basic properties, waveform and pitch 
(frequency). The type of waveform the oscillator produces determines the 
harmonic content of the sound, which in turn affects the resultant sound qual-
ity (timbre). Selecting a oscillator waveform is usually the starting point when 
creating a new Subtractor Patch from scratch.

Oscillator 1 Waveform

Oscillator 1 provides 32 waveforms. The first four are standard waveforms, 
and the rest are “special” waveforms, some of which are suitable for emulat-
ing various musical instrument sounds.

✪ It is worth noting here that all waveforms can be radically trans-
formed using Phase offset modulation (see page 103). 

➜ To select a waveform, click the spin controls to the right of the 
“Waveform” LED display. 
The first 4 basic waveforms are shown as standard symbols, and the 
special waveforms are numbered 5 - 32. 

Here follows a brief description of the Subtractor waveforms:
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! Please note that the descriptions of the waveforms sound or timbre 
is merely meant to provide a basic guideline, and shouldn’t be taken 
too literally. Given the myriad ways you can modulate and distort a 
waveform in Subtractor, you can produce extremely different re-
sults from any given waveform.

| Waveform | Description

Sawtooth This waveform contains all harmonics and produces a bright 
and rich sound. The Sawtooth is perhaps the most “general 
purpose” of all the available waveforms.

Square A square wave only contains odd number harmonics, which 
produces a distinct, hollow sound.

Triangle The Triangle waveform generates only a few harmonics, 
spaced at odd harmonic numbers. This produces a flute-like 
sound, with a slightly hollow character.

Sine The sine wave is the simplest possible waveform, with no har-
monics (overtones). The sine wave produces a neutral, soft 
timbre.

5 This waveform emphasizes the higher harmonics, a bit like a 
sawtooth wave, only slightly less bright-sounding.

6 This waveform features a rich, complex harmonic structure, 
suitable for emulating the sound of an acoustic piano.

7 This waveform generates a glassy, smooth timbre. Good for 
electric piano-type sounds.

8 This waveform is suitable for keyboard-type sounds such as 
harpsichord or clavinet.

9 This waveform is suitable for electric bass-type sounds.

10 This is a good waveform for deep, sub-bass sounds.

11 This produces a waveform with strong formants, suitable for 
voice-like sounds.

12 This waveform produces a metallic timbre, suitable for a vari-
ety of sounds.

13 This produces a waveform suitable for organ-type sounds.

14 This waveform is also good for organ-type sounds. Has a 
brighter sound compared to waveform 13.

15 This waveform is suitable for bowed string sounds, like violin or 
cello.

16 Similar to 15, but with a slightly different character.

17 Another waveform suitable for string-type sounds.

18 This waveform is rich in harmonics and suitable for steel string 
guitar-type sounds.

19 This waveform is suitable for brass-type sounds.

20 This waveform is suitable for muted brass-type sounds.

21 This waveform is suitable for saxophone-like sounds.

22 A waveform suitable for brass and trumpet-type sounds.

23 This waveform is good for emulating mallet instruments such 
as marimba.

24 Similar to 23, but with a slightly different character.

25 This waveform is suitable for guitar-type sounds.

26 This is a good waveform for plucked string sounds, like harp.

27 Another waveform suitable for mallet-type sounds (see 23-24), 
but has a brighter quality, good for vibraphone-type sounds.

28 Similar to 27, but with a slightly different character.

29 This waveform has complex, enharmonic overtones, suitable 
for metallic bell-type sounds.

30 Similar to 29, but with a slightly different character. By using 
FM (see page 104) and setting the Osc Mix to Osc 1, this and 
the following two waveforms can produce noise.

31 Similar to 30, but with a slightly different character.

32 Similar to 30, but with a slightly different character.

| Waveform | Description
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Setting Oscillator 1 Frequency - Octave/
Semitone/Cent

By clicking the corresponding up/down buttons you can tune, i.e. change the 
frequency of Oscillator 1 in three ways:

➜ In Octave steps 
The range is 0 - 9. The default setting is 4 (where “A” above middle “C” on 
your keyboard generates 440 Hz). 

➜ In Semitone steps 
Allows you to raise the frequency in 12 semitone steps (1 octave).

➜ In Cent steps (100th of a semitone) 
The range is -50 to 50 (down or up half a semitone).

Oscillator Keyboard Tracking

Oscillator 1 has a button named “Kbd. Track”. If this is switched off, the oscil-
lator pitch will remain constant, regardless of any incoming note pitch mes-
sages, although the oscillator still reacts to note on/off messages. This can 
be useful for certain applications:

➜ When Frequency Modulation (FM - see page 104) or Ring Modula-
tion (see page 105) is used.
This produces enharmonic sounds with very varying timbre across the 
keyboard.

➜ For special effects and non-pitched sounds (like drums or percus-
sion) that should sound the same across the keyboard.

Using Oscillator 2

You activate Osc 2 by clicking the button next to the text “Osc 2“. Setting os-
cillator frequency and keyboard tracking is identical to Oscillator 1.

Adding a second oscillator enables many new modulation possibilities which 
can produce richer timbres. A basic example is to slightly detune (+/– a few 
cents) one of the oscillators. This slight frequency offset causes the oscilla-
tors to “beat” against each other, producing a wider and richer sound. Also, 
by combining two different waveforms, and adding frequency or ring modula-
tion, many new timbres can be created.

Oscillator Mix 

The Osc Mix knob determines the output balance between Osc 1 and Osc 2. 
To be able to clearly hear both oscillators, the “Osc Mix” knob should be set 
somewhere around the center position. If you turn the Mix knob fully to the 
left, only Osc 1 will be heard, and vice versa. [Command]/[Ctrl]-clicking the 
knob sets the Mix parameter to center position.

Oscillator 2 Waveform
The waveform alternatives for Oscillator 2 are identical to those of Oscillator 
1.

However, the Noise Generator provides a third sound generating source (in 
addition to the two oscillators) in Subtractor, and could be regarded as an 
“extra” waveform for Oscillator 2, as it is internally routed to the Oscillator 2 
output. See below for a description of the Noise Generator.
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Noise Generator

The Noise Generator could be viewed as an oscillator that produces noise in-
stead of a pitched waveform. Noise can be used to produce a variety of 
sounds, the classic example being “wind” or “rolling wave” sounds, where 
noise is passed through a filter while modulating the filter frequency. Other 
common applications include non-pitched sounds like drums and percus-
sion, or simulating breath noises for wind instruments. To use the Noise 
Generator, select an Init Patch and proceed as follows:

1. Turn Osc 2 off.

2. Click the button (in the Noise Generator section) to activate the 
Noise Generator.
If you play a few notes on your MIDI instrument you should now hear 
Osc1 mixed with the sound of the Noise Generator.

3. Turn the Mix knob fully to the right, and play a few more notes.
Now just the Noise Generator will be heard. 

➜ Thus, the output of the Noise Generator is internally routed to Osc 
2.
If you switch Osc 2 on, the noise will be mixed with the Osc 2 waveform.

There are three Noise Generator parameters. These are as follows:

Phase Offset Modulation
A unique feature of the Subtractor oscillators is the ability to create an extra 
waveform within one oscillator, to offset the phase of that extra waveform, 
and to modulate this phase offset. By subtracting or multiplying a waveform 
with a phase offset copy of itself, very complex waveforms can be created. 
Sounds complicated? Well, the theory behind it might be, but from a user 
perspective it is just a method of generating new waveforms from existing 
waveforms.

A seasoned synth programmer using Subtractor for the first time may won-
der why the Subtractor oscillators (seemingly) cannot provide the commonly 
used pulse waveform and the associated pulse width modulation (PWM). Or 
oscillator sync, another common feature in analog synthesizers. The simple 
answer is that Subtractor can easily create pulse waveforms (with PWM) and 
oscillator sync-sounds, and a lot more besides, partly by the use of phase 
offset modulation.

Each oscillator has it's own Phase knob and a selector button. The Phase 
knob is used to set the amount of phase offset, and the selector switches be-
tween three modes:

• Waveform multiplication (x) 
• Waveform subtraction (–) 
• No phase offset modulation (o).

| Parameter | Description

Noise Decay This controls the length it takes for the noise to quieten when 
you play a note. Note that this is independent from the Amp 
Envelope Decay parameter (see page 110), allowing you to 
mix a short “burst” of noise at the very beginning of a sound, 
i.e. a pitched sound that uses oscillators together with noise.

Noise Color This parameter allows you to vary the character of the noise. 
If the knob is turned fully clockwise, pure or “white” noise 
(where all frequencies are represented with equal energy) is 
generated. Turning the knob anti-clockwise produces a grad-
ually less bright sounding noise. Fully anti-clockwise the 
noise produced is an earthquake-like low frequency rumble.

Level Controls the level of the Noise Generator.
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When phase offset modulation is activated, the oscillator creates a second 
waveform of the same shape and offsets it by the amount set with the Phase 
knob. Depending on the selected mode, Subtractor then either subtracts or 
multiplies the two waveforms with each other. The resulting waveforms can 
be seen in the illustration below.

• In example 1, we see two sawtooth waves with a slight offset. 
• Example 2 shows that subtracting one slightly offset sawtooth wave 

from the other, produces a pulse wave. If you modulate the Phase 
offset parameter (with for example an LFO), the result will be pulse 
width modulation (PWM).

• Example three shows the resulting waveform when multiplying the 
offset waves with each other. As you can see (and hear if you try it), 
multiplying waveforms can produce very dramatic and sometimes 
unexpected results.

Using phase offset modulation can create very rich and varied timbres, espe-
cially when used along with LFO or Envelopes to modulate the phase offset.

✪ To get a “feel” for this concept, you could study Patches that use 
phase offset modulation, and maybe tweak some of the Phase Off-
set parameters to find out what happens. Try “SyncedUp” in the 
Polysynth category in the Factory Soundbank for an example of osc 
sync or “Sweeping Strings”(in the Pads category) for an example of 
PWM.

! Note that if you activate waveform subtraction with a Phase offset 
set to “0” for an oscillator, the second waveform will cancel out the 
original waveform completely, and the oscillator output will be si-
lent. If you set the Phase Offset knob to any other value than zero, 
the sound returns.

Frequency Modulation (FM)

In synthesizer-speak, Frequency Modulation, or FM, is when the frequency 
of one oscillator (called the “carrier”) is modulated by the frequency of an-
other oscillator (called the “modulator”). Using FM can produce a wide range 
of harmonic and non harmonic sounds. In Subtractor, Osc 1 is the carrier and 
Osc 2 the modulator. To try out some of the effects FM can produce, proceed 
as follows:

1. Select an Init Patch by selecting “Initialize Patch” from the Edit 
menu.

2. Activate Osc 2.
As you need both a carrier and a modulator to produce FM, turning the 
FM knob will not produce any effect unless you first activate Osc 2. For 
classic FM sounds, use sine wave on oscillator 1 and triangle wave on 
oscillator 2.

3. Use the FM knob to set the FM amount to a value of about 50.
As you can hear, the timbre changes, but the effect isn’t very pronounced 
yet.

4. Turn the Osc Mix knob fully to the left, so that only the sound of Osc 
1 is heard.
The modulator (Osc 2) still affects Osc 1, even though the Osc 2 output is 
muted.

5. Now, hold down a note on your MIDI keyboard and tune Osc 2 a fifth 
up from the original pitch by setting the Osc 2 frequency “Semi” pa-
rameter to a value of 7.
As you can hear, for each semitone step you vary the Osc 2 frequency, 
the timbre changes dramatically. Setting Osc 2 frequency to certain mu-
sical intervals (i.e. fourth, fifth or octave semitone steps) produces har-
monic, rich timbres, almost like tube distortion. Setting Osc 2 to non-
musical intervals usually results in complex, enharmonic timbres.

✪ Experiment with different oscillator parameters such as phase off-
set modulation, changing the waveforms etc. and listen to how they 
affect the sound of frequency modulation.

1. The two offset 
waveforms:
1. The two offset 
waveforms:

2. The result of 
subtraction:

3. The result of 
multiplication:

Ampl.

Ampl.

Ampl.

t.

t.

t.
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Using the Noise Generator as the Modulator source

As explained earlier, the Noise Generator is internally routed to the Osc 2 
output. Hence, if you deactivate Osc 2, and activate the Noise Generator 
while using FM, the noise will be used to frequency modulate Osc 1. 

✪ With the Noise Generators default settings, this will sound much 
like colored noise. But by changing (lowering) the Noise Generator 
Decay parameter, so that the noise modulates only the attack por-
tion of the sound can produce more interesting results. You could 
also use a combination of noise and Osc 2.

Ring Modulation

Ring Modulators basically multiply two audio signals together. The ring mod-
ulated output contains added frequencies generated by the sum of, and the 
difference between, the frequencies of the two signals. In the Subtractor 
Ring Modulator, Osc 1 is multiplied with Osc 2 to produce sum and difference 
frequencies. Ring modulation can be used to create complex and enhar-
monic, bell-like sounds.

1. Select an Init Patch by selecting “Initialize Patch” from the Edit 
menu.
Save any current settings you wish to keep before initializing.

2. Activate Ring Modulation with the button in the lower right corner of 
the oscillator section.

3. Activate Osc 2.
You need to activate Osc 2 before any ring modulation can happen.

4. Turn the Osc Mix knob fully to the right, so that only the sound of 
Osc 2 is heard.
Osc 2 provides the ring modulated output.

5. If you play a few notes while varying the frequency of either oscilla-
tor, by using the Semitone spin controls, you can hear that the tim-
bre changes dramatically.
If the oscillators are tuned to the same frequency, and no modulation is 
applied to either the Osc 1 or 2 frequency, the Ring Modulator won’t do 
much. It is when the frequencies of Osc 1 and Osc 2 differ, that you get 
the “true” sound of ring modulation.
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The Filter Section

In subtractive synthesis, a filter is the most important tool for shaping the overall timbre of the sound. The filter section in Subtractor contains two filters, the first 
being a multimode filter with five filter types, and the second being a low-pass filter. The combination of a multimode filter and a lowpass filter can be used to 
create very complex filter effects.

Filter 1 Type
With this multi-selector you can set Filter 1 to operate as one of five different types of filter. The five types are illustrated and explained on the following pages:

➜ 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequencies. This filter type has a fairly steep roll-off curve (24dB/Octave). Many classic syn-
thesizers (Minimoog/Prophet 5 etc.) use this filter type.

The darker curve illustrates the roll-off curve of the 24dB Lowpass Filter. The lighter curve in the middle represents the filter characteristic when the Resonance parameter is 
raised.
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➜ 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in analog synthesizers 
(Oberheim, early Korg synths etc.). It has a gentler slope (12 dB/Octave), 
leaving more of the harmonics in the filtered sound compared to the LP 
24 filter.

The darker curve illustrates the roll-off curve of the 12dB Lowpass Filter. The lighter 
curve in the middle represents the filter characteristic when the Resonance 
parameter is raised.

➜ Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange fre-
quencies are not affected. Each slope in this filter type has a 12 dB/Oc-
tave roll-off.

The darker curve illustrates the roll-off curve of the Bandpass Filter. The lighter 
curve in the middle represents the filter characteristic when the Resonance 
parameter is raised.



SUBTRACTOR SYNTHESIZER108

➜ Highpass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out the lower 
frequencies and letting the high frequencies pass. The HP filter slope has 
a 12 dB/Octave roll-off.

The darker curve illustrates the roll-off curve of the Highpass Filter. The lighter curve 
in the middle represents the filter characteristic when the Resonance parameter is 
raised.

➜ Notch
A notch filter (or band reject filter) could be described as the opposite of a 
bandpass filter. It cuts off frequencies in a narrow midrange band, letting 
the frequencies below and above through. On it’s own, a notch filter 
doesn’t really alter the timbre in any dramatic way, simply because most 
frequencies are let through. However, by combining a notch filter with a 
lowpass filter (using Filter 2 - see page 109 in this chapter), more musi-
cally useful filter characteristics can be created. Such a filter combination 
can produce soft timbres that still sound “clear”. The effect is especially 
noticeable with low resonance (see page 109) settings.

The darker curve illustrates the roll-off curve of the Notch Filter. The lighter curve in 
the middle represents the filter characteristic when the Resonance parameter is 
raised.
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Filter 1 Frequency 
The Filter Frequency parameter (often referred to as “cutoff”) determines 
which area of the frequency spectrum the filter will operate in. For a lowpass 
filter, the frequency parameter could be described as governing the “open-
ing” and “closing” of the filter. If the Filter Freq is set to zero, none or only the 
very lowest frequencies are heard, if set to maximum, all frequencies in the 
waveform are heard. Gradually changing the Filter Frequency produces the 
classic synthesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the 
Filter Envelope (see page 111) as well. Changing the Filter Fre-
quency with the Freq slider may therefore not produce the expected 
result.

Resonance 
The filter resonance parameter is used to set the Filter characteristic, or qual-
ity. For lowpass filters, raising the filter Res value will emphasize the frequen-
cies around the set filter frequency. This produces a generally thinner sound, 
but with a sharper, more pronounced filter frequency “sweep”. The higher the 
filter Res value, the more resonant the sound becomes until it produces a 
whistling or ringing sound. If you set a high value for the Res parameter and 
then vary the filter frequency, this will produce a very distinct sweep, with the 
ringing sound being very evident at certain frequencies.

• For the highpass filter, the Res parameter operates just like for the 
lowpass filters.

• When you use the Bandpass or Notch filter, the Resonance setting 
adjusts the width of the band. When you raise the Resonance, the 
band where frequencies are let through (Bandpass), or cut (Notch) 
will become narrower. Generally, the Notch filter produces more 
musical results using low resonance settings.

Filter Keyboard Track (Kbd)
If Filter Keyboard Track is activated, the filter frequency will increase the fur-
ther up on the keyboard you play. If a lowpass filter frequency is constant (a 
Kbd setting of “0”) this can introduce a certain loss of “sparkle” in a sound the 
higher up the keyboard you play, because the harmonics in the sound are 
progressively being cut. By using a degree of Filter Keyboard Tracking, this 
can be compensated for.

Filter 2 
A very useful and unusual feature of the Subtractor Synthesizer is the pres-
ence of an additional 12dB/Oct lowpass filter. Using two filters together can 
produce many interesting filter characteristics, that would be impossible to 
create using a single filter, for example formant effects. 

The parameters are identical to Filter 1, except in that the filter type is fixed, 
and it does not have filter keyboard tracking.

➜ To activate Filter 2, click the button at the top of the Filter 2 section. 
Filter 1 and Filter 2 are connected in parallel. This means that the output 
of Filter 1 is routed to Filter 2, but both filters function independently. For 
example, if Filter 1 was filtering out most of the frequencies, this would 
leave Filter 2 very little to “work with”. Similarly, if Filter 2 had a filter fre-
quency setting of “0”, all frequencies would be filtered out regardless of 
the settings of Filter 1.

✪ Try the “Singing Synth” patch (in the Monosynth category of the 
Factory Sound Bank) for an example how dual filters can be used.

Filter Link

When Link (and Filter 2) is activated, the Filter 1 frequency controls the fre-
quency offset of Filter 2. That is, if you have set different filter frequency val-
ues for Filter 1 and 2, changing the Filter 1 frequency will also change the 
frequency for Filter 2, but keeping the relative offset. 

✪ Try the “Fozzy Fonk” patch (in the Polysynth category of the Fac-
tory Sound Bank) for an example how linked filters can be used.

! Caution! If no filter modulation is used, and the filters are linked, 
pulling down the frequency of Filter 2 to zero will cause both filters 
to be set to the same frequency. If combined with high Res settings, 
this can produce very loud volume levels that cause distortion!
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Envelopes - General
Envelope generators are used to control several important sound parame-
ters in analog synthesizers, such as pitch, volume, filter frequency etc. Enve-
lopes govern how these parameters should respond over time - from the 
moment a note is struck to the moment it is released. 

Standard synthesizer envelope generators have four parameters; Attack, 
Decay, Sustain and Release (ADSR). 

There are three envelope generators in the Subtractor, one for volume, one 
for the Filter 1 frequency, and one modulation envelope which has selectable 
modulation destinations. 

The ADSR envelope parameters.

Attack

When you play a note on your keyboard, the envelope is triggered. This 
means it starts rising from zero to the maximum value. How long this should 
take, depends on the Attack setting. If the Attack is set to “0”, the maximum 
value is reached instantly. If this value is raised, it will take time before the 
maximum value is reached.

For example, if the Attack value is raised and the envelope is controlling the 
filter frequency, the filter frequency will gradually rise up to a point each time 
a key is pressed, like an “auto-wha” effect. 

Decay

After the maximum value has been reached, the value starts to drop. How 
long this should take is governed by the Decay parameter. 

If you wanted to emulate the volume envelope of a note played on a piano for 
example, the Attack should be set to “0” and the Decay parameter should be 
set to a medium value, so that the volume gradually decreases down to si-
lence, even if you keep holding the key down. Should you want the decay to 
drop to some other value than zero, you use the Sustain parameter.

Sustain

The Sustain parameter determines the level the envelope should rest at, af-
ter the Decay. If you set Sustain to full level, the Decay setting is of no impor-
tance since the volume of the sound is never lowered.

If you wanted to emulate the volume envelope of an organ, you theoretically 
only really need to use the Sustain parameter set to full level, as a basic or-
gan volume envelope instantly goes to the maximum level (Attack “0”) and 
stays there (Decay “0”), until the key is released and the sound instantly 
stops (Release “0”). 

But often a combination of Decay and Sustain is used to generate envelopes 
that rise up to the maximum value, then gradually decreases to finally land to 
rest on a level somewhere in-between zero and maximum. Note that Sustain 
represents a level, whereas the other envelope parameters represent times.

Release

Finally, we have the Release parameter. This works just like the Decay pa-
rameter, except it determines the time it takes for the value to fall back to 
zero after releasing the key.

Amplifier Envelope

The Amplifier Envelope is used to adjust how the volume of the sound should 
change from the time you press a key until the key is released. By setting up 
a volume envelope you sculpt the sound’s basic shape with the four Amplifier 
Envelope parameters, Attack, Decay, Sustain and Release. This determines 
the basic character of the sound (soft, long, short etc.).

Attack
(time)

Decay
(time)

Sustain
(level)

Release
(time)

Key Down Key Up

Level

Time
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Filter Envelope

The Filter Envelope affects the Filter 1 Frequency parameter. By setting up a 
filter envelope you control the how the filter frequency should change over 
time with the four Filter Envelope parameters, Attack, Decay, Sustain and 
Release. 

Filter Envelope Amount

This parameter determines to what degree the filter will be affected by the 
Filter Envelope. Raising this knob’s value creates more drastic results. The 
Envelope Amount parameter and the set Filter Frequency are related. If the 
Filter Freq slider is set to around the middle, this means that the moment you 
press a key the filter is already halfway open. The set Filter Envelope will 
then open the filter further from this point. The Filter Envelope Amount set-
ting affects how much further the filter will open.

Filter Envelope Invert

If this button is activated, the envelope will be inverted. For example, nor-
mally the Decay parameter lowers the filter frequency, but after activating In-
vert it will instead raise it, by the same amount. 

Mod Envelope

The Mod Envelope allows you to select one of a number of parameters, or 
Destinations, to control with the envelope. By setting up a modulation enve-
lope you control the how the selected Destination parameter should change 
change over time with the four Mod Envelope parameters, Attack, Decay, 
Sustain and Release. 

The available Mod Envelope Destinations are as follows:

| Destination | Description

Osc 1 Selecting this makes the Mod Envelope control the pitch 
(frequency) of Osc 1.

Osc 2 Same as above, but for Osc 2.

Osc Mix Selecting this makes the Mod Envelope control the oscillator 
Mix parameter. Both oscillators must be activated for this to 
have any effect.

FM Selecting this makes the Mod Envelope control the FM 
Amount parameter. Both oscillators must be activated for 
this to have any effect.

Phase Selecting this makes the Mod Envelope control the Phase 
Offset parameter for both Osc 1 and 2. Note that Phase Off-
set Modulation (Subtraction or Multiplication) must be acti-
vated for this to have any effect (see page 103).

Freq 2 Selecting this makes the Mod Envelope control the Fre-
quency parameter for Filter 2.
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LFO Section

LFO stands for Low Frequency Oscillator. LFO:s are oscillators, just like Osc 
1 & 2, in that they also generate a waveform and a frequency. However, 
there are two significant differences:

• LFO’s only generate waveforms with low frequencies.
• The output of the two LFO’s are never actually heard. Instead they 

are used for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound 
generating) oscillator, to produce vibrato. Subtractor is equipped with two 
LFO’s. The parameters and the possible modulation destinations vary some-
what between LFO 1 and LFO 2.

LFO 1 Parameters
Waveform

LFO 1 allows you to select different waveforms for modulating parameters. 
These are (from top to bottom):

Destination

The available LFO 1 Destinations are as follows:

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster 
modulation rate.

Amount

This parameter determines to what degree the selected parameter destina-
tion will be affected by LFO 1. Raising this knob’s value creates more drastic 
results.

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted Saw-
tooth

This produces a “ramp up” cycle. If applied to an oscillator’s 
frequency, the pitch would sweep up to a set point (gov-
erned by the Amount setting), after which the cycle immedi-
ately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but 
inverted.

Square This produces cycles that abruptly changes beween two val-
ues, usable for trills etc.

Random Produces random stepped modulation to the destination. On 
some vintage synths, this is called “sample & hold”.

Soft Random The same as above, but with smooth modulation.

| Destination | Description

Osc 1&2 Selecting this makes LFO 1 control the pitch (frequency) of 
Osc 1 and Osc 2.

Osc 2 Same as above, but for Osc 2.

Filter Freq Selecting this makes the LFO 1 control the filter frequency 
for Filter 1 (and Filter 2 if linked). 

FM Selecting this makes the LFO 1 control the FM Amount pa-
rameter. Both oscillators must be activated for this to have 
any effect.

Phase Selecting this makes the LFO 1 control the Phase Offset 
parameter for both Osc 1 and 2. Note that Phase Offset 
Modulation (Subtraction or Multiplication) must be acti-
vated for this to have any effect (see page 103).

Osc Mix Selecting this makes the LFO 1 control the oscillator Mix 
parameter. 
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LFO 2 Parameters
LFO 2 is polyphonic. This means that for every note you play, an indepen-
dent LFO cycle is generated, whereas LFO 1 always modulates the destina-
tion parameter using the same “cycle”. This can be used to produce subtle 
cross-modulation effects, with several LFO cycles that “beat” against each 
other. This also enables LFO 2 to produce modulation rates that vary across 
the keyboard (see the “Keyboard Tracking” parameter below). 

Destination

The available LFO 2 Destinations are as follows:

LFO 2 Delay

This parameter is used to set a delay between when a note is played and 
when the LFO modulation “kicks in”. For example, if Osc 1 & 2 is selected as 
the destination parameter and Delay was set to a moderate value, the sound 
would start out unmodulated, with the vibrato only setting in if you hold the 
note(s) long enough. Delayed LFO modulation can be very useful, especially 
if you are playing musical instrument-like sounds like violin or flute. Naturally 
it could also be used to control more extreme modulation effects and still re-
tain the “playability” of the sound.

LFO 2 Keyboard Tracking

If LFO keyboard tracking is activated, the LFO rate will progressively in-
crease the higher up on the keyboard you play. Raising this knob’s value cre-
ates more drastic results.

✪ If the LFO is set to modulate the phase offset, LFO keyboard track-
ing can produce good results. For example, synth string pads and 
other sounds that use PWM (see page 103) can benefit from this.

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster 
modulation rate.

Amount

This parameter determines to what degree the selected parameter destina-
tion will be affected by LFO 2. Raising this knob’s value creates more drastic 
results.

| Destination | Description

Osc 1&2 Selecting this makes LFO 2 modulate the pitch (frequency) of 
Osc 1 and Osc 2.

Phase Selecting this makes the LFO 2 modulate the Phase Offset 
parameter for both Osc 1 and 2. Note that Phase Offset Mod-
ulation (Subtraction or Multiplication) must be activated for 
this to have any effect (see page 103). 

Filter Freq 2 Selecting this makes the LFO 2 modulate the filter frequency 
for Filter 2. 

Amp Selecting this makes the LFO 2 modulate the overall volume., 
to create tremolo-effects.
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Play Parameters
This section deals with two things: Parameters that are affected by how you 
play, and modulation that can be applied manually with standard MIDI key-
board controls. 

These are:

• Velocity Control
• Pitch Bend and Modulation Wheel
• Legato
• Portamento
• Polyphony

Velocity Control

Velocity is used to control various parameters according to how hard or soft 
you play notes on your keyboard. A common application of velocity is to 
make sounds brighter and louder if you strike the key harder. Subtractor fea-
tures very comprehensive velocity modulation capabilities. By using the 
knobs in this section, you can control how much the various parameters will 
be affected by velocity. The velocity sensitivity amount can be set to either 
positive or negative values, with the center position representing no velocity 
control. 

The following parameters can be velocity controlled:

| Destination | Description

Amp This let’s you velocity control the overall volume of the sound. 
If a positive value is set, the volume will increase the harder 
you strike a key. A negative value inverts this relationship, so 
that the volume decreases if you play harder, and increases if 
you play softer. If set to zero, the sound will play at a constant 
volume, regardless of how hard or soft you play. 

FM This sets velocity control for the FM Amount parameter. A 
positive value will increase the FM amount the harder you 
play. Negative values invert this relationship.

M. Env This sets velocity control for the Mod Envelope Amount pa-
rameter. A positive value will increase the envelope amount 
the harder you play. Negative values invert this relationship.

Phase This sets velocity control for the Phase Offset parameter. This 
applies to both Osc 1 & 2, but the relative offset values are re-
tained. A positive value will increase the phase offset the 
harder you play. Negative values invert this relationship.

Freq 2 This sets velocity control for the Filter 2 Frequency parame-
ter. A positive value will increase the filter frequency the 
harder you play. Negative values invert this relationship.

F. Env This sets velocity control for the Filter Envelope Amount pa-
rameter. A positive value will increase the envelope amount 
the harder you play. Negative values invert this relationship.

F. Dec This sets velocity control for the Filter Envelope Decay pa-
rameter. A positive value will increase the Decay time the 
harder you play. Negative values invert this relationship.

Osc Mix This sets velocity control for the Osc Mix parameter. A posi-
tive value will increase the Osc 2 Mix amount the harder you 
play. Negative values invert this relationship.

A. Attack This sets velocity control for the Amp Envelope Attack param-
eter. A positive value will increase the Attack time the harder 
you play. Negative values invert this relationship.
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Pitch Bend and Modulation Wheels

The Pitch Bend wheel is used for “bending” notes, like bending the strings on 
a guitar. The Modulation wheel can be used to apply various modulation 
while you are playing. Virtually all MIDI keyboards have Pitch Bend and Mod-
ulation controls. Subtractor features not only the settings for how incoming 
MIDI Pitch Bend and Modulation wheel messages should affect the sound. 
Subtractor also has two functional wheels that could be used to apply real 
time modulation and pitch bend should you not have these controllers on 
your keyboard, or if you aren’t using a keyboard at all. The Subtractor wheels 
mirror the movements of the MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is 
turned fully up or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of pa-
rameters. You can set positive or negative values, just like in the Velocity 
Control section. The following parameters can be affected by the modulation 
wheel:

Legato
Legato works best with monophonic sounds. Set Polyphony (see below) to 1 
and try the following:

➜ Hold down a key and then press another key without releasing the 
previous.
Notice that the pitch changes, but the envelopes do not start over. That 
is, there will be no new “attack”. 

➜ If polyphony is set to more voices than 1, Legato will only be ap-
plied when all the assigned voices are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 
note chord, the next note you played would be Legato. Note, however, 
that this Legato voice will “steal” one of the voices in the 4 note chord, as 
all the assigned voices were already used up!

| Parameter | Description

F. Freq This sets modulation wheel control of the Filter 1 Frequency 
parameter. A positive value will increase the frequency if the 
wheel is pushed forward. Negative values invert this relation-
ship.

F. Res This sets modulation wheel control of the Filter 1 Resonance 
parameter. A positive value will increase the resonance if the 
wheel is pushed forward. Negative values invert this relation-
ship.

LFO 1 This sets modulation wheel control of the LFO 1 Amount pa-
rameter. A positive value will increase the Amount if the 
wheel is pushed forward. Negative values invert this relation-
ship.

Phase This sets modulation wheel control of the Phase Offset pa-
rameter for both Osc 1 and 2. Note that Phase Offset Modu-
lation (Subtraction or Multiplication) must be activated for 
this to have any effect (see page 103). 

FM This sets modulation wheel control of the FM Amount pa-
rameter. A positive value will increase the FM amount if the 
wheel is pushed forward. Negative values invert this relation-
ship. Both oscillators must be activated for this to have any 
effect.



SUBTRACTOR SYNTHESIZER116

Retrig
This is the “normal” setting for playing polyphonic patches. That is, when you 
press a key without releasing the previous, the envelopes are retriggered, 
like when you release all keys and then press a new one. In monophonic 
mode, Retrig has an additional function; if you press a key, hold it, press a 
new key and then release that, the first note is also retriggered.

Portamento (Time)
Portamento is when the pitch “glides” between the notes you play, instead of 
instantly changing the pitch. The Portamento knob is used to set how long it 
takes for the pitch to glide from one pitch to the next. If you don’t want any 
Portamento at all, set this knob to zero.

Setting Number of Voices - Polyphony

This determines the polyphony, i.e. the number of voices a Subtractor Patch 
can play simultaneously. This can be used to make a patch monophonic (=a 
setting of “1”), or to extend the number of voices available for a patch. The 
maximum number of voices you can set a Subtractor Patch to use is 99. In 
the (unlikely) event you should need more voices, you can always create an-
other Subtractor!

! Note that the Polyphony setting does not “hog” voices. For exam-
ple, if you have a patch that has a polyphony setting of ten voices, 
but the part the patch plays only uses four voices, this won’t mean 
that you are “wasting” six voices. In other words, the polyphony 
setting is not something you need to consider much if you want to 
conserve CPU power - it is the number of voices actually used that 
counts.

About the Low Bandwidth button
This can be used to conserve CPU power. When activated, this function will 
remove some high frequency content from the sound of this particular de-
vice, but often this is not noticeable (this is especially true for bass sounds).

External Modulation

Subtractor can receive common MIDI controller messages, and route these 
to various parameters. The following MIDI messages can be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending Aftertouch messages, or if you 
have access to an Expression Pedal or a Breath controller, you can use 
these to modulate parameters. The “Ext. Mod” selector switch sets which of 
these message-types should be received.

These messages can then be assigned to control the following parameters:

| Destination | Description

F. Freq This sets External modulation control of the Filter 1 Fre-
quency parameter. A positive value will increase the fre-
quency with higher external modulation values. Negative 
values invert this relationship.

LFO 1 This sets External modulation control of the LFO 1 Amount 
parameter. A positive value will increase the LFO 1 amount 
with higher external modulation values. Negative values in-
vert this relationship.

Amp This let’s you control the overall volume of the sound with 
external modulation. If a positive value is set, the volume 
will increase with higher external modulation values. A 
negative value inverts this relationship.

FM This sets External modulation control of the FM Amount 
parameter. If a positive value is set, the FM amount will in-
crease with higher external modulation values. A negative 
value inverts this relationship. Both oscillators must be ac-
tivated for this to have any effect.
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Connections

Flipping the Subtractor around reveals a plethora of connection possibilities, 
most of which are CV/Gate related. Using CV/Gate is described in the chap-
ter “Routing Audio and CV”.

Audio Output
This is Subtractor’s main audio output. When you create a new Subtractor 
device, this is auto-routed to the first available channel on the audio mixer.

Sequencer Control
The Sequencer Control CV and Gate inputs allow you to play the Subtractor 
from another CV/Gate device (typically a Matrix or a Redrum). The signal to 
the CV input controls the note pitch, while the signal to the Gate input deliv-
ers note on/off along with velocity.

! For best results, you should use the Sequencer Control inputs with 
monophonic sounds.

Modulation Inputs

! Remember that CV connections will not be stored in the Subtractor 
patch, even if the connections are to/from the same Subtractor de-
vice! 

These control voltage (CV) inputs (with associated voltage trim pots), can 
modulate various Subtractor parameters from other devices, or from the 
modulation outputs of the same Subtractor device. These inputs can control 
the following parameters:

• Oscillator Pitch (both Osc 1 & 2).
• Oscillator Phase Offset (both Osc 1 & 2).
• FM Amount
• Filter 1 Cutoff
• Filter 1 Res
• Filter 2 Cutoff
• Amp Level 
• Mod Wheel

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or 
other parameters in the same Subtractor device. The Modulation Outputs 
are:

• Mod Envelope
• Filter Envelope 
• LFO 1

Gate Inputs
These inputs can receive a CV signal to trigger the following envelopes. Note 
that connecting to these inputs will override the normal triggering of the en-
velopes. For example, if you connected an LFO output to the Gate Amp in-
put, you would not trigger the amp envelope by playing notes, as this is now 
controlled by the LFO. In addition you would only hear the LFO triggering the 
envelope for the notes that you hold down. The following Gate Inputs can be 
selected:

• Amp Envelope
• Filter Envelope
• Mod Envelope
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Introduction
A sampler could be described as a device capable of recording and repro-
ducing audio material, like a tape recorder. Unlike a tape or harddisk based 
recorder, samplers allows you to “play” the recorded sound via MIDI, using a 
keyboard for example. This way, any reproducible sound can be integrated 
into the MIDI environment, and be controlled from sequencers etc. like syn-
thesizers. 

The NN-19 is a sample player, capable of reproducing, but not recording or 
editing sound files. 

The program comes with more than a hundred ready-made sample patches, 
covering all kinds of instrument types. In addition to this there are plenty of 
single samples that can be used for creating your own patches.

If you want to record or edit your own samples, there are plenty of relatively 
inexpensive (and even free) audio editing software for both the Windows and 
the MacOS platforms, that will allow you to both record audio (via your com-
puters or audio cards audio inputs), and to edit the resulting audio file. Virtu-
ally every product that is capable of this, can create sound files which can be 
loaded directly into the NN-19.

Also, there are thousands of high quality sample CD:s available, covering ev-
ery conceivable musical style or direction ranging from professionally re-
corded orchestral samples to esoteric electronic noises.

General Sampling 
Principles 
Background
Before a sound can be used by a sampler, it must be converted to a digital 
signal. Hardware samplers provide audio inputs that can convert the analog 
signal to digital, by the use of an “A/D Converter” (analog to digital). This 
“samples” the signal at very short time intervals and converts it to a digital 
representation of the analog signal’s waveform. The sample rate and the bit 
depth of this conversion determines the resulting sound quality. Finally the 
signal is passed through a digital to analog converter (D/A) which recon-
structs the digital signal back to analog, which can be played back. 

Multisampling vs. Single Samples
Most of the included NN-19 patches are made up by a collection of several 
samples. This is because a single sampled sound only sounds natural within 
a fairly narrow frequency range. If a single sample is loaded into an empty 
NN-19, the sample will be playable across the whole keyboard. The pitch 
(frequency) of the original sample (called root-key) will be automatically 
placed on the middle C key (C3). 

Note that this has nothing to do with the actual pitch the sample itself pro-
duces! It may not even have a pitch as such, it could be the sound of some-
one talking for example. 

If you play any single sample about two octaves above or below its root key, 
it will most likely sound very “unnatural”. In the case of it actually being a 
sample of someone talking, playing two octaves up will make the talking 
voice sample sound squeaky, short and most likely unintelligible. Two oc-
taves down the voice will sound something like a drawn-out gargle.

Thus, the range that most samples can be transposed without sounding un-
natural is limited. To make a sampled piano, for example, sound good across 
the whole keyboard, you need to first have made many samples at close in-
tervals across the keyboard, and then define an upper and lower range for 
each sample, called a Key Zone. All the keyzones in the piano sample patch 
then make up a Key Map. 

How to create key zones is described on page 122.

To sample real instruments accurately requires a lot of hard work. Firstly, you 
need the original instrument, which should be in perfect working order. For 
acoustic instruments you need a couple of good microphones, a mixer or 
other device with high quality microphone preamps, and a room with good 
acoustics. You need to be meticulous when recording the different samples, 
so that levels are smooth and even across the range etc. 
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Fortunately Reason provides a wide range of high quality multisampled in-
struments, so much of this hard work has already been done for you.

In our experience, most people don’t use samplers only for playing sampled 
versions of “real” instruments. Very often, single “stand alone” or single sam-
ples are used. Maybe you wish to use different sounds for every key zone. Or 
you could have complete chorus and verse vocals plus variations assigned 
to several “one note” key zones. Or use samples of different chords that play 
rhythmic figures to the same tempo, and use these to build song structures 
etc. The possibilities are endless. When you use samples in this way, the 
keys on your keyboard that plays the samples do not necessarily correspond 
to pitch at all, the keys are simply used to trigger the samples.

Loading a Sample Patch
When you create a new NN-19 device, it is empty. That is, the “Init patch” in 
the NN-19 does not contain any samples. For NN-19 to produce sound, you 
need to load either a sampler patch, or a sample. 

A patch contains “everything”. All the samples, assigned key zones, and as-
sociated panel settings will be loaded. Loading a sample patch is done using 
the patch browser, just like in the Subtractor.

Open the folder that contains the NN-19 patch you wish to load, select it and 
click open.

About Audio File Formats
The NN-19 can read audio files in two formats:

• Wave (.wav)
• AIFF (.aif)
• Any sample rate and practically any bit depth.

! Regardless of the files original bit depth, samples will be played 
back as 16-bit files in NN-19.

Wave and AIFF are the standard audio file formats for the PC and Mac plat-
forms, respectively. Any audio or sample editor, regardless of platform, can 
read and create audio files in at least one of these formats. 

About the Sample Patch format

Reason’s Sample Patch format (.smp), is based on either Wave or AIFF files, 
but includes all the NN-19 associated parameter settings as well.

➜ The audio files may be stereo or mono. Stereo audio files are shown 
with a “S” symbol beside its name in the display.
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About Key Zones and 
Samples
Loading a Sample into an empty NN-19
1. Create a new sampler device.

2. Click on the sample browser button.
This is located above the keyboard display to the left.

✪ When you browse samples, you can preview them before loading 
using the browser Play button. If you select the Preview “Autoplay” 
function, the samples play back once automatically when selected.

3. Use the browser to select a sample and open it.

When you load the first sample into an empty NN-19, this will be assigned a 
key zone that spans the entire range of the keyboard, and the default Init 
Patch settings will be used.

Below the keyboard, the range, sample name, root key, tuning, level and 
loop status of the current key zone is displayed, each with a corresponding 
knob.

The light blue strip above the keyboard indicates the currently selected key zone, which 
is in this case the full range of the keyboard. 

The inverted note on the keyboard indicates the “root key” of the sample. All 
samples contain a root key, tuning and level setting. If NN-19 is empty, a 
sample will have its root key placed on the middle “C” (C3) key.

4. If desired, click on the keyboard to change the root key. 

Creating Key Zones
A “key zone” is a range of keys, that plays a sample. All key zones together 
make up a “key map”.

To create a new key zone, the following methods can be used:

➜ Select “Split Key Zone” from the Edit or context menus.
This splits the currently selected key zone in the middle. The new zone is 
the upper half of the split, and is empty. The dividing point has a “handle” 
above it, see “Setting the Key Zone Range” below for a description.

➜ By [Alt]/[Option]-clicking at a point just above the key zone strip, a 
new empty key zone is created. 
The point where you click becomes the lower limit (or boundary) for the 
original key zone, and the upper limit for the new key zone. 

The new empty key zone gets selected upon creation.

Selecting Key Zones
Only one key zone can be selected at a time. A selected key zone is indi-
cated by a light blue (as opposed to dark blue) strip above the keyboard in 
the display. There are two ways you can select key zones:

➜ By clicking on an unselected key zone in the display.

➜ By activating the “Select Key Zone via MIDI” button.
Playing a note belonging to an unselected key zone from your MIDI key-
board, will select the key zone it belongs to.
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Setting the Key Zone Range 

! Key zones cannot overlap.

When you adjust the boundaries of a key zone, the surrounding boundaries 
are automatically adjusted accordingly. 

You can change the key zone range in the following ways:

➜ By dragging the “handle(s)” which divides the key zones, you can 
change the range of the selected key zone.
In the case of having two key zones split in the middle, you could thus 
change the lower limit for the upper (new) key zone and the upper limit 
for the original key zone. 

➜ By using the “Lowkey” and “Highkey” knobs to set a lower and up-
per range, respectively.

Deleting a Key Zone
➜ To delete a key zone, select it and then select “Delete Key Zone” 

from the Edit menu. 

About Key zones, Assigned and Unassigned 
Samples
When you load samples and rearrange your key mapping, you will often wind 
up with samples that are not assigned to any key zone. In the following texts 
we refer to the samples as follows:

• Assigned samples are samples that are currently assigned to one 
ore more key zones.

• Unassigned samples are samples that reside in the sample mem-
ory, but that are currently not assigned to any key zone.

Adding Sample(s) to a Key Map

If the sample hasn’t been loaded yet

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the Sample Browser to add one, or several (see below), sam-
ple(s).

The following will happen:

➜ If the zone contained a sample prior to loading, this will be replaced, 
both in the zone and in the sample memory, unless the sample was 
also used by another key zone, in which case it will be kept.

➜ If you loaded several samples, one of the samples will be assigned 
to the key zone, and the other samples will be loaded but remain un-
assigned.

If the sample is already loaded but unassigned

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the Sample knob to dial in the sample you want the key zone to 
play.

The Sample knob.
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Setting the Root Key
Once you have defined a key zone, and added a sample, you should set the 
root key for the sample. 

➜ Select the key zone the sample belongs to, and click on the key you 
wish to set the root key to.
Which key to select is normally determined by the pitch of the sample. 
For example if the sample plays a F#2 guitar note, click on F#2.

✪ Note that it is possible to select a root key outside the key zone, if 
required.

Removing Sample(s) from a Key Map
➜ To remove a sample, select the zone it belongs to, and then select 

“Delete Sample” from the Edit or context menus.
The sample is removed from the zone and from sample memory.

➜ To remove a sample from a key zone/map, without removing it from 
memory, you can either select “No Sample” with the Sample knob 
for that zone, or simply replace it with another sample in the same 
way.

Removing All Unassigned Samples
➜ To remove all samples that are not assigned to any key zone, select 

Delete Unused Samples from the Edit menu.

Rearranging Samples in a Key Map
There is no specific function for rearranging or trading places between sam-
ples and key zones. Simply select a key zone and change the current sample 
assignment with the Sample knob.

Setting Sample Level
For each key zone you can set a volume level, using the Level button below 
the display. If the transition between two key zones causes a noticeable level 
difference, this parameter can be used to balance the levels.

Tuning Samples
Sometimes you might find that the samples you wish to use in a key map are 
slightly out of tune with each other. This parameter allows you to tune each 
sample in a map by +/– half a semitone. 

➜ Select the key zone(s) that contains the out of tune sample(s), and 
use the Tune knob below the keyboard display. 

✪ If all samples originate from different sources, and all or most of 
them are pitched slightly different (a not uncommon sampling sce-
nario), you could first tune them so that they all match each other, 
and then, if necessary, use the Sample Pitch controls in the Osc 
section to tune them globally to the “song” you wish to use the 
samples in.

➜ Note that if all the samples were slightly out of tune by the same 
amount in relation to the song you intend to use the samples in, it 
would be much simpler to use the Sample Pitch controls in the Osc 
section directly.

Looping Samples

A sample, unlike the cycles of an oscillator for example, is a finite quantity. 
There is a sample start and end. To get samples to play for as long as you 
press down the keys on your keyboard, they need to be looped. 

For this to work properly, you have to first set up two loop points which deter-
mine the part of the sample that will be looped, and make this a part of the 
audio file. You cannot set loop points in the NN-19, this has to be done in a 
sample editor. 

All included samples already have set loop points (if needed).
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For each sample (or key zone), you can select the following Loop modes by 
using the Loop knob below the keyboard display:

➜ OFF
No looping is applied to the sample.

➜ FWD
The part between the loop points plays from start to end, then the cycle is 
repeated. This is the most common loop mode.

➜ FWD - BW
The part between the loop points plays from start to end, then from end to 
start (backwards), and then repeats the cycle. 

! For samples without any loop points, the whole sample will be 
looped.

About the Solo Sample Function
The Solo Sample button will allow you to listen to a selected sample over the 
entire keyboard range.

➜ Select the key zone the sample is assigned to, and then activate 
Solo Sample.
This can be useful for checking if the root key is set correctly or if the cur-
rent range is possible to extend etc.

! For Solo Sample to work, “Select Key Zone via MIDI” must be dis-
abled!

Automap Samples
If you have a number of samples that belong together, but haven’t been 
mapped them to key zones you can use the “Automap Samples” function on 
the Edit menu. This is used in the following way:

1. Select all samples that belong together and load them in one go, us-
ing the sample browser.
One of the samples will be assigned to a key zone spanning the whole 
range, and the rest will be loaded in to memory but remain unassigned.

2. Select Automap Samples from the Edit menu.

Now all samples currently in memory (assigned or unassigned) will be ar-
ranged automatically so that:

➜ Each sample will be placed correctly according to its root note, and 
will be tuned according to the information in the sample file.
Most audio editing programs can save root key information as part of the 
file.

➜ Each sample will occupy half the note range to the next sample’s 
root note.
The root key will always be in the middle of each zone, with the zone ex-
tending both down and up in relation to the root position.

Mapping Samples Without Root Key or Tuning 
Information
Some samples may not have any information about root key or tuning stored 
in the file. If the file names indicate the root key you can manually set it for 
each sample using the method described below. In a worst case scenario, 
i.e. no tuning or root key information whatsoever, you can still make use of 
the Automap function:

1. Select all samples that belong together and load them in one go, us-
ing the sample browser.
One of the samples will be assigned to a key zone spanning the whole 
range, and the rest will be loaded in to memory but remain unassigned.

2. Manually set the root key, and adjust the tune knob if the sample 
needs fine-tuning.
Without any information stored in the file, or if the file name doesn’t indi-
cate the root key, you will have to use your ears for this step. Play the 
sample and use another instrument or a tuner to determine its pitch.

3. Select the next sample using the Sample knob, and repeat the previ-
ous step.
Proceed like this until you have set a root key for all the samples in mem-
ory.

4. Select “Automap Samples” from the edit menu.
The samples will be automatically mapped according to their set root key 
positions!

How Mapping Information is Saved
All information about key zones, high and low range, root key etc. is stored 
as part of the Sampler Patch. The original sample files are never altered!
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NN-19 Synth Parameters
The NN-19 synth parameters are used to shape and modulate samples. 
These are mostly similar to the parameters used to shape the oscillators in 
Subtractor - you have envelope generators, a filter, velocity control etc. 
Again, it is important to remember that these parameters do not alter the au-
dio files in any way, only the way they will play back.

! These parameters are global, in the sense that they will affect all 
samples in a sample patch.

The Oscillator Section

For a sample patch, the actual samples are what oscillators are for a synthe-
sizer, the main sound source. The following settings can be made in the Osc 
section of the NN-19:

Sample Start

This changes the start position of samples in a sample patch. Turning the 
knob clockwise gradually offsets the samples’ start position, so that they will 
play back from a position further “into” the samples’ waveform. This is useful 
mainly for two things:

➜ Removing “air” or other unwanted artefacts from the start of less 
than perfect samples.
Occasionally (although not in any samples supplied with Reason) you 
may come across samples where the start point of the sample is slightly 
ahead of the start of the actual sound. There may be noise or silence in 
the beginning which was not intended to be part of the sample. By adjust-
ing the sample start position, this can be removed.

➜ Changing the start point as an effect.
For example, if you had a sample of someone saying “one, two, three”, 
you could change the start position so that when you played the sample it 
would start on “three”. 

✪ You can also assign velocity sample start allowing to use your play-
ing to determine the exact sample start. See later in this chapter.

Setting Sample Pitch - Octave/Semitone/Fine

By adjusting the corresponding knobs you can change the pitch of all sam-
ples belonging to a patch, in three ways:

➜ Octave steps 
The range is 0 - 8. The default setting is 4. 

➜ Semitone steps 
Allows you to raise the frequency in 12 semitone steps (1 octave).

➜ Fine steps (100th of a semitone) 
The range is -50 to 50 (down or up half a semitone).

! Note that the controls in this section cannot be used to tune sam-
ples against each other, as all samples will be affected equally. To 
tune individual samples, you use the Tune parameter below the key-
board display (see page 124).

Keyboard Tracking

The Osc section has a button named “Kbd. Track”. If this is switched off, the 
sample’s pitch will remain constant, regardless of any incoming note pitch 
messages, although the oscillator still reacts to note on/off messages. This 
could be useful if you are using non-pitched samples, like drums for exam-
ple. You could then play a sample in a zone using several keys, allowing for 
faster note triggering if you wanted to play a drum roll, for example.

Osc Envelope Amount

This parameter determines to what degree the overall pitch of the samples 
will be affected by the Filter Envelope (see page 128). You can set negative 
or positive values here, which determines whether an envelope parameter 
should raise or lower the pitch.
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The Filter Section

Filters are used for shaping the overall timbre of the sound. The filter in NN-
19 contains a multimode filter with five filter types.

Filter Mode

With this selector you can set the filter to operate as one of five different 
types of filter. These are as follows:

➜ 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequen-
cies. This filter type has a fairly steep roll-off curve (24dB/Octave). Many 
classic synthesizers (Minimoog/Prophet 5 etc.) used this filter type.

➜ 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in classic analog synthesiz-
ers (Oberheim, TB-303 etc.). It has a gentler slope (12 dB/Octave), leav-
ing more of the harmonics in the filtered sound compared to the LP 24 
filter.

➜ Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange fre-
quencies are not affected. Each slope in this filter type has a 12 dB/Oc-
tave roll-off.

➜ High-Pass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out the lower 
frequencies and letting the high frequencies pass. The HP filter slope has 
a 12 dB/Octave roll-off.

➜ Notch
A notch filter (or band reject filter) could be described as the opposite of a 
bandpass filter. It cuts off frequencies in a narrow midrange band, letting 
the frequencies below and above through. 

Filter Frequency 

The Filter Frequency parameter (often referred to as “cutoff”) determines 
which area of the frequency spectrum the filter will operate in. For a lowpass 
filter, the frequency parameter could be described as governing the “open-
ing” and “closing” of the filter. If the Filter Freq is set to zero, none or only the 
very lowest frequencies are heard, if set to maximum, all frequencies in the 
waveform are heard. Gradually changing the Filter Frequency produces the 
classic synthesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the 
Filter Envelope (see “Envelope Section” below) as well. Changing 
the Filter Frequency with the Freq slider may therefore not produce 
the expected result.

Resonance

The filter resonance parameter (sometimes called Q) is used to set the Filter 
characteristic, or quality. For lowpass filters, raising the filter Res value will 
emphasize the frequencies around the set filter frequency. This produces a 
generally thinner sound, but with a sharper, more pronounced filter fre-
quency “sweep”. The higher the resonance value, the more resonant the 
sound becomes until it produces a whistling or ringing sound. If you set a 
high value for the Res parameter and then vary the filter frequency, this will 
produce a very distinct sweep, with the ringing sound being very evident at 
certain frequencies.

• For the highpass filter, the Res parameter operates just like for the 
lowpass filters.

• When you use the Bandpass or Notch filter, the Resonance setting 
adjusts the width of the band. When you raise the Resonance, the 
band where frequencies are let through (Bandpass), or cut (Notch) 
will become narrower. Generally, the Notch filter produces more 
musical results using low resonance settings.
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Envelope Section

! Please refer to the Subtractor chapter for a description of the basic 
envelope parameters.

Envelope generators are used to control several important sound parame-
ters in analog synthesizers, such as pitch, volume, filter frequency etc. Enve-
lopes govern how these parameters should respond over time - from the 
moment a note is struck to the moment it is released. 

Standard synthesizer envelope generators have four parameters; Attack, 
Decay, Sustain and Release (ADSR). 

There are two envelope generators in the NN-19, one for volume, and one 
for the filter frequency. 

Amplifier Envelope

The Amp Envelope is used to adjust how the volume of the sound should 
change from the time you press a key until the key is released. By setting up 
a volume envelope you sculpt the sound’s basic shape with the four Amplifier 
Envelope parameters, Attack, Decay, Sustain and Release. This determines 
the basic character of the sound (soft, long, short etc.). The Level parameter 
acts as a general volume control for the sample patch.

Filter Envelope

The Filter Envelope can be used two control two parameters; filter frequency 
and sample pitch. By setting up a filter envelope you control the how the filter 
frequency and/or the sample pitch should change over time with the four Fil-
ter Envelope parameters, Attack, Decay, Sustain and Release. 

Filter Envelope Amount

This parameter determines to what degree the filter will be affected by the 
Filter Envelope. Raising this knob’s value creates more drastic results. The 
Envelope Amount parameter and the set filter frequency are related. If the 
Filter Freq slider is set to around the middle, this means that the moment you 
press a key the filter is already halfway open. The set Filter Envelope will 
then open the filter further from this point. The Filter Envelope Amount set-
ting affects how much further the filter will open.

Filter Envelope Invert

If this button is activated, the envelope will be inverted. For example, nor-
mally the Decay parameter lowers the filter frequency, but after activating In-
vert it will instead raise it, by the same amount. Note that Invert does not 
affect the Osc pitch parameter (this can be inverted by setting positive or 
negative values).

LFO Section

LFO stands for Low Frequency Oscillator. LFO’s are oscillators in the sense 
that they generate a waveform and a frequency. However, there are two sig-
nificant differences compared to normal sound generating oscillators:

• LFO’s only generate waveforms with low frequencies.
• The output of the two LFO’s are never actually heard. Instead they 

are used for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound 
generating) oscillator or sample, to produce vibrato. 

The LFO section has the following parameters:
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Waveform

LFO 1 allows you to select different waveforms for modulating parameters. 
These are (from the top down):

Destination

The available LFO Destinations are as follows:

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster 
modulation rate.

Amount

This parameter determines to what degree the selected parameter destina-
tion will be affected by the LFO. Raising this knob’s value creates more dras-
tic results.

Play Parameters
This section deals with two things: Parameters that are affected by how you 
play, and modulation that can be applied manually with standard MIDI key-
board controls. 

These are:

• Velocity Control
• Pitch Bend and Modulation Wheel
• Legato
• Portamento
• Polyphony
• Voice Spread
• External Controllers

Velocity Control

Velocity is used to control various parameters according to how hard or soft 
you play notes on your keyboard. A common application of velocity is to 
make sounds brighter and louder if you strike the key harder. By using the 
knobs in this section, you can control how much the various parameters will 
be affected by velocity. The velocity sensitivity amount can be set to either 
positive or negative values, with the center position representing no velocity 
control. 

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted
Sawtooth

This produces a “ramp up” cycle. If applied to an oscillator’s 
frequency, the pitch would sweep up to a set point (gov-
erned by the Amount setting), after which the cycle immedi-
ately starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but 
inverted.

Square This produces cycles that abruptly changes between two 
values, usable for trills etc.

Random Produces random stepped modulation to the destination. 
Some vintage analog synths called this feature “sample & 
hold”.

Soft Random The same as above, but with smooth modulation.

| Destination | Description

Osc Selecting this makes LFO control the pitch (frequency) of the 
sample patch.

Filter Selecting this makes the LFO control the filter frequency. 

Pan Selecting this makes the LFO modulate the pan position of 
samples, i.e. it will move the sound from left to right in the 
stereo field.
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The following parameters can be velocity controlled:

Pitch Bend and Modulation Wheels
The Pitch Bend wheel is used for “bending” notes, like bending the strings on 
a guitar. The Modulation wheel can be used to apply various modulation 
while you are playing. Virtually all MIDI keyboards have Pitch Bend and Mod-
ulation controls. NN-19 also has two functional wheels that could be used to 
apply real time modulation and pitch bend should you not have these control-
lers on your keyboard, or if you aren’t using a keyboard at all. The wheels 
mirror the movements of the MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is 
turned fully up or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of pa-
rameters. You can set positive or negative values, just like in the Velocity 
Control section. The following parameters can be affected by the modulation 
wheel:

Legato
Legato works best with monophonic sounds. Set Polyphony (see below) to 1 
and try the following:

➜ Hold down a key and then press another key without releasing the 
previous.
Notice that the pitch changes, but the envelopes do not start over. That 
is, there will be no new “attack”. 

➜ If polyphony is set to more voices than 1, Legato will only be ap-
plied when all the assigned voices are “used up”.
For example, if you had a polyphony setting of “4” and you held down a 4 
note chord, the next note you played would be Legato. Note, however, 
that this Legato voice will “steal” one of the voices in the 4 note chord, as 
all the assigned voices were already used up!

| Destination | Description

Amp This let’s you velocity control the overall volume of the 
sound. If a positive value is set, the volume will increase the 
harder you strike a key. A negative value inverts this relation-
ship, so that the volume decreases if you play harder, and in-
creases if you play softer. If set to zero, the sound will play at 
a constant volume, regardless of how hard or soft you play.

F. Env This sets velocity control for the Filter Envelope Amount pa-
rameter. A positive value will increase the envelope amount 
the harder you play. Negative values invert this relationship.

F. Dec This sets velocity control for the Filter Envelope Decay pa-
rameter. A positive value will increase the Decay time the 
harder you play. Negative values invert this relationship.

S.Start This sets velocity control for the Sample Start parameter. A 
positive value will increase the Start Time amount the harder 
you play. Negative values invert this relationship.

A. Attack This sets velocity control for the Amp Envelope Attack pa-
rameter. A positive value will increase the Attack time the 
harder you play. Negative values invert this relationship.

| Destination | Description

F. Freq This sets modulation wheel control of the Filter Frequency 
parameter. A positive value will increase the frequency if the 
wheel is pushed forward. Negative values invert this relation-
ship.

F. Res This sets modulation wheel control of the Filter Resonance 
parameter. A positive value will increase the resonance if the 
wheel is pushed forward. Negative values invert this relation-
ship.

F. Dec This sets modulation wheel control for the Filter Envelope 
Decay parameter. A positive value will increase the decay if 
the wheel is pushed forward. Negative values invert this rela-
tionship.

LFO This sets modulation wheel control of the LFO Amount pa-
rameter. A positive value will increase the Amount if the 
wheel is pushed forward. Negative values invert this relation-
ship.

Amp This sets modulation wheel control for the Amp level param-
eter. A positive value will increase the level if the wheel is 
pushed forward. Negative values invert this relationship.
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Retrig
This is the “normal” setting for playing polyphonic patches. That is, when you 
press a key without releasing the previous, the envelopes are retriggered, 
like when you release all keys and then press a new one. In monophonic 
mode, Retrig has an additional function; if you press a key, hold it, press a 
new key and then release that, the first note is also retriggered.

Portamento (Time)
Portamento is when the pitch “glides” between the notes you play, instead of 
instantly changing the pitch. The Portamento knob is used to set how long it 
takes for the pitch to glide from one pitch to the next. If you don’t want any 
Portamento at all, set this knob to zero.

Setting Number of Voices - Polyphony
This determines the polyphony, i.e. the number of voices a patch can play si-
multaneously. This can be used to make a patch monophonic (=a setting of 
“1”), or to extend the number of voices available for a patch. The maximum 
number of voices you can set a patch to use is 99. 

! Note that the Polyphony setting does not “hog” voices. For exam-
ple, if you have a patch that has a polyphony setting of ten voices, 
but the part the patch plays only uses four voices, this won’t mean 
that you are “wasting” six voices. In other words, the polyphony 
setting is not something you need to consider if you want to con-
serve CPU power - it is only the number of voices actually used that 
counts.

Voice Spread
This parameter can be used to control the stereo (pan) position of voices. 
The Spread knob determines the intensity of the panning. If this is set to “0”, 
no panning will take place. The following pan modes can be selected:

Low Bandwidth
This will remove some high frequency content from the sound, but often this 
is not noticeable (this is especially true if you have “filtered down” your loop). 
Activating this mode will save you some extra computer power, if needed.

Controller Section
NN-19 can receive common MIDI controller messages, and route these to 
various parameters. The following MIDI messages can be received:

• Aftertouch (Channel Pressure)
• Expression Pedal
• Breath Control

If your MIDI keyboard is capable of sending Aftertouch messages, or if you 
have access to an Expression Pedal or a Breath controller, you can use 
these to modulate NN-19 parameters. The “Source” selector switch deter-
mines which of these message-types should be received.

These messages can then be assigned to control the following parameters:

| Mode | Description

Key This will shift the pan position gradually from left to right the higher 
up on the keyboard you play.

Key 2 This will shift the pan position from left to right in 8 steps (1/2 oc-
tave) for each consecutive higher note you play, and then repeat 
the cycle.

Jump This will alternate the pan position from left to right for each note 
played.

F. Freq This sets external modulation control of the filter frequency pa-
rameter. A positive value will increase the frequency with higher 
external modulation values. Negative values invert this relation-
ship.

LFO 1 This sets external modulation control of the LFO Amount param-
eter. A positive value will increase the LFO amount with higher 
external modulation values. Negative values invert this relation-
ship.

Amp This let’s you control the overall volume of the sound with exter-
nal modulation. If a positive value is set, the volume will increase 
with higher external modulation values. A negative value inverts 
this relationship.
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Connections
On the back panel of the NN-19 you will find the connectors, which are 
mostly CV/Gate related. 

Audio Outputs
These are the main left and right audio outputs. When you create a new NN-
19 device, these are auto-routed to the first available channels on the audio 
mixer.

Mono Sequencer Control
These are the main CV/Gate inputs. CV controls the note pitch. Gate inputs 
trigger note on/off values plus a level, which can be likened to a velocity 
value. If you want to control the NN-19 from a Matrix Pattern Sequencer for 
example, you would normally use these inputs. The inputs are “mono”, i.e. 
they control one voice in the sampler.

Modulation Inputs

! Remember that CV connections will not be stored in the sample 
patch, even if the connections are to/from the same NN-19 device! 

These control voltage (CV) inputs (with associated voltage trim pots), can 
modulate various NN-19 parameters from other devices, or from the modula-
tion outputs of the same NN-19 device. These inputs can control the follow-
ing parameters:

• Osc (sample) Pitch
• Filter Cutoff
• Filter Resonance
• Amp Level 
• Mod Wheel

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or 
other parameters in the same NN-19 device. The Modulation Outputs are:

• Filter Envelope 
• LFO 

Gate Inputs
These inputs can receive a CV signal to trigger the envelopes. Note that con-
necting to these inputs will override the “normal” triggering of the envelopes. 
For example, if you connected a LFO output to the Gate Amp input, you 
would not trigger the amp envelope by playing notes, as this is now con-
trolled by the LFO. In addition you would only hear the LFO triggering the en-
velope for the notes that you hold down.

• Amp Envelope
• Filter Envelope
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Introduction

The Dr.Rex Loop Player is capable of playing back and editing files created 
in ReCycle, another product created by Propellerhead Software. ReCycle is 
a program designed especially for working with sampled loops. By “slicing” a 
loop and making separate samples of each beat, ReCycle makes it possible 
to change the tempo of loops without affecting the pitch and to edit the loop 
as if it was built up of individual sounds.

ReCycled Loops
To fully understand Dr.Rex you need to understand what it means to ReCy-
cle a drum loop. Imagine that you have a sample of a drum loop that you 
want to use in a track you are working on. The loop is 144 bpm and your 
track is 118 bpm. What do you do? You can of course lower the pitch of the 
loop, but that will make the loop sound very different, and if the loop contains 
pitched elements they will no longer match your song. You can also time 
stretch it. This won’t alter the pitch, but will make the loop sound different. 
Usually it means that you loose some “punch” in the loop. 

Instead of stretching the sample, ReCycle slices the loop into little pieces so 
that each drum hit (or whatever sound you are working with) gets it's own 
slice. These slices can be exported to an external hardware sampler or 
saved as a REX file to be used in Reason. When the loop has been sliced 
you are free to change the tempo any way you want. You can also create fills 
and variations since the slices can be moved around in the sequencer.

About File Formats
Dr.Rex can read files in the following formats:

➜ REX (.rex) 
This is the file format generated by previous versions of ReCycle (Mac 
platform).

➜ RCY (.rcy) 
This is the file format generated by previous versions of ReCycle (PC 
platform).

➜ REX 2 (.rex2) 
This is the brand new ReCycle file format for both Mac and PC platforms. 
In fact, it is so new that the program version of Recycle that can create 
REX2 files hadn’t been released as of this writing! There are, however, 
REX2 files included with Reason. Amongst other things, the REX2 format 
supports stereo files. 

! At the time of this writing, ReCycle 2.0 is scheduled for imminent re-
lease. Check the Propellerheads website for up to date information.

! Unlike the other audio devices, Dr.Rex does not load or save file in-
formation in a “Patch” format. The REX file and the associated 
panel settings is instead saved in the Song (.rns) file. 

✪ If you have made adjustments (pitch, level etc.) to a REX loop that 
you wish to use in another Song, you can simply copy the whole 
Dr.Rex device from one song to another.
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Adding a Loop
To add a loop into the Dr.Rex Loop Player, proceed as follows:

1. Open the browser by selecting “Browse ReCycle/REX Files” from 
the Edit menu or the device context menu, or click on the folder but-
ton beside the Loop name display.

2. In the browser, locate and open the desired loop.
You can listen to the loops before loading by using the Preview function 
in the browser.

! Loading a new REX file will replace any currently loaded file.

Auditioning the Loop in Dr.Rex
➜ Once loaded, you can check out the loop by using the Preview but-

ton.
It will play back repeatedly in the tempo set on the transport panel. If you 
change the tempo, the loop tempo follows.

➜ You can also play the loop once via MIDI, by using the D1 key.

➜ To check out the loop together with other device sequencer data 
and patterns already recorded, activate both the Preview function 
and the sequencer Play button.
This does not have to be done in any particular order, they will play back 
in perfect sync anyway.

Loading Loops “On the Fly”
Another practical method for checking out loops, is to load them “on the fly”, 
i.e. during playback. This is especially useful if you want to check out a num-
ber of loops against other sequencer data and patterns previously recorded. 
Proceed as follows:

1. Activate Preview on the Dr.Rex and start sequencer playback.
The REX loop and the sequencer are synced.

2. Now load a new REX file by using the Browser in one of the usual 
ways.
After a brief silence, the new file is loaded, and sync is maintained.

3. Repeat step 2 as necessary until you have found a suitable loop.

➜ If you are trying out loops within the same folder, the quickest ways 
to select a new loop is to use the arrow keys next to the loop name 
display.
Or, you can click in the loop name display and select a new loop from the 
pop-up menu that appears.

! Note that the Preview function is not the “real” way of playing back 
REX loops. If you want to use the loop in a context with other de-
vices, you should transfer the REX slices to notes in the sequencer, 
as described on page 136.
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Creating Sequencer 
Notes
To be able to make your REX loop start at the same time as other sequencer 
or pattern data, you first have to create sequencer notes from the slices:

1. Select a sequencer track connected to the Dr.Rex device.

2. Set the left and right locators to encompass the section you want to 
fill with REX notes.
You may want to make sure that this area doesn’t contain any notes al-
ready, to avoid confusion.

3. Click the To Track button on the Dr.Rex panel.

Now, the program will create a note for each slice, positioned according to 
the timing of the slices. The notes will be pitched in semitone steps, with the 
first note on C1, the second on C#1 and so on, with one pitch for each slice. 
If the area between the locators is longer than the loop length, the loop notes 
will be repeated to fill out the loop.

The loop notes in the Arrange View...

...and in the Edit View.

Activating playback in the sequencer will now play back the notes on the se-
quencer track. These in turn will play back the slices in the Dr.Rex device, in 
the correct order and with the original timing maintained. Now the fun begins!

• You can change the groove in the loop by quantizing or moving 
notes.

• You can transpose notes to change the order of the slices on play-
back.

• You can use the Alter Notes function in the Change Events dialog 
(see page 29) to scramble the loop notes - without destroying the 
original loop timing.

• You can remove and draw new notes, creating any kind of variation.
• You can use the User Groove function to apply the rhythmic feel of 

the loop to notes on other sequencer tracks.

For details about editing in the sequencer, see page 20.

! Note that if you have created sequencer notes from a REX file, you 
cannot load a new REX file into Dr.Rex and play it from the existing 
track. Well, you can, but it will not play back properly. If you have 
created notes in this way, and want to change the REX file, first de-
lete the notes, then use the “To Track” command again after having 
loaded the new REX file. 

You can also export the REX file as a MIDI file, as described on page 174.
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Slice Handling
Selecting Slices

A selected slice is indicated by being highlighted in the waveform display. To 
select a slice, use one of the following methods:

➜ By clicking in the waveform display.
If you hold down [Option] (Mac) or [Alt] (Windows) and click on a slice in 
the waveform display, it will be played back.

➜ By using the “Slice” knob below the waveform display.

➜ Via MIDI.
If you activate “Select Slice Via MIDI”, you can select and “play” slices us-
ing your MIDI keyboard. Slices are always mapped to consecutive semi-
tone steps, with the first slice always being on the “C1” key.

➜ If you play back a loop with “Select via MIDI” option activated, each 
consecutive slice is selected as it is played back.
You can edit parameters during playback.

Editing Individual Slices
There are two basic methods you can use to edit individual slices in Reason:

➜ In the Waveform display of the Dr.Rex device.
This is used for making playback settings for a slice.

➜ In the Sequencer.
Here you can edit the notes that play the slices. There is a special REX 
lane for editing REX slice notes, with the notes indicated by the slice 
numbers instead of by pitches. Editing in the sequencer is described in 
the Sequencer chapter.

Editing in the Waveform Display

Here you are able to edit several parameters for each slice, by first selecting 
it, and then using the knobs below the waveform display. The following slice 
parameters can be set:

! If you have made settings to any of the parameters listed above, 
these will be lost if you load a new REX file. All Dr.Rex panel set-
tings are stored in the Song. You cannot directly apply panel set-
tings to another REX file!

| Parameter | Description

Pitch Allows you to transpose each individual slice in semi-
tone steps, over a range of more than eight octaves.

Pan The stereo position of each slice.

Level The volume of each slice. The default level is 100.

Decay Allows you to shorten individual slices.



DR. REX LOOP PLAYER138

Dr.Rex Synth Parameters
The Dr.Rex synth parameters are used for shaping and modulating the 
sound of the REX loops. These parameters are familiar synth parameters, 
similar to the ones in the Subtractor and in the NN-19 sampler. It is important 
to remember that these parameters do not alter the REX files in any way, 
only the way they will play back. 

! These parameters are global, in the sense that they will affect all 
slices in a REX file.

Oscillator Section

For a REX file, the audio contained in the slices are what oscillators are for a 
synthesizer, the main sound source. The following settings can be made in 
the Osc section of the Dr.Rex:

Setting the overall Pitch

You can change the pitch of a REX file in three ways:

➜ In octave steps.
This is done using the Oct knob. The range is 0 - 8, with “4” the default.

➜ In semitone steps.
This is done by using the Transpose knob below the waveform display, or 
by clicking on the keyboard above the knob. You can raise or lower the 
frequency in 12 semitone steps (+/– 1 octave). The transpose value can 
also be changed via MIDI, by pressing a key between C-2 and C0 (with 
C1 resetting the transpose value to zero).

➜ In cents (100th of a semitone).
The range is -50 to 50 (down or up half a semitone).

! To tune an individual slice, you select it and use the Pitch parameter 
below the waveform display.

Osc Envelope Amount

This parameter determines to what degree the overall pitch of the REX file 
will be affected by the Filter Envelope (see page 139). You can set negative 
or positive values here, which determines whether the envelope curve 
should raise or lower the pitch.

The Filter Section

Filters are used for shaping the overall timbre of the sound. The filter in 
Dr.Rex is a multimode filter with five filter modes.

➜ You activate or deactivate the filter completely by clicking the Filter 
button.
The filter is active when the button is lit.

Filter Mode

With this selector you can set the filter to operate as one of five different 
types of filter. These are as follows:

➜ 24 dB Lowpass (LP 24)
Lowpass filters lets low frequencies pass and cuts out the high frequen-
cies. This filter type has a fairly steep roll-off curve (24dB/Octave). Many 
classic synthesizers (Minimoog/Prophet 5 etc.) used this filter type.

➜ 12 dB Lowpass (LP 12)
This type of lowpass filter is also widely used in classic analog synthesiz-
ers (Oberheim, early Korg synths, etc.). It has a gentler slope (12 dB/Oc-
tave), leaving more of the harmonics in the filtered sound compared to 
the LP 24 filter.

➜ Bandpass (BP 12)
A bandpass filter cuts both high and low frequencies, while midrange fre-
quencies are not affected. Each slope in this filter type has a 12 dB/Oc-
tave roll-off.

➜ High-Pass (HP12)
A highpass filter is the opposite of a lowpass filter, cutting out the lower 
frequencies and letting the high frequencies pass. The HP filter slope has 
a 12 dB/Octave roll-off.

➜ Notch
A notch filter (or band reject filter) could be described as the opposite of a 
bandpass filter. It cuts off frequencies in a narrow midrange band, letting 
the frequencies below and above through. 
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Filter Frequency 

The Filter Frequency parameter (often referred to as “cutoff”) determines 
which area of the frequency spectrum the filter will operate in. For a lowpass 
filter, the frequency parameter could be described as governing the “open-
ing” and “closing” of the filter. If the Filter Freq is set to zero, none or only the 
very lowest frequencies are heard, if set to maximum, all frequencies in the 
waveform are heard. Gradually changing the Filter Frequency produces the 
classic synthesizer filter “sweep” sound.

! Note that the Filter Frequency parameter is usually controlled by the 
Filter Envelope (see page 139) as well. Changing the Filter Fre-
quency with the Freq slider may therefore not produce the expected 
result.

Resonance

The filter resonance parameter affects the character of the filter sound. For 
lowpass filters, raising the resonance will emphasize the frequencies around 
the set filter frequency. This produces a generally thinner sound, but with a 
sharper, more pronounced filter frequency “sweep”. The higher the reso-
nance value, the more resonant the sound becomes until it produces a whis-
tling or ringing sound. If you set a high value for the resonance parameter 
and then vary the filter frequency, this will produce a very distinct sweep, with 
the ringing sound being very evident at certain frequencies.

• For the highpass filter, the resonance parameter operates just like 
for the lowpass filters.

• When you use the Bandpass or Notch filter, the resonance setting 
adjusts the width of the band. 
When you raise the resonance, the band where frequencies are let 
through (Bandpass), or cut (Notch) will become narrower. Generally, the 
Notch filter produces more musical results using low resonance settings.

Envelope Section
Envelope generators are used to control several important sound parame-
ters in analog synthesizers, such as pitch, volume, filter frequency etc. In a 
conventional synthesizer, envelopes govern how these parameters should 
respond over time - from the moment a note is struck to the moment it is re-
leased. In the Dr.Rex device however, the envelopes are triggered each time 
a slice is played back.

There are two envelope generators in the Dr.Rex, one for volume, and one 
for the filter frequency (and/or pitch). Both have the standard four parame-
ters; Attack, Decay, Sustain and Release 

! Please refer to the Subtractor chapter for a description of the basic 
envelope parameters.

Amplifier Envelope

The Amp Envelope governs how the volume of a slice should change over 
time, from the time it is triggered (the slice note starts) until the slice note 
ends. This can be used to make a loop more distinct (by having a snappy at-
tack and a short decay time) or more spaced-out (by raising the attack time).

The Level parameter acts as a general volume control for the loop.

Filter Envelope

The Filter Envelope can be used to control two parameters; filter frequency 
and overall loop pitch. By setting up a filter envelope you control how the filter 
frequency and/or the pitch should change over time for each slice.

The Amount parameter determines to what degree the filter frequency will be 
affected by the Filter Envelope. The higher the Amount setting, the more pro-
nounced the effect of the envelope on the filter.

✪ Try lowering the Frequency slider and raising Resonance and Enve-
lope Amount to get the most effect of the filter envelope!
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LFO Section

LFO stands for Low Frequency Oscillator. LFO:s are oscillators in the sense 
that they generate a waveform and a frequency. However, there are two sig-
nificant differences compared to normal sound generating oscillators:

• LFOs only generate waveforms with low frequencies.
• The output of the two LFO:s are never actually heard. Instead they 

are used for modulating various parameters.

The most typical application of an LFO is to modulate the pitch of a (sound 
generating) oscillator or sample, to produce vibrato. In the Dr.Rex device, 
you can also use the LFO to modulate the filter frequency or panning.

Waveform

LFO 1 allows you to select different waveforms for modulating parameters. 
These are, from top to bottom:

Destination

The available LFO Destinations are as follows:

Rate

The Rate knob controls the LFO’s frequency. Turn clockwise for a faster 
modulation rate.

Amount

This parameter determines to what degree the selected parameter destina-
tion will be affected by the LFO 1, i.e. the amount of vibrato, filter wah or 
auto-panning.

| Waveform | Description

Triangle This is a smooth waveform, suitable for normal vibrato.

Inverted
Sawtooth

This produces a “ramp up” cycle. If set to control pitch (fre-
quency), the pitch would sweep up to a set point (governed 
by the Amount setting), after which the cycle immediately 
starts over.

Sawtooth This produces a “ramp down” cycle, the same as above but 
inverted.

Square This produces cycles that abruptly changes between two 
values, usable for trills etc.

Random Produces random stepped modulation to the destination. 
Some vintage analog synths called this feature “sample & 
hold”.

Soft Random The same as above, but with smooth modulation.

| Destination | Description

Osc Selecting this makes LFO control the pitch (frequency) of 
the REX file.

Filter Selecting this makes the LFO control the filter frequency. 

Pan Selecting this makes the LFO modulate the pan position of 
the REX file, i.e. it will move the sound from left to right in 
the stereo field.
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Velocity Control

Velocity is usually used to control various parameters according to how hard 
or soft you play notes on your keyboard. A REX file does not contain velocity 
values on its own. And when you create sequencer track data by applying 
the “To Track” function, all velocities are set to a default value of “64”. As ve-
locity information is meant to reflect variation, having them all set to the same 
value is not meaningful if you wish to velocity control Dr.Rex parameters.

There are basically two ways you can apply “meaningful” velocity values to 
REX files:

• After creating track data, you can edit velocity values in the Velocity 
Lane in the sequencer.

• You can play slices in real time on your keyboard. The resulting 
data will have velocity values reflecting how the notes were struck 
when you played.

When velocity values have been adjusted, you can control how much the 
various parameters will be affected by velocity. The velocity sensitivity 
amount can be set to either positive or negative values, with the center posi-
tion representing no velocity control. 

The following parameters can be velocity controlled:

Pitch Bend and Modulation Wheels

The Pitch Bend wheel is used for “bending” the pitch up or down. The Modu-
lation wheel can be used to apply various modulation while you are playing 
the loop. Virtually all MIDI keyboards have Pitch Bend and Modulation con-
trols. Dr.Rex also has two functional wheels that could be used to apply real 
time modulation and pitch bend should you not have these controllers on 
your keyboard, or if you aren’t using a keyboard at all. The wheels mirror the 
movements of the corresponding MIDI keyboard controllers.

Pitch Bend Range

The Range parameter sets the amount of pitch bend when the wheel is 
turned fully up or down. The maximum range is “24” (=up/down 2 Octaves).

Modulation Wheel

The Modulation wheel can be set to simultaneously control a number of pa-
rameters. You can set positive or negative values, just like in the Velocity 
Control section. The following parameters can be affected by the modulation 
wheel:

|  Parameter | Description

Amp This let’s you velocity control the overall volume of the file. If 
a positive value is set, the volume will increase with higher 
velocity values. 

F. Env This sets velocity control for the Filter Envelope Amount pa-
rameter. A positive value will increase the envelope amount 
with higher velocity values. Negative values invert this rela-
tionship.

F. Decay This sets velocity control for the Filter Envelope Decay pa-
rameter. A positive value will increase the Decay time with 
higher velocity values. Negative values invert this relation-
ship.

| Parameter | Description

F. Freq This sets modulation wheel control of the filter frequency pa-
rameter. A positive value will raise the frequency if the 
wheel is pushed forward. Negative values invert this rela-
tionship.

F. Res This sets modulation wheel control of the filter resonance 
parameter. A positive value will increase the resonance if 
the wheel is pushed forward. Negative values invert this re-
lationship.

F. Decay This sets modulation wheel control for the Filter Envelope 
Decay parameter. A positive value will increase the decay if 
the wheel is pushed forward. Negative values invert this re-
lationship.
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Setting Number of Voices - Polyphony

This determines the polyphony, i.e. the number of voices, or slices, Dr.Rex 
can play simultaneously. For normal loop playback, it is worth noting that 
slices sometimes “overlap”. Therefore, it is recommended that you use a po-
lyphony setting of about 3-4 voices when playing REX files. If you are “play-
ing” slices via MIDI, the polyphony setting should be set according to how 
many overlapping slices you want to have.

! Note that the Polyphony setting does not “hog” voices. For exam-
ple, if you are playing a file that has a polyphony setting of ten 
voices, but the file only uses four voices, this won’t mean that you 
are “wasting” six voices. In other words, the polyphony setting is 
not something you need to consider if you want to conserve CPU 
power - it is only the number of voices actually used that counts.

Audio Quality Settings

These two parameters provide ways of balancing audio quality vs. conserva-
tion of computer power.

High Quality Interpolation

When this is activated, the loop file playback is calculated using a more ad-
vanced interpolation algorithm. This results in better audio quality, especially 
for loops with a lot of high frequency content.

➜ High Quality Interpolation uses more computer power - if you don’t 
need it, it’s a good idea to turn it off!
Listen to the loop in a context and determine whether you think this set-
ting makes any difference.

! If you are using a Macintosh with a G4 (Altivec) processor, turning 
High Quality Interpolation off makes no difference.

Low Bandwidth (BW)

This will remove some high frequency content from the sound, but often this 
is not noticeable (this is especially true if you have “filtered down” your loop). 
Activating this mode will save you some extra computer power, if needed.
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Connections
On the back panel of Dr.Rex you will find the connectors, which are mostly 
CV/Gate related. Using CV/Gate is described in the chapter “Routing Audio 
and CV”.

Audio Outputs
These are the main left and right audio outputs. When you create a new 
Dr.Rex device, these are auto-routed to the first available channels on the 
audio mixer.

Slice Gate Output
This outputs a gate signal for each triggered slice in the loop.

Modulation Inputs
These control voltage (CV) inputs (with associated voltage trim pots), allow 
you to modulate various Dr.Rex parameters from other devices (or from the 
modulation outputs of the Dr.Rex device itself). The following CV inputs are 
available:

• Osc Pitch.
• Filter Cutoff.
• Filter Resonance.
• Amp Level.
• Mod Wheel.

Modulation Outputs
The Modulation outputs can be used to voltage control other devices, or 
other parameters in the Dr.Rex device itself. The Modulation Outputs are:

• Filter Envelope.
• LFO.

Gate Inputs
These inputs can receive a CV/gate signal to trigger the two envelopes. Note 
that connecting to these inputs will override the “normal” triggering of the en-
velopes. For example, if you connected an LFO CV output on another device 
to the Gate Amp input on the Dr.Rex, the amplitude envelope would not be 
triggered by the incoming MIDI notes to the Dr.Rex device, but by the LFO 
CV signal. In addition you would only hear the LFO triggering the envelope 
for the slices that were playing at the moment of the trigger.

• Amp Envelope
• Filter Envelope
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Introduction

The Matrix is a pattern-based device. Matrix doesn’t generate sound on its 
own, but has to be connected to another instrument device. It basically works 
by sending pattern data in the form of Note CV (pitch) and Gate CV (note on/
off plus velocity) or Curve CV (for general CV parameter control) signals to a 
device or device parameter. The patterns can be up to 32 steps, and there 
are 32 memory locations for storing pattern data. The Matrix is monophonic 
and can control one voice in an instrument device.

Unlike most other devices in Reason, the user interface of the Matrix is not 
modeled on any existing hardware equivalent. The hardware devices that 
could be said to have similar functionality are analog step sequencers, which 
usually had rows of knobs that controlled the note pitch and gate values for 
each step.

About the Three Output Types

Note and Gate CV values.

The Matrix can produce three types of output: Curve CV, Note (Key) CV and 
Gate CV. 

➜ Note CV normally controls note pitch. 
When connected to an instrument device Sequencer Control input, the 
values correspond to semitone steps.

➜ Gate CV represents a note-on/off value, plus a level value (that 
could be likened to velocity).

Both of these two outputs are typically connected to the Sequencer Control 
Gate and CV inputs on a compatible instrument device. For example, if you 
create a Matrix with either a Subtractor or a NN-19 selected, they will be 
auto-routed in this way, and will control one voice in the device.

➜ Curve CV is a separate pattern, programmed separately from the 
Note/Key and Gate CV.

Curve CV values (upper window).

This is useful for programming CV curves that control other parameters other 
than note pitch (although you could do this too). This way you could control 
the note pitch and triggering from the Key and Gate outputs for a device, 
then add a second independent pattern using the Curve CV output that could 
control filter cutoff for example.

It should be stressed that all three outputs can be used in any number of 
ways. For example, you could use the Gate CV to trigger a drum in Redrum, 
or let the Curve CV control the feedback parameter of a delay, etc.

Gate values are 
entered here

Note values are 
entered here
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Programming Patterns
! Pattern programming basics is covered in “Programming Pattern 

Devices”.

Tutorial
The programming procedure of the Matrix is to input note and gate values 
into the upper and lower fields of the pattern window respectively. You can 
input values by clicking or dragging in the pattern window. Proceed as fol-
lows:

1. Create a Subtractor synth.
You don’t have to use the Subtractor device to use the Matrix, in fact you 
don’t have to use an instrument device at all, but for this basic tutorial we 
will use a “standard” setup.

2. With the Subtractor selected, create a Matrix Pattern Sequencer.
The Matrix Note and Gate CV outputs will now be auto-routed to Subtrac-
tors Sequencer Control Gate and CV inputs, as you can see if you flip the 
rack around.

3. Make sure that the switch to the left of the pattern window is set to 
“Keys” position.
As you can see, there is a horizontal row of red rectangles at the bottom 
of the upper field in the pattern window. These rectangles represent note 
pitch, for each step in a pattern. At the moment they are all set to the 
same note pitch.

4. Click inside the upper grid section of the Matrix pattern window.
As you can see, the red rectangles are placed according to where you 
click. You can drag to input continuous note values.

5. Click in the lower area of the pattern window.
Vertical strips of varying heights can be created. These represent Gate 
velocity values. The higher the strip, the higher the velocity value. You 
can drag to input continuous gate values.

6. Press the Play button on the Matrix.
The pattern you “programmed” in the previous steps is now repeated. At 
the top of the pattern window, a red rectangle indicates every step of the 
pattern.

➜ If you now click or drag in the upper grid section with the pattern 
playing, you can hear how the note pitches change.
The note pitch corresponds to the keyboard printed to the left of the pat-
tern window, in a one octave range.
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➜ If you now click or drag in the lower gate section while the pattern is 
playing, you can hear how the timbre and volume changes. 

➜ If you drag some of the vertical rectangles down so that they disap-
pear from view, the corresponding steps of the pattern are com-
pletely silenced.

➜ By using the 5-way switch below the “Keys/Curve” switch you can 
input notes in other octave ranges (over five octaves).
Note that there can only be one note for each step in the pattern.

7. By using a combination of the methods described in the above 
steps, you can program suitable note values for each step, decide 
which steps should be played and set their velocity with the gate 
values.

Using Curve Patterns
Curve patterns are independent patterns that can be applied separately to 
the note pattern programmed in “Keys” mode. If you switch the Keys/Curve 
switch to “Curve”, the note, but not the gate steps, disappear from view, and 
leaves the upper area of the pattern window empty. You can now start pro-
gramming a curve pattern. Proceed as follows:

1. Draw a curve, using the same method as for notes or gates.
As you can see, the Curve pattern looks like large vertical gate steps. 

➜ If you play the pattern, nothing has changed, i.e. the pattern sounds 
exactly like it did before the Curve pattern was drawn.
This is because the Curve CV output hasn’t been connected to any pa-
rameter yet.

2. Flip the rack around so you can see the back panel of the Matrix.

3. Connect the Curve CV output to the Filter Cutoff Modulation Input 
on the Subtractor.
Now the curve pattern controls the filter frequency of the Subtractor.

✪ If the effect isn’t very noticeable, try raising the filter Q parameter, 
and lowering the filter frequency.

➜ The Curve CV output can be connected to any device CV or Modula-
tion input.
Actually, Curve CV signals can also produce Gate triggers (used for trig-
gering samples or envelopes for example). 

➜ A Gate trigger is produced for each curve pattern step that follows a 
value of “0”. 
If you look at the picture below, steps 2,4 and 6 will produce a trigger, be-
cause steps 1, 3 and 5 are set to zero, but the rest of the pattern would 
not.
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About Unipolar and Bipolar Curves

On the back panel of the Matrix you will find a switch, allowing you to select 
between “Unipolar” or “Bipolar” Curves. The difference is as follows:

➜ A unipolar curve has values starting from “0” and up. 
“0” is the value produced by all steps when they are “empty” (not visible). 
Unipolar is the default setting of this switch when a new Matrix is created.

Unipolar curve.

➜ A bipolar curve is divided in the “middle”, with the middle repre-
senting a value of “0”.
The curve reflects this. If no curve has been drawn and you switch to bi-
polar mode, all steps go from the bottom up to the middle of the scale 
printed to the left of the pattern window. Thus, all steps are at “0”, and the 
curve can be drawn both up and down from the middle.

Bipolar curve.

Bipolar curves are essential in some instances. If you want to use the Matrix 
to CV control the Pan parameter for a mixer channel for example, a unipolar 
curve would start at zero - which for Pan equals center position. This means 
that you would only be able to use the curve to pan in one direction from this 
center position. A bipolar curve however, will have the zero value in the mid-
dle, allowing you to draw pan curves in both directions. Bipolar curves can 
also be used for controlling parameters with positive and negative values.

Setting Pattern Length

You may want to make settings for Pattern length, i.e the number of steps the 
pattern should play before repeating:

➜ The “Steps” spin controls are used to set the number of steps you 
wish the pattern to play.
The range is 1 to 32. You can always extend the number of steps at a 
later stage, as this will merely add empty steps at the end of the original 
pattern. You could also make it shorter, but that would (obviously) mean 
that the steps you remove won’t play back. The steps you remove aren’t 
erased though, if you set the step number back again, anything recorded 
in the previously removed step locations will be played back.

Using Tied Notes
If you activate “Tie” to the left of the Gate pattern window, you can create 
longer notes (eighth notes, quarter notes etc). A quick way to draw tied gates 
is to hold down [Shift] when you input the gate values.

Entering tied gate values.

➜ Each step that has one tied gate value will be twice the length com-
pared to a normal step.
Tied gate steps are indicated by being twice as wide in the pattern win-
dow.

➜ If two or more notes of the same pitch are tied together, the result 
will be even longer notes. 

Tied notes are also essential if you want to create typical TB-303 “Acid”-type 
lead lines - see page 152.

Selecting Patterns and Pattern Banks
This is described in the chapter “Programming Pattern Devices” in the Basics 
book.
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Setting Pattern Resolution
Matrix always follows the tempo setting on the transport panel, but you can 
also make Matrix play in different tempo “resolutions” in relation to the tempo 
setting. This is explained in the chapter “Programming Pattern Devices”.

Pattern Shuffle
Shuffle is a rhythmic feature, that gives the music a more or less pronounced 
swing feel. It works by delaying all sixteenth notes that fall in between the 
eighth notes.

Straight sixteenth note pattern (viewed in the sequencer).

The same sixteenth note pattern with shuffle applied.

In Reason, you can activate or deactivate shuffle individually for each pattern 
in a pattern device. However, the amount of shuffle is set globally with the 
Pattern Shuffle control on the transport panel.

The Shuffle on/off switch in Matrix and the Pattern Shuffle control on the transport panel.

Pattern Mute
If you deactivate the “Pattern” button above the Pattern select buttons, the 
pattern playback will be muted, starting at the next downbeat (exactly as if 
you had selected an empty (silent) pattern). For example, this can be used 
for bringing different pattern devices in and out of the mix during playback.

Pattern Functions
When a pattern device is selected, you will find some specific pattern func-
tions on the Edit menu (and on the device context menu).

Shift Pattern Left/Right

The Shift Pattern functions move the notes and corresponding gate values in 
a pattern one step to the left or right.

Shift Pattern Up/Down

! This function does not alter the Curve CV. This is because the val-
ues produced by the Curve CV do not necessarily correspond to 
semitone note steps at all.

The Shift Pattern functions will transpose all the notes in a pattern one semi-
tone up or down. 

Randomize Pattern

The Randomize Pattern function create random patterns. These can often be 
great starting points and help you get new ideas. Both Note, Gate and Curve 
CV values will be created.

Alter Pattern

The Alter Pattern function modifies existing patterns. Note that there must be 
something in the pattern for the function to work on - using an Alter function 
on an empty pattern will not do anything.

! Note that Randomize and Alter affects both the Gate, Note and 
Curve CV!



MATRIX PATTERN SEQUENCER 151

Chaining Patterns

! Selecting Patterns and Banks and using Cut, Copy and Paste with 
Patterns is described in the chapter “Programming Pattern De-
vices”. 

When you have created several patterns that belong together, you will most 
probably want to make these play back in a certain order. 

➜ Simply activate record for the track with the Matrix as the destina-
tion in the sequencer and use the Pattern and Bank buttons to de-
termine the playback order as the Song is playing. 
The Patterns play to the end before changing, so you won’t have worry 
too much over the “timing” of the pattern changes you input manually. 
When you are done, the sequencer track will contain pattern change 
data, and the patterns will automatically switch according to the order set 
while recording. 

4. More on recording pattern changes on page 8.

➜ An alternative way to do this is editing directly in the Pattern Edit 
lane in the sequencer.
Editing in the Pattern lane is described in the Sequencer chapter.

Converting Pattern Data to Notes

! Curve patterns cannot be converted to sequencer data! Only the 
note pattern and the gate values will be converted.

You can convert Matrix Pattern data to note data, that can be edited and 
played back from the main sequencer. Proceed as follows:

1. Select the sequencer track connected to the Matrix.

2. Set the left and right locators to the desired range or length.
If the range set is longer than the pattern(s), the data will be repeated to 
fit the range.

3. Select the Matrix device you wish to copy the pattern(s) from.

4. Select “Copy Pattern to Track” from the Edit menu or the device 
context menu.
Notes will be created between the left and right locators, according to the 
selected pattern (Gate and Key values only).

However, at this point the track with the notes is connected to the Matrix it-
self. This is pointless, since the Matrix doesn’t produce any sound. 
Therefore:

5. Re-route the sequencer track to the device which was controlled by 
the Matrix (or to another instrument device if you like).
This is done by clicking in the Out column for the track in the track list, 
and selecting another device from the pop-up menu that appears.

If you now activate playback from the transport you will send note data to the 
connected device from both the sequencer and the Matrix at the same time, 
which is probably not what you want. To avoid this happening, you have to 
do one of the following:

➜ Delete the Matrix device.

Or...

➜ Disconnect CV and Gate cables between the Matrix and the instru-
ment device on the back panel.

✪ The procedure above copies a single pattern to notes in the se-
quencer. If you have automated pattern changes, you can copy a 
complete pattern track to notes, taking all pattern changes into ac-
count. This is described on page 11.
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Example Usage
As mentioned previously, the Matrix is a very flexible device. Here follows a 
few examples of how you can use the Matrix Pattern Sequencer.

Using the Matrix for Modulation
You can effectively use the Matrix as a modulation source, much like an 
LFO. Unlike the LFO’s in Reason’s instrument devices, the Matrix can gener-
ate modulation that is synchronized to tempo, which has many advantages. 
Proceed as follows:

1. Create a Subtractor Synthesizer.

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to 
an empty pattern.
These two devices may or may not be connected (by autorouting) via 
Subtractors Sequencer Control inputs - it doesn’t matter for this example.

3. Flip the rack around and connect the Curve CV output on the Matrix 
back panel to the “Amp Level” Modulation input on the Subtractor.
This parameter is used for modulating the output level (volume) of the 
Subtractor. Volume modulation is often referred to as Tremolo. You can 
use a unipolar curve (see page 149) for this example.

4. Flip the rack back again, and switch the Matrix to display the Curve 
pattern window.
You should now see an empty pattern window, with no Gate or Curve 
events visible.

5. Draw a curve like the one shown in the illustration below.
If you use fewer or more steps than16 (as shown in the picture), just draw 
the curve so that it roughly matches the shape in the picture.

6. Activate Click on the transport panel.

7. Select the track that is routed to the Subtractor, so that you can play 
the Subtractor from your MIDI keyboard.

8. Activate Play on the transport panel, and hold a chord down on your 
keyboard.
You should now hear the volume being modulated by the Curve pattern.

9. While still in play mode, you can use the Resolution knob to change 
the modulation “rate” in relation to the tempo.
For each clockwise resolution step the modulation speed is doubled and 
vice versa, but it will always stay in sync with the tempo.

Programming “Acid Style” lead lines
By “acid style” lead lines we mean patterns that use a combination of Legato 
and slide (or portamento) effects to produce the widely used hypnotic “wavy” 
sound produced by the original Roland TB-303, and recreated in the Propel-
lerhead Software product ReBirth. To approximate this typical sound using 
Reason, proceed as follows:

1. Create a Subtractor Synthesizer.

2. Create a Matrix Pattern Sequencer, or if one already exists, set it to 
an empty pattern.

3. Make sure that the Note and Gate CV outputs are connected to the 
Subtractor Sequencer Control CV and Gate inputs, respectively.

4. For Subtractor, select either a Init Patch, or use the “TB Synth” 
patch in the Monosynth category of the Factory Sound Bank. 

➜ If you use an Init patch, it is important that you make the following 
settings:

• Set Polyphony to “1”.
• Switch Trigger Mode to “Legato”.
• Set Portamento to a value around “50”.

5. Create a pattern in Matrix, and keep it playing back.

➜ If “Tie” (see page 149) now is activated for a step, the note will be 
tied to the next and the pitch will continuously “glide” to the pitch of 
the following step.
Please note that Tie should be activated on the note you wish to slide 
from, and not the note you slide to.

➜ If you have several tied notes, one after the other, they will play as 
one long legato phrase. This can be used to create “wavy” lead 
lines with pitch bend effects.

6. Experiment with different Note, Tie and Gate values.
If you have ever used a TB-303 or ReBirth, you should now begin to get 
the hang of how you can create patterns in that particular style by using 
the Matrix together with Subtractor.

✪ Adding a DDL-1 (delay), and a D-11 (distortion) effect device will 
make it sound even more “ReBirth”-like, but of course you are also 
able to get a much wider range of timbres by utilizing Reason’s 
other sound and modulation capabilities.
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Triggering Samples
The Gate CV output can be used to trigger samples, either in Redrum or in 
the NN-19 Sampler.

➜ Connect the Matrix Gate CV out to the Gate (Sequencer Control) in 
the NN-19 or to one of the individual Gate Channel inputs of Re-
drum.
The Matrix gate values will now trigger the sample on each step that has 
a Gate value above “0”.
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Introduction

The ReBirth Input Machine is a device dedicated to receiving audio from the 
Propellerhead program “ReBirth RB-338” (version 2.01 and later). This is 
achieved by using ReWire technology (see page 46), where Reason will act 
as master and ReBirth as a slave device. If you don’t have ReBirth installed, 
you cannot use this device. If you are a ReBirth user, you can use the Re-
Birth Input Machine for the following:

➜ Receive up to eighteen channels of streaming ReBirth channels in 
Reason.
You can create more ReBirth Input Machines, but only one can be active 
at a time.

➜ Sample accurate synchronization between the audio in the two pro-
grams.

➜ The two programs can share the same audio card and take advan-
tage of multiple outputs on that card.

Preparations
For the ReBirth Input Machine to correctly operate together with ReBirth, the 
launch and quit order is very important. Proceed as follows:

Launching
1. Launch Reason.

2. Create a ReBirth Input Machine.
You may want create a Mixer prior to this step, otherwise the L/R Mix 
channels will be routed directly to the Audio Hardware Interface. If you 
have a Mixer, the L/R Mix output from the ReBirth Input Machine will be 
automatically connected to the mixer’s first available audio inputs.

3. Launch ReBirth.

4. When ReBirth is launched, select Reason as the application in fo-
cus.
If both the “Reason is Rewire Master” and the “Active” indicator on the 
ReBirth Input Machine are lit, this indicates that the launch procedure 
was correct and that Reason and ReBirth are now locked and in sync.

➜ If only the “Active” indicator is lit, either the launch order was 
wrong, or ReBirth is not installed properly.

5. Activate playback on Reason’s transport panel.
ReBirth and Reason are locked in perfect sync, and will follow any trans-
port commands in either of the programs.

! Note that there is no master/slave relationship for the transport con-
trols when using ReWire, as either device will control the other de-
vice’s transport. The audio, however, is streamed from ReBirth to 
Reason, so in this aspect Reason is the master device.

Quitting
1. First quit ReBirth.

2. Then quit Reason.

Routing
When the two programs are synced, you can route any of the eighteen avail-
able outputs in ReBirth, to separate channels in a Reason Mixer, or to the 
Hardware Interface for direct connection to a physical output on your audio 
card.

If you flip the rack around, a row of 18 audio outputs is shown, with the L/R 
Mix outputs auto-routed to your mixer or to the hardware interface.

What Signals are on the Outputs?

Mix-L and Mix-R

This is the regular master output in ReBirth RB-338. These are the only ste-
reo channels, all other channels are in mono.

➜ If none of the other channels are used, then this carries all the 
sound from ReBirth.

➜ Signals that are activated separately are removed from this mix.
If for example the 909-Mix channel is activated, then Mix-L and Mix-R 
carries all the sound from ReBirth RB-338 except the 909, which will ap-
pear on its own channel.

The individual outputs are described more closely in the ReWire chapter of 
the ReBirth manual.
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Common Device Features
While the specific parameters for each device are described below, some 
features and procedures are common to all effect devices:

The Input meter

This shows the level of the incoming audio signal, giving you an indication of 
which devices are active, connected and playing. However, you don’t need 
to worry about clipping in effect devices, even if the meter goes into the red.

The Power/Bypass switch

This is located in the upper left corner of each effect device. The switch has 
three modes, according to the following figure:

About making settings

You adjust effect parameters using the regular editing techniques, as de-
scribed in the Getting Started book. Note:

✪ A quick way to reset the parameters to their default values is to 
[Command]/[Ctrl]–Click the corresponding knob.

About Connections

➜ All effect devices have stereo inputs and outputs, and can be con-
nected as send effects or as insert effects. 
However, some effects are best used as one of these only. This is stated 
for each effect on the following pages. See also the section about the sig-
nal flow graphs below.

➜ Most of the effect devices have one or several CV inputs on the 
back panel.
These allow you to control various effect parameters in real-time, from 
another device in the rack. See page 34 for details about routing CV.

The Signal Flow graphs

On the back of each effect device, you will find two or three small “graphs”. 
These indicate how the effect device handles mono and stereo signals, de-
pending on the connections. The selection of graphs for a device tells you 
how it should be used, according to the following rules:

| Mode | Description

Bypass In this mode, the input signal is passed directly to the audio out-
put, without being affected by the effect device. This is useful 
when the effect device is connected as an insert effect, and you 
want to compare the effect sound with the dry sound.

On This is the default mode, in which the device processes the in-
coming signal.

Off In this mode, the effect device is turned off and neither dry nor 
effect sound is sent out. This is useful when the device is con-
nected as a send effect and you want to turn it off temporarily.

| Graph | Description

Can be connected as a mono-in, mono-out device. 
(Of course, all effect devices can be connected in mono. How-
ever, if this graph isn’t shown for a device, this means that a 
mono-in, mono-out connection may not give the proper results).

Can be connected as a mono-in, stereo-out device. This means 
that the device creates some sort of stereo effect (e.g. a reverb) 
or a mono effect that can be panned.

If you connect both inputs and outputs in stereo, the two sides 
will be processed independently (true stereo processing).

If you connect both inputs and outputs in stereo, the two sides 
are summed before the effect processing. However, the actual 
effect is in stereo (and the dry signal will remain in stereo, if it is 
passed through the effect).
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RV-7 Digital Reverb

Reverb adds ambience and creates a space effect. Normally, reverb simu-
lates some kind of acoustic environment such as a room or a hall, but you 
could also use it as a special effect.

➜ The Reverb device can be used as a send effect or an insert effect.
If several devices uses the same type of reverb, you should connect the 
reverb as a send effect, to conserve computer power.

Parameters

The display to the left on the panel shows the selected reverb algorithm - the 
general type of reverb. By clicking the arrow buttons you can change algo-
rithm, with the following options available:

✪ If you need to conserve computer power, try using the Low Density 
algorithm. This uses much less power than the other algorithms.

The selected reverb algorithm can be tweaked using the parameters on the 
device panel:

CV Inputs

You can control the Decay parameter via the CV input on the back of the Re-
verb device.

| Algorithm | Description

Hall Emulates a fairly large, smooth hall.

Large Hall Emulates a larger hall, with pronounced pre-delay.

Hall 2 A hall reverb with a brighter attack than “Hall”.

Large Room Emulates a large room with hard early reflections.

Medium Room Emulates a medium-sized room with semi-hard walls.

Small Room A smaller room, suitable for “drum booth”-type reverbs.

Gated A gated reverb, that is abruptly cut off.

Low Density A thinly spaced reverb, where you clearly can here the in-
dividual echoes. Useful for strings and pads and as a spe-
cial effect.

Stereo Echoes An echo effect with the repeats alternating between ste-
reo sides.

Pan Room This is slightly similar to “Stereo Echoes”, but the echo re-
peats have soft attacks.

| Parameter | Description

Size Adjusts the emulated room size. Middle position (value 0) is 
the default size for the selected algorithm. 
Lowering this parameter results in a closer and gradually 
more “canned” sound. Raising this parameter results in a 
more spacey sound, with longer pre-delay.
For the “Stereo Echoes” and “Pan Room” algorithms, the 
Size parameter adjusts the delay time.

Decay This governs the length of the reverb effect. Middle position 
is the default decay time for the selected algorithm.
Note: Decay is not used for the “Gated” algorithm.

Damp Raising the Damp value cuts off the high frequencies of the 
reverb, thereby creating a smoother, warmer effect.

Dry/Wet If you are using the reverb as an insert effect, you use this 
parameter to adjust the balance between the unprocessed 
audio signal (dry) and the effect (wet). 
If the reverb is used as a send effect, this should be set all 
the way to wet only, since you can control the balance by us-
ing the AUX send controls in the Mixer.



THE EFFECT DEVICES160

DDL-1 Digital Delay Line

This is a mono delay (with the output pannable in stereo) that can be syn-
chronized to the song tempo. The delay can be used as a send effect or an 
insert effect. 

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

➜ Pan CV.
This allows you to control the panning of the delay signal. Connect an 
LFO to this for moving delay effects, or use a Matrix pattern to simulate 
random delay panning.

➜ Feedback CV.
This allows you to control the amount of feedback (the number of delay 
repeats) from another device. Useful for dub-type echoes on certain 
beats or notes only.

Switching between Unit modes

When you switch between the two Unit modes (Steps and MS), the following 
rules apply:

➜ If you switch from Steps mode to MS mode, the delay will be set to 
the same actual delay time as was used in the Steps mode.
This means that you can set up an exact rhythmic delay in Steps mode, 
and then switch to MS mode to adjust it slightly. 

➜ If you switch from MS mode to Steps mode, the delay is reset to the 
previously used Steps value.

| Parameter | Description

Delay time The display to the left on the device panel shows the delay 
time, either as note value steps (based on the sequencer 
tempo and the Step Length parameter) or in milliseconds, 
depending on the setting of the Unit switch. 
The maximum delay time is two seconds (2000 ms) while 
the maximum number of steps is 16. 
Note that if the tempo is low, you may reach the maximum 
delay time at a lower number of steps than 16 (in which 
case raising the steps value will not make any difference).

Unit This is where you select whether you want a tempo-based 
delay (“Steps” mode) or a free time delay (“MS” mode).
In the Steps mode, you specify the delay time in note value-
based steps. This means that if you change the tempo in 
the transport panel, the delay will maintain its rhythmic rela-
tion to the music (provided that the resulting delay time 
doesn’t reach the maximum value). This mode is useful for 
creating rhythmic patterns.
If you change the tempo when using the delay in MS mode, 
the delay time will remain the same.
See also the note about switching Unit modes below.

Step length Governs whether each step in Steps mode should be a six-
teenth note (1/16) or an eighth triplet note (1/8T).

Feedback Determines the number of delay repeats.

Pan Pans the delay effect to the left or to the right.

Wet/Dry If you are using the delay as an insert effect, you use this 
parameter to adjust the balance between the unprocessed 
audio signal (dry) and the delay effect (wet). 
If the delay is used as a send effect, this should be set all 
the way to wet only, since you can control the balance by 
using the AUX send controls in the Mixer.

| Parameter | Description
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D-11 Foldback Distortion

The D-11 is a simple but effective distortion effect, capable of producing any-
thing from just a whisper soft touch of distortion, to complete thrashing. This 
effect is most often used as an insert effect.

Parameters

The distortion has the following parameters:

CV Inputs

On the D-11 you will find a CV input for controlling the Amount parameter. 
This can produce very drastic effects, especially if you control parameters in 
the instrument device (such as filter frequency and resonance) at the same 
time.

ECF-42 Envelope 
Controlled Filter

The ECF-42 is a multimode filter with a built in envelope generator. It is 
mainly designed to be used together with pattern devices to create pattern 
controlled filter and envelope effects, but it can also be triggered via MIDI, or 
used as a “static” filter for shaping the sound of an instrument device or a 
whole mix. 

Usage

The Envelope Controlled Filter is best connected as an insert effect. How-
ever, unlike the other effects it is not a pure “stand-alone” device. To make 
the most of the ECF-42, you need either CV/Gate from an external device or 
MIDI notes from a sequencer track.

➜ If you connect a device to the ECF-42 using audio inputs/outputs 
only, it will simply act as a filter with no velocity or envelope modu-
lation. 
Hence, all filter parameters are “static”, unless you manually turn the 
knobs or automate them in the sequencer.

➜ Connecting a gate signal to the Env Gate input on the back panel of 
the device allows you to trigger the envelope generator for the filter.
Note that the ECF-42 envelope generator is not triggered by the audio it-
self - the envelope parameters won’t do anything unless the device re-
ceives gate signals.

➜ By creating a sequencer track connected to the ECF-42, you can 
have the envelope triggered by MIDI notes on the track.
The envelope is affected by the position, length and velocity of the MIDI 
notes (but not by their pitch).

✪ If you are unfamiliar with basic filter and envelope parameters, 
please refer to the Subtractor chapter for a description of these. 

| Parameter | Description

Amount This controls the amount of distortion. The higher the 
value, the more distortion.

Foldback This adjusts the character of the distortion by introducing 
foldback, which makes the waveform more complex. 
The default value is in the middle position. This produces 
a “flat” clipping distortion, which is the most common type. 
Lowering the parameter makes the sound rounder and 
more gentle, raising it makes the sound sharper and more 
evil.
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The Filter Parameters

The ECF-42 filter section has the following parameters:

The Envelope Parameters

This is a standard envelope generator with Attack, Decay, Sustain and Re-
lease parameters. It is triggered by a gate signal connected to the Env Gate 
input on the back panel, or by MIDI notes on a sequencer track connected to 
the ECF-42. The parameters have the following functionality:

➜ The Gate indicator lights up when the device receives a signal to the 
Env. Gate input on the back panel or a MIDI note from a sequencer 
track.

CV/Gate Inputs

On the back panel of the ECF-42, you can find the following CV/Gate inputs:

➜ Freq CV.
Use this for controlling the filter frequency from another device. For 
smooth filter modulation, try connecting an LFO to this input.

➜ Decay CV.
For controlling the envelope decay parameter from another device.

➜ Res CV.
Allows you to control the filter resonance from another device. Can be 
very effective in combination with filter frequency sweeps.

➜ Env. Gate.
This is where you connect a gate signal (e.g. from a Matrix or Redrum 
device) for triggering the envelope.

| Parameter | Description

Mode This button sets the desired filter mode. Three modes are 
available: 24dB/octave lowpass, 12dB/octave lowpass and 
12dB/octave bandpass.

Freq This is the filter cutoff frequency. 
When using the ECF-42 in “static” mode (without triggering 
the envelope), this parameter adjusts the frequency content 
of the sound.
When using the envelope, the Freq parameter serves as the 
start and end frequency for the filter sweep.

Res This is the filter resonance. Raising this produces a more ex-
treme, “synthy” effect.

Env Amt Determines how much the filter frequency should be af-
fected when the envelope is triggered. The higher the value, 
the more drastic the effect.
Note though, that if the Freq parameter is set high, raising 
the Envelope Amount will not make any difference over a 
certain value! This is because the filter is already fully 
opened - try lowering the Freq parameter in that case.

Velocity This parameter determines how much the gate velocity 
value should affect the envelope amount.

| Parameter | Description

A (Attack) When the envelope is triggered, this is the time it takes be-
fore the envelope signal reaches its max value.

D (Decay) After reaching its max value, this is the time it takes for the 
envelope signal to reach the sustain level.

S (Sustain) If the gate remains open (or the MIDI note is held), the en-
velope signal will remain on this level.

R (Release) When the gate is closed (gate CV goes back to 0) or the 
MIDI note ends, this is the time it takes for the envelope 
signal to drop from its current value to the start value (set 
by the Freq parameter).
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Pattern Controlled Filter - An Example

This example shows how to use the ECF-42 and the Matrix to create pattern 
controlled filter effects. Proceed as follows:

1. Start with an empty Song.

2. Create a Mixer.

3. Create a Subtractor Synthesizer.
An Init Patch will work fine for these examples.

4. Create an ECF-42.

5. Create a Matrix Pattern Sequencer.
If you flip the rack around, you can see that the audio out from the Sub-
tractor is passed through the ECF-42 and then on to the Mixer. The Ma-
trix Curve CV is connected to the ECF-42 Frequency CV parameter, and 
the Matrix Gate CV is connected to the ECF-42 Env Gate input.

6. Select the Track connected to the Subtractor (given that you are 
handling MIDI input via the sequencer) so that you can play it from 
your keyboard.
If you play a few notes and turn the ECF-42 filter freq knob, you should 
hear the sound being filtered.

7. Draw a Gate pattern in the Matrix, using mixed velocity values.
Draw only a Gate pattern, not a Curve pattern.

8. Set both the Env.Amt and Vel knobs on the ECF-42 to about “40”.

9. Click the Run button on the Matrix panel.

10. While in Run mode, hold a chord down on your keyboard.
Now you should hear the envelope (controlling the filter) being triggered 
with every gate step.

➜ By increasing the Env.Amount, you determine how much the enve-
lope parameters should affect the filter frequency.

➜ By increasing the Vel. parameter, you determine how much the gate 
velocity should affect the filter frequency.

✪ If the filter effect isn’t very noticeable, try lowering the filter fre-
quency, and raising the Res value.

11. Set both the Env.Amt and Vel knobs on the ECF-42 to “0”.

12. With the Matrix still playing, draw a Curve pattern in the Matrix pat-
tern window.
Now, you should hear the filter frequency being modulated by the curve 
pattern. By combining the various parameters you can create many new 
filter effects. 

➜ You can also control the ECF-42 from other devices with CV and/or 
Gate outputs.

Triggering the ECF-42 via MIDI

To trigger the envelope in the ECF-42, proceed as follows:

1. Create a sequencer track for the ECF-42.
This is easiest done by bringing up the context menu for the device and 
selecting “Create Sequencer Track for XX” (where “XX” is the name of 
this particular filter device).

2. Record or draw some notes on the sequencer track.
Remember that the envelope takes the note length and velocity into ac-
count. The note pitches doesn’t matter.

3. Play back the track.
The actual notes will not be heard (since the track is connected to the 
ECF-42, which produces no sound in itself) but the envelope will be trig-
gered according to the notes.

➜ You can even control the envelope “live” via MIDI: just set MIDI in-
put to the sequencer track for the ECF-42 and play your MIDI instru-
ment!
To route MIDI input to a track, click in the In column in the track list, so 
that the MIDI connector symbol appears next to the track name.
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CF-101 Chorus/Flanger

The CF-101 is a combined chorus and flanger effect. It adds depth and 
movement to the sound by adding a short modulated delay to the audio sig-
nal. The delayed signal is then mixed with the original (either in the effect de-
vice, or manually by you - see below). The CF-101 can be used as an insert 
effect or a send effect.

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

➜ Delay CV.
Allows you to control the delay time from another device. This may give 
best results if you turn off the LFO modulation in the device (turn LFO 
Mod Amount to zero). For example, by controlling the delay parameter 
from a Matrix, you can create “stepped flanger” effects, in sync with the 
tempo.

✪ If you use the Delay CV input for “playing” the feedback tone, note 
that a higher delay value gives a lower pitch.

➜ Rate CV.
Lets you control the rate of the modulating LFO from another device.

About Stereo and Mono connections

The CF-101 can be connected using mono or stereo inputs, as shown by the 
graphs on the back panel. Note the following:

➜ A “moving” stereo effect is only obtained when you use a mono in-
put and stereo outputs.
With a stereo input, the two sides are processed in parallel, maintaining 
the stereo image of the original sound.

➜ When you are using a mono input and stereo outputs, there will 
only be a stereo effect if the internal LFO is used.
If you turn LFO Mod Amount to zero, both stereo outputs will carry the 
same signal (mono). This is because the “fake stereo” effect is produced 
by inverting the modulation for one of the output channels.

Tip: Using the CF-101 as a vibrato effect

The Send mode is intended for when using the CF-101 as a send effect. In 
this mode, the device will only output the modulated delay signal - the actual 
“chorusing” is obtained by mixing this signal with the dry, unprocessed signal 
in the Mixer.

However, if you activate Send mode while using the device as an insert ef-
fect, the result will be a pitch modulated version of the original sound - in 
short, a vibrato effect. Along with a little feedback, this can be used for spe-
cial effects.

| Parameter | Description

Delay This is a manual control for the delay time used to create 
the chorus/flanger effect. Usually, flanger-type effects use 
fairly short delay times while chorus-type effects use me-
dium long delay times.

Feedback This governs the amount of effect signal fed back to the in-
put, which in turn affects the intensity and character of the 
effect. Turning this to the extreme left (negative feedback) 
or right (positive feedback) produces different flanger ef-
fects with a pronounced resonance “tone”, while keeping it 
in between produces a more gentle chorus effect.

LFO Rate This is the frequency of the LFO modulating the delay time. 
The higher the value, the faster the sound will oscillate.

LFO Mod 
Amount

This determines the depth of the LFO modulation, i.e. by 
how much the delay time should be modulated.
If you turn this to zero, the effect will be “frozen” (most ef-
fective if you add a little feedback).

Send Mode This determines whether the delayed signal and the dry 
signal should be mixed in the effect device or not.
If you use the device as an insert effect, you should turn 
this off. The device will then output a mix of the dry signal 
and the modulated delay signal.
If you use the device as a send effect, you should activate 
Send mode. Then, the device will only output the modu-
lated delay signal, allowing you to mix it with the dry signal 
using the AUX send controls in the mixer.
See also the note below about using the CF-101 as a vi-
brato effect!
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PH-90 Phaser

The PH-90 Phaser is a classic phaser effect with some special features for 
fine-tuning the sound. It can create the classic sweeping phaser sounds suit-
able for pads or guitars, but also more extreme effects if you like. The phaser 
is best used as an insert effect.

Theory

A phaser works by shifting portions of the audio signal out of phase, and then 
adding the processed signal back to the original one. This way, narrow 
bands of the frequency range (“notches”) are filtered out. When these fre-
quencies are adjusted, a sweeping phaser sound is created.

The PH-90 is a four-stage phaser, which means that there are four “notches” 
in the frequency response curve (this is a little like using four notch filters with 
different filter frequencies - see page 108 for an explanation of notch filters). 

When the phaser frequency is adjusted (manually or by the built-in LFO), 
these notches will move in parallel in the frequency spectrum. Furthermore, 
you can adjust the distance between the notches (Split) and their Width. 
Adding feedback raises the filter gain just below each notch in the frequency 
range, creating a more pronounced effect.

Parameters

CV Inputs

The following CV inputs are available on the back panel of the device:

➜ Freq CV.
Adjusts the frequency parameter. Use this e.g. for creating envelope con-
trolled phasing (preferably with LFO Freq. Mod turned off in the device).

➜ Rate CV.
Lets you control the speed of the modulating LFO from another device.

About Stereo and Mono connections

The CF-101 can be connected using mono or stereo inputs, as shown by the 
graphs on the back panel. Note the following:

➜ A “moving” stereo effect is only obtained when you use a mono in-
put and stereo outputs.
With a stereo input, the two sides are processed in parallel, maintaining 
the stereo image of the original sound.

➜ When you are using a mono input and stereo outputs, there will 
only be a stereo effect if the internal LFO is used.
If you turn LFO Mod Amount to zero, both stereo outputs will carry the 
same signal (mono). This is because the “fake stereo” effect is produced 
by inverting the modulation for one of the output channels.

| Parameter | Description

Frequency Sets the frequency of the first notch. Adjusting this will move 
the other notches correspondingly. This is the parameter 
modulated by the LFO to create phaser sweeps.

Split This adjusts the distance between the notches in the fre-
quency range, thereby changing the character of the effect.

Width Determines the width of the notches. Raising the Width 
deepens the effect and simultaneously makes the sound 
more hollow and thin. This will also have an effect on char-
acter of the feedback “tone”.

LFO Rate This is the speed of the LFO modulating the frequency pa-
rameter. The higher the value, the faster the phaser sweeps.

LFO Freq. 
Mod

This determines the depth of the LFO modulation, i.e. by 
how much the frequency parameter should be modulated.
If you turn this to zero, the effect will be a static, formant-like 
sound (most effective if you add a little feedback).

Feedback This is similar to the resonance control on a filter. Raising 
the feedback gives a more pronounced “tone” in the effect. 
For “singing” phaser sounds, try raising this to the maximum.
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COMP-01 Auto Make-up 
Gain Compressor

The COMP-01 compressor levels out the audio, by making loud sounds 
softer. To compensate for the volume loss, the device has an automatic 
make-up gain, that raises the overall level by a suitable amount. The result is 
that the audio levels become more even and individual sounds can get more 
“power” and longer sustain.

The COMP-01 should be used as an insert effect, either for a single instru-
ment device or for a whole mix (e.g. inserted between a Mixer device and the 
Hardware Interface).

Parameters

➜ There are no CV inputs for the Compressor.

| Parameter | Description

Ratio This lets you specify the amount of gain reduction applied to 
the signals above the set threshold. The value is expressed 
as a ratio, from 1:1 (no reduction) to 16:1 (levels above the 
threshold are reduced by a factor 16).

Threshold This is the threshold level above which the compression 
sets in. Signals with levels above the threshold will be af-
fected, signals below it will not.
In practice, this means that the lower the Threshold setting, 
the more the compressor effect.

Attack This governs how quickly the compressor will apply its effect 
when signals rise above the set threshold. If you raise this 
value, the response will be slower, allowing more of the sig-
nal to pass through the compressor unaffected. Typically, 
this is used for preserving the attacks of the sounds.

Release When the signal level drops below the set threshold, this de-
termines how long it takes before the compressor lets the 
sound through unaffected. Set this to short values for in-
tense, “pumping” compressor effects, or to longer values for 
a smoother change of the dynamics.

Gain meter This shows the amount of gain reduction or increase (in dB), 
caused by the combined compression and make-up gain.
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PEQ-2 Two Band 
Parametric EQ

While there is a simple two-band shelving equalizer available for each chan-
nel in the mixer, the PEQ-2 gives you much more precise control over the 
tone color. The device consists of two independent, fully parametric equaliz-
ers and is most often used as an insert effect, in mono or stereo.

About the two EQ modules

The two independent EQs are labeled “A” and “B”. 

➜ EQ A is always active (provided that the effect device is in “On” 
mode and that you have set the Gain to a value other than 0). 

➜ To activate EQ B, click the button next to the EQ B parameters, so 
that the LED lights up.
If you only use one EQ, it’s a good idea to turn EQ B off, to conserve 
computer power.

Parameters

For both EQs (A and B), the following parameters are available:

About the graphic display

The graphic display to the left in the device panel shows the frequency re-
sponse curve as set by the EQ parameters. This gives a visual feedback and 
helps you tailor the EQ settings.

CV Inputs

The following CV inputs are available on the back panel of the device:

➜ Freq 1 CV.
Allows you to control the frequency of EQ A from another device, creat-
ing subtle or dramatic EQ sweeps depending on the Q and Gain settings.

➜ Freq 2 CV.
Allows you to control the frequency of EQ B in the same way.

| Parameter | Description

Frequency This determines the center frequency of the EQ, e.g. at 
which frequency the level should be decreased or in-
creased. The range is 31 Hz to 16 kHz.

Q This governs the width of the affected area around the set 
center frequency. The higher the value, the narrower the 
affected frequency range.

Gain Specifies how much the level of the selected frequency 
range should be boosted (positive values) or lowered 
(negative values). The gain range is ±18 dB.
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File Menu
New
When you select this, a new, empty song appears. The exact contents of this 
song is determined by the contents of your “Default Song.rns” document.

To customize the contents of new songs, proceed as follows:

1. Select New from the File menu to create a new song document win-
dow.

2. Add/remove devices and make settings as desired.
Typically, you may want the default song to contain your choice of de-
vices and possibly some patterns. You could also make some special 
routing between devices, or even add some sequencer data.

3. Save the song in the Reason program folder under the name “De-
fault Song.rns” (but without the quotes).
The next time you launch the program or select New from the File menu, 
the new song document will contain the devices and settings you made.

Open...
To open a Song, proceed as follows:

1. Pull down the File menu and select Open.
The Reason song browser window appears.

2. Use the browser to navigate to the desired folder on disk or within a 
ReFill.

3. When you have located the song file, select it and click Open (or 
double click on the file).
The song appears in its own document window.

✪ You can have several songs open at the same time if you like. This 
allows you to copy and paste patterns and patches between songs. 
However, all open songs consume some memory and performance, 
so you may want to close songs you don’t need.

Close
This closes the active window.

If the window is a song document and it has unsaved changes, you will be 
asked whether you want to save those changes.

Save
This saves the active song document to disk.

• If the song document hasn’t yet been saved, the Save As dialog ap-
pears, requesting you to enter a file name and specify a location for 
the file on disk.

• If the document has already been saved at least once, the document 
will simply be saved without any questions.

Save As...
This saves the active song document to disc. A standard Save As dialog ap-
pears requesting you to enter a file name and specify a location for the file on 
disk.

✪ You can set things up so that any samples used in the song are in-
cluded in the song file itself by specifying self-contained settings 
(also on the File menu).
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Song Information...

This brings up a dialog that allows you to add contact information, comments 
about the song, etc. Furthermore, if you save a published version of the song 
in the Reason Song Archive on the Propellerhead web site, vital information 
can automatically be extracted by the web archive engine, and displayed 
with the song file.

The dialog contains the following items:

Text in Window Title

The text you add here will be displayed directly after the file name in the song 
window’s title bar.

More Information

This is where you add notes and comments about the song.

Song Splash

Allows you to add a picture to the song. If the “Show splash on song open” 
checkbox is ticked, the picture will be displayed when the song is opened.

To add a splash picture, click the folder button at the upper right corner, and 
locate and open the picture file in the file dialog that appears.

! Splash pictures must be JPEG files (Windows extension “.jpg”) with 
a size of 256 x 256 pixels.

To remove the splash picture from the song, click the cross button.

Author’s Web Page

Allows you to specify your web site. The user can go directly to your site by 
clicking the Browser button to the right (provided there is a working Internet 
connection).

Author’s Email

This is where you specify your email address, if you want other Reason us-
ers to send you their comments, etc.

Publish Song...
If you want to make your songs available to the public, e.g. for downloading 
on the Internet, there is a special file format for this. A Reason published 
song (Windows file extension “.rps”) is much like a self-contained song, but 
has the following restrictions:

• The user cannot save any changes to the song.
• Copy, Cut and Paste is disabled.

In a word, published songs are “locked”. They are meant for playback only - 
no elements can be added, removed or extracted. Furthermore, a published 
song contains information about which ReFills are required (if any).

To create a published song, pull down the File menu and select Publish 
Song. Specify a name and location for the published song in the file dialog 
that appears, and click Save.

➜ Note that you don’t have to make self-contained settings - all files 
(except ReFill components) are automatically included.

About the Reason Song Archive

On the Propellerhead web site (www.propellerheads.se) you will find the 
Reason Song Archive. This allows you to share your music with other Rea-
son users by uploading your songs. 
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Song Self-contain Settings...

A self-contained song contains not only the references to the used files, but 
also the files themselves. You can choose exactly which files should be in-
cluded in the self-contained song, with the following exception:

! Files that are part of a ReFill cannot be included in a self-contained 
song.

If your song contains samples or REX files from a ReFill, other users must 
have the same ReFill to be able to play the song.

To specify which files should be included in the song, proceed as follows:

1. Tick the checkbox in the Sound column for the files you want in-
cluded in the song.

➜ You can use the Check All button to activate all checkboxes in one 
go.
Similarly, the Uncheck All button deactivates all checkboxes.

➜ Files that are part of a ReFill are indicated by a lock symbol instead 
of a checkbox (since they cannot be included in the song file).
The rightmost column indicates to which ReFill each such file belongs.

2. When you have selected the desired sounds, click OK.
The dialog is closed. The next time you save, the specified sounds will be 
included in the song file.

! Note that a self-contained song file will be considerably larger than 
the original song file. 
However, samples included in a self-contained song are automati-
cally compressed by approximately 50%, meaning that the self-con-
tained song will still be a lot smaller than the original song and the 
sample files combined.

“Un-self-containing” a Song

If you have opened a song that is more or less self-contained (i.e. contains 
one or several sounds embedded in the song file), you may want to extract 
these sounds and make the song refer to them on disk as usual.

1. Locate the sounds you want to extract from the song file, and deac-
tivate their checkboxes (or click Uncheck All).

2. Click OK to close the dialog.
Now, the program will check for each “extracted” sound file whether it is 
available in your database (at its original, stored location) or not.

➜ If the program finds the sound file at the location stored in the song, 
it is simply removed from the song file, and the original file refer-
ence path is used.

➜ If the program doesn’t find the sound file, a file dialog appears, al-
lowing you to select a folder and name for the sound file.
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Import MIDI File...
Reason can import standard MIDI files (SMF). This allows you to import MIDI 
data to Reason from other applications.

➜ Under Windows, MIDI files have the extension “.mid”.
On a Macintosh, MIDI files are recognized if they have the file type “Midi”.

➜ If the imported MIDI file is of “Type 1”, there will be one sequencer 
track for each track in the MIDI file.

➜ If the imported MIDI file is of “Type 0” (that is, it contains one track 
with MIDI events on multiple channels), there will be one sequencer 
track for each used MIDI channel.

➜ Any tempo changes in the MIDI file are disregarded.
The tempo in Reason will be set to the first tempo in the MIDI file.

➜ The new tracks will not be connected to devices in the rack.
You will need to connect the tracks manually to the proper devices, by 
using the Out pop-up menu in the track list.

➜ All controller data in the MIDI file is included.
This means that pitch bend, volume and modulation wheel data are pre-
served properly. However, some controllers may “mean” different things 
for the original MIDI instruments used when creating the MIDI file and the 
devices in Reason. When you have connected a sequencer track to a de-
vice, you may therefore need to remove some unwanted automation 
from the track.

Export MIDI File...
Reason can export standard MIDI files (SMF). This allows you to transfer 
MIDI data from Reason to other applications.

1. Set the End (E) marker at where you want the MIDI file to end.
The MIDI file will contain all events on all tracks from the start of the song 
to the End marker.

2. Select “Export MIDI File” from the File menu. 

3. In the file dialog that appears, specify a name and location for the 
file.
Under Windows, the file will automatically get the extension “.mid”. Under 
MacOS, this is not required. However, if you want the MIDI file to be rec-
ognizable under Windows (and by some hardware sequencers), you may 
want to activate the option “Add Extension to File Name” before saving.

4. Click Save.

MIDI files exported by Reason will have the following properties:

➜ The MIDI file will be of Type 1, with one MIDI track for each track in 
the Reason sequencer.
The tracks will have the same names as in the Reason sequencer.

➜ Since the Reason sequencer doesn’t use MIDI channels as such, all 
tracks will be set to MIDI channel 1.

➜ The sequencer tempo is included in the MIDI file.

Export Device Patch...
This item is valid for all items that can save patches. The menu item name 
reflects the type of device selected (for example “export Redrum Patch”).

Even though the device settings are stored in the song, you may want to 
save any settings you have made for a device as a separate patch file. This 
allows you to use the patch in other songs, and lets you try out other patches 
in your song without risking to lose your sound.

➜ Under Windows, the different types of patch files have different file 
extensions.
These are “.zyp” (Subtractor patch files), “.smp” (NN19 patch files) and 
“.drp” (Redrum patch files). Under Windows, file extensions are automat-
ically added by Reason when you save. Under MacOS, you can choose 
to automatically add extensions by activating the “Add Extension to File 
Name” checkbox in the save dialog (this is not required, but may be a 
good idea if you want the saved files to be usable under Windows).

➜ If you have selected a patch, modified it and want to save it with the 
modifications, you could either save a separate, modified version of 
the patch (with a new name) or simply overwrite the old patch file on 
disk.
As usual, you will be asked whether you really want to replace the exist-
ing patch file.

✪ You can save a patch under the same name and location (without 
having the save dialog appear) by holding down [Option] (Mac) or 
[Alt] (Windows) and clicking the floppy disk button on the device 
panel. Note that this overwrites the original patch!



MENU AND DIALOG REFERENCE174

Export Song/Loop as Audio File...
When you have created a complete song, you may want to mix it down to an 
audio file to make it playable for other people (who don’t use Reason). You 
can either export the whole song (from the start to the “E” marker), or only 
the loop (the area between the left and right locator in the sequencer). Pro-
ceed as follows:

1. Make sure only the main stereo outputs are used.
The export function will only include audio routed to the stereo outputs.

2. Make sure the Loop/End markers are at the correct positions.
If you want to export the loop, you need to set the left and right locators to 
encompass the desired area. If you instead want to export the whole 
song, make sure the End (E) marker is at the desired end position.

✪ If you are using reverb or delay, you may want to adjust the right lo-
cator or End marker so that the reverb/delay “tails” are included in 
the exported file.

3. Check that the song (or loop) plays back properly.
It’s especially important that no clipping occurs during playback (see 
page 74).

4. Pull down the file menu and select Export Song as Audio File (or Ex-
port Loop as Audio File).
A file dialog appears.

5. Specify a name, location and file type (AIFF or Wave) for the audio 
file, and click Save.

6. Specify a sample rate and bit depth (resolution) for the exported file 
in the Settings dialog that appears.

7. Click OK.
The program creates the audio file. Depending on the length of the song/
loop, this may take a while, during which a progress dialog is shown.

Export REX as MIDI File...
If you have imported a REX file into a Dr. Rex device and wish to play back 
the loop via MIDI (typically from another sequencer), proceed as follows:

1. Select the Dr. Rex device in the rack.

2. Select “Export REX as MIDI File...” from the File menu.

3. Save the MIDI File to disk.

4. In the other application, open the MIDI file you just created.

5. Set up the other application to play back the MIDI File on the correct 
MIDI Output and MIDI Channel (the output and channel on which the 
Dr. Rex device receives data).

Quit
This allows you to quit the program. If there are any documents open with un-
saved changes you will be asked whether you want to save those changes.
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Edit Menu
Undo
Virtually all actions in Reason can be undone. This includes creation, dele-
tion and reordering of devices in the Rack, parameter value adjustments, ed-
iting in the sequencer and tempo/time signature adjustments. You can undo 
up to 10 actions.

➜ To undo the latest action, select “Undo” from the Edit menu or hold 
[Command] (Mac) or [Ctrl] (Windows) and press [Z].
The action to be undone is indicated next to the Undo command on the 
Edit menu. For example, if your latest action was to delete some de-
vice(s) from the Rack, the Edit menu will say “Undo Delete Devices”.

Redo
To redo an undone action (“undo the undo operation”), select “Redo” from 
the Edit menu or hold [Command] (Mac) or [Ctrl] (Windows) and press [Y]

The action to be redone is indicated next to the Redo command on the Edit 
menu.

You can undo/redo up to 10 actions.

Cut/Cut Device/Cut Pattern
This command takes the selected item(s), removes them and places them 
on the clipboard (an invisible storage location) from where they can later be 
pasted in.

Cutting applies to tracks, sequencer events and Groups, devices and pat-
terns.

Copy/Copy Device/Copy Patch/Copy Pattern
This command takes the selected item(s), copies them and places the cop-
ies on the clipboard (an invisible storage location) from where they can later 
be pasted in

Copying applies to tracks, sequencer events and Groups, devices and pat-
terns.

Paste/Paste Device/Paste Patch/Paste Pattern
This command takes the items you have cut or copied and pastes them back 
into the document.

Sequencer tracks

➜ If you Paste the track(s) into their original song, this simply dupli-
cates the tracks.
However, the Pasted tracks will not be connected to any devices in the 
rack.

➜ You can also Paste the track(s) into another song.
Note that only the tracks (complete with contents) are copied and pasted 
- not their respective devices. You may want to separately copy and 
paste the devices to the other song.

Sequencer events and groups

➜ When you Paste sequencer events and groups, they appear at the 
song position, on their original track(s).
If you have deleted the original tracks, or if you Paste into another Rea-
son song document, new tracks will be created as needed.

Devices

➜ When you Paste devices, these are inserted into the rack below the 
currently selected device.
If no device is selected, the pasted devices will appear at the bottom of 
the rack.

➜ If you Copy and Paste several devices, the connections between 
these are preserved.

➜ If you hold down [Shift] when you Paste a device, Reason will at-
tempt to automatically route its audio patching. 

Patterns

➜ Paste Pattern copies the pattern on the clipboard to the selected 
pattern location in the selected device.
This overwrites the selected pattern with the one on the clipboard.
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Transferring patterns between Reason songs

If you want to copy patterns between different Reason songs, you use copy 
and paste:

1. Open both songs.

2. Select the pattern you want to copy.

3. Select Copy Pattern from the Edit menu or the device context menu.

4. Make the other song active.
This is done by clicking in the song window or by selecting the song from 
the Windows menu.

5. Select the bank and pattern location to which you want to copy the 
pattern.
Note that any pattern already stored in that location will be overwritten!

6. Select Paste Pattern from the Edit menu or the device context 
menu.

Clear/Delete Device/Clear Pattern
This menu item is used for deleting selected items. It is also used for clearing 
(emptying) the select pattern on a pattern device.

Initialize Patch
Sometimes it is useful to start with a “clean slate” when creating a synth 
sound, a drum kit or a sampler patch. This is done by selecting Initialize 
Patch from the device context menu or Edit menu. This sets all parameters to 
“standard” values. Initializing NN19, Dr. Rex or Redrum devices will also re-
move all sample file references, allowing you to start from scratch.

Select All
This selects all items of the same type as the one currently selected, that is 
all sequencer notes, all devices in the rack, etc.

You can use this to quickly apply a command to all items you are working on, 
for example deleting all devices in the rack (select Select All and then press 
[Delete]) or for Quantizing all notes in the Edit View (select Select All and 
then click the Quantize button).

➜ Whether the Select All function applies to the track list, the Arrange/
Edit View or the rack depends on which area has focus in the pro-
gram.
Focus is indicated by a thin frame around an area in the document win-
dow. To set focus to the desired area, click somewhere in it.

Browse Device Patches...
This menu item allows you to select a new Patch for a device. The menu item 
reflects which device is selected - in other words, you must select the device 
for the corresponding Browse Patches item to appear on the Edit menu.

When you select the menu item, the Browser dialog appears, allowing you to 
locate and select the patch, on the hard disk or within a ReFill.

When you select a patch, the device’s parameters will be set according to the 
values stored in the patch, and the name of the patch will be shown in the 
patch name display. As with any change you make, this operation can be un-
done.

! Any parameter adjustments you make on the device panel after se-
lecting a patch will not affect the actual patch file (for this you need 
to save the patch).

If referenced samples are missing

Patches for the Redrum and NN19 contain references to samples. Just like 
patches, samples can be independent files on the hard disk or elements 
within a ReFill. However, if sample files have been moved or renamed after a 
patch was saved, the sample file references in the patch will not be accurate.

If this is the case when you select a patch, the program will tell you so. You 
can then choose to either manually locate the missing files, to have the pro-
gram search for them in the database and ReFills or to proceed with missing 
sounds.

Browse ReCycle/REX Files...
This menu item is used to add a loop to the selected Dr.Rex device. Files to 
be imported can be in REX, RCY or REX2 file format. 

Loading a new REX file will replace any currently loaded file.
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Browse Samples...

Redrum

To use this menu item to load a new drum sound into Redrum, proceed as 
follows:

1. Select a channel in the drum machine, by clicking its Select button.

2. Select Browse Samples.
The Redrum sample browser opens.

3. Navigate to a location containing drum samples, select one and 
click Open.

NN19

This menu item can also be used to add a sample to a key zone in a key map 
in the NN19 sampler.

1. Select a key zone.
This can be empty, or contain a sample - it doesn’t matter for now.

2. Use the browser to add one or several (see below) sample(s).

The following will happen:

➜ If the zone contained a sample prior to loading, this will be replaced, 
both in the zone and in the sample memory, unless the sample was 
also used by another key zone.

➜ If you loaded several samples, one of the samples (the sample that 
was selected furthest down in the Browser list) will be loaded into 
the key zone, and the other samples will be loaded into the sample 
memory.

Automap Samples
This menu item applies to the NN 19 Sampler. If you have a number of sam-
ples that belong together but haven’t been mapped to key zones, you can 
use the “Automap Samples” function. This is used in the following way:

1. Select all samples that belong together and load them in one go, us-
ing the sample browser.
One of the samples will be loaded to a key zone spanning the whole 
range, and the rest will reside in the sample memory.

2. Select Automap Samples from the Edit menu.

Now the samples currently in memory will be arranged automatically so that:

➜ Each sample will be placed correctly according to its root note, and 
will be tuned according to the information in the sample file.
Most audio editing programs can save root key information as part of the 
file.

➜ Each sample will occupy half the note range to the next sample’s 
root note.
The root key will always be in the middle of each zone, with the zone ex-
tending both down and up in relation to the root position. Hence, no key 
zone high or low limits have to be manually set!

Mapping Samples Without Root Key or Tuning Information

Some samples may not have any information about root key or tuning stored 
in the file (nor indicated in the file name). If this is the case, you can still make 
use of the Automap function:

1. Select all samples that belong together and load them in one go, us-
ing the sample browser.
One of the samples will be loaded to a key zone spanning the whole 
range, and the rest will reside in the sample memory. 

2. Manually set the root key, and adjust the tune knob if the sample 
needs pitch fine-tuning.
Without any information stored in the file, or if the file name doesn’t indi-
cate the root key, you will have to use your ears for this step. Play the 
sample across different areas of the keyboard and listen to where it 
sounds the most “natural”. As long as you are in the general area of the 
correct root key, the result should be o.k. You can always adjust this 
later.

3. Select the next sample using the Sample knob, and repeat the previ-
ous step.
Proceed like this until you have set a root key for all the samples.

4. Select “Automap Samples” from the edit menu.
The samples will be automatically mapped according to their set root key 
positions!
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Delete Sample/Remove Sample

Redrum

➜ To remove a sample from a Redrum drum machine, select its drum 
sound channel and then select “Delete Sample” from the Edit menu.
The sample is removed from the drum sound channel and from sample 
memory.

NNI9

➜ To remove a sample from an NN19 Sampler’s memory, select the 
zone it belongs to, and then select “Delete Sample” from the Edit 
menu.
The sample is removed from the zone and from sample memory.

Delete Unused Samples
This menu item is used for the NN19 Sampler. When you select it, all sam-
ples that are not assigned to a key zone are deleted from sampler memory.

This way you can make sure that you are not wasting any sample memory 
for samples that are not actually used.

Split Key Zone
This menu item is used for the NN19 Sampler. It splits the currently selected 
key zone in the middle. The new zone is the upper half of the split, and is 
empty. The dividing point has a “handle” above it.

Delete Key Zone
This menu item is used for the NN19 Sampler. It deletes the currently se-
lected key zone from the key map.

Copy REX Loop to Track
This menu item is used for the Dr. Rex loop player device. To be able to 
make your REX loop start at the same time as other sequencer or pattern 
data, you “convert” the slices in the loop to notes in the sequencer:

1. Select a sequencer track connected to the Dr.Rex device.

2. Set the left and right locators to encompass the section you want to 
fill with REX notes.
You may want to make sure that this area doesn’t contain any notes al-
ready, to avoid confusion.

3. Select the Dr. Rex player, so that it has focus.

4. Pull down the Edit menu and select “Copy REX Loop to Track”.
Now, the program will create a note for each slice, positioned according 
to the timing of the slices. The notes will be pitched in semitone steps, 
with the first note on C1, the second on C#1 and so on, with one pitch for 
each slice. If the area between the locators is longer than the loop length, 
the loop notes will be repeated to fill out the loop.

Now you can reorder, overdub onto, and otherwise edit the note data, using 
the REX or Key edit lanes in the sequencer.

Copy Pattern to Track
This menu item is used for the Redrum drum machine and Matrix pattern se-
quencer. It converts the selected pattern to notes on a sequencer track. Pro-
ceed as follows:

1. Select a sequencer track connected to the Redrum/Matrix.

2. Set the left and right locators to the desired range or length.
If the range set is longer than the pattern(s), the data will be repeated to 
fit the range.

3. Select the pattern device, so that it has the focus.

4. Pull down the Edit menu and select “Copy Pattern to Track”.
Notes will be created between the left and right locators, according to the 
selected pattern.

! When copying Matrix patterns, only the Gate and Keys values will 
be included!

➜ If you copied a Redrum pattern, you may want to turn off the “En-
able Pattern Section” before playing back the new track data.
Otherwise, both the main sequencer and the pattern sequencer will play 
the drum sounds, simultaneously.

➜ If you copied a Matrix pattern, you need to connect the track to an 
instrument device (such as the device which was originally con-
trolled by the Matrix), since the Matrix in itself doesn’t produce any 
sound.
Furthermore, you may want to disconnect the Matrix (or even remove it), 
to avoid having both the Matrix and the sequencer notes playing at the 
same time.

Shift Pattern Left/Right
These menu items are used for the Redrum and Matrix respectively.

The Shift Pattern functions move the notes in a pattern one step to the left or 
right. 
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Shift Drum Left/Right
These menu items are used for the Redrum.

The Shift Drum functions move the notes for the selected instrument one 
step to the left or right.

Shift Pattern Up/Down
These menu items are used for the Matrix.

The Shift Pattern functions will transpose all the notes in a pattern one semi-
tone up or down.

! This function does not alter the Curve CV.

Randomize Pattern
This menu item is used for the Redrum and Matrix.

The Randomize Pattern function create random patterns. These can often be 
great starting points and help you get new ideas.

! Note that for the Matrix, Randomize affects both the Gate, Note and 
Curve CV!

Randomize Drum
The Randomize Drum functions creates random patterns for the selected 
drum sound channel in the Redrum drum machine.

Alter Pattern
This menu item is used for the Redrum and Matrix.

The Alter Pattern function modifies existing patterns. Note that there must be 
something in the pattern for the function to work on - using an Alter function 
on an empty pattern will not do anything.

! Note that for the Matrix, Alter affects both the Gate, Note and Curve 
CV!

Alter Drum
The Alter Pattern function modifies existing patterns for the selected drum 
sound. Note that there must be something in the pattern for that channel for 
the function to work - using an Alter function on an empty pattern will not do 
anything.

Auto-route Device
Auto-routing is when devices’ audio and CV/gate connections are automati-
cally routed according to default rules. Auto-routing is normally performed:

• When a new device is created.
• When moving, duplicating or pasting devices with [Shift] pressed.

However, if a device is already in the rack, you can “force” it to be auto-
routed by selecting it and then select this menu item.

For more information about auto-routing rules, see page 35.

Disconnect Device
This disconnects all audio and CV/gate connections from the selected de-
vice(s).

Duplicate Track
This creates a copy of the selected track, complete with all events. The dupli-
cated track will appear below the original track in the track list.

Group
This puts a selection of events in the Arrange view into a Group:

1. Select the events that you want to Group.
It doesn’t matter which lanes you select - all notes, pattern changes and 
controllers within the area will be included in the Group.

➜ If you select events on several tracks, one Group for each track will 
be created.
Each Group can only contain events on one track.

2. If you want the Group to have a specific length, activate Snap and 
select an appropriate Snap value.
Often it is practical to create Groups that are one or several whole bars of 
length.

3. Select Group from the Edit menu.

Ungroup
This menu item is used to dissolve a Group:

1. Select the Group.

2. Select Ungroup from the Edit menu.



MENU AND DIALOG REFERENCE180

Find Identical Groups
This command helps you locate all Groups with the same contents:

1. Select a Group.

2. Select “Find Identical Groups” from the Edit menu.
All Groups with the same contents are selected in the Arrange View.

Insert Bars Between Locators
This function inserts an empty area between the locators in the main se-
quencer. All events after the left locator are moved to the right to “make 
room” for the inserted area.

Remove Bars Between Locators
This function removes all material between the locators in the main se-
quencer. All events after the right locator are moved to the left to “fill out” the 
gap after the removed section.

Convert Pattern Track to Notes
If you have recorded or drawn pattern changes on a Redrum or Matrix track, 
you can have the whole track converted to notes, in the following way:

1. Select the track with the pattern changes.

2. Select “Convert Pattern Track to Notes” from the Edit menu or the 
context menu for the track.
For each bar, the corresponding pattern is converted to notes on the 
track (following the same rules as for the “Copy Pattern to Track” func-
tion). The track will play back just the same as when you played the pat-
tern device with the pattern changes (including the Pattern Enabled/Mute 
switch).

➜ After the operation, all pattern changes are automatically removed 
from the track.

Redrum notes

• The “Enable Pattern Section” switch is automatically turned off 
when you use this function.

Matrix notes

• After performing “Convert Pattern Track to Notes”, you need to 
move the contents to another track, or re-route the track to another 
device.
Having the track connected to the Matrix itself is pointless, since the Ma-
trix cannot produce any sound.

• You may want to disconnect or even remove the Matrix after per-
forming this function. 
This is because you probably don’t want both the Matrix and the se-
quencer notes to play back at the same time.

Get User Groove
You can create your own groove and apply this using Groove Quantize:

1. Create or record a rhythmic note “pattern” of some kind.
You may for example record a drum pattern, or use the notes playing the 
slices in a REX loop.

2. Select the notes you want to include in the user groove.
The groove can be of any length, but it’s usually most practical to make it 
one or two bars long.

3. Select “Get User Groove” from the Edt menu or sequencer context 
menu.
Your pattern is stored as the User groove.

4. Select any notes you want to quantize, make sure “User” is selected 
as Quantize value, and quantize as usual.
The rhythmic feel of your groove is applied to the notes.

! The User Groove is only stored temporarily - it isn’t included when 
you save your Song.

Clear Automation
To remove all automation for a controller, select “Clear Automation” from the 
Edit menu.

This requires that the controller subtrack has focus. Click in the subtrack if 
you are uncertain.

Selecting “Clear Automation” will remove all controller values from the sub-
track, and the text “Not Automated” will be shown.
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Quantize Notes
In Reason, you use the Quantize function in the following way:

1. Select the notes you want to quantize.
Only notes will be affected, so you can select Groups or complete Tracks 
if you like.

2. Pull down the Quantize pop-up menu on the sequencer toolbar and 
select a Quantize value.
This determines to which note values the notes will be moved when you 
quantize. For example, if you select sixteenth notes, all notes will be 
moved to (or closer to) the closest sixteenth note position.

3. Select a value from the Quantize Strength pop-up menu.
This is a percentage, governing how much each note should be moved. If 
you select 100%, notes will be moved all the way to the closest Quantize 
value positions; if you select 50%, notes will be moved half-way, etc.

4. Click the Quantize button or select “Quantize Notes” from the Edit 
menu.
The selected notes are quantized.

Change Events...

The Change Events dialog contains some special editing functions. Proceed 
as follows:

1. Select the events to which you want to apply the editing functions.
The Change Events functions are mainly used with notes, but the Scale 
Tempo function will also affect controllers and pattern changes (see be-
low).

2. Select Change Events from the Edit menu or the context menu for 
the selected events.
The Change Events dialog appears.

3. Make settings for one of the functions in the dialog and click the Ap-
ply button next to the settings.
All settings can be made by clicking the spin controls or by clicking in a 
value field and entering a value numerically. The functions are described 
below.

4. If you like, use other settings in the same way.
You can use the transport controls as usual while the dialog is open. This 
allows you to play back the events to check out the changes.

5. When you are done, close the dialog.

Transpose

This function transposes the selected notes up or down, by the specified 
number of semitones.
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Velocity

Adjusts the velocity of the selected notes.

➜ The Add field lets you add a fixed amount to the velocity values.
To subtract, enter a negative amount. Note that the possible velocity 
range is 0-127. Adding an amount to a note with velocity 127 will not 
make any difference.

➜ The Scale field allows you to scale velocities by a percentage factor.
Scaling with a factor above 100% will increase the velocity values, but 
also make the difference between soft and hard notes bigger. Scaling 
with a factor below 100% will decrease the velocity values, but also make 
the difference between soft and hard notes smaller.

➜ By combining the Add and Scale functions, you can adjust the “dy-
namics” of the notes in various ways.
For example, by using a Scale factor below 100% and Add a suitable 
amount, you can “compress” the velocity values (decreasing the differ-
ence between the velocity values without lowering the average velocity).

Scale Tempo

This function will make the selected events play back faster (Scale factor 
above 100%) or slower (Scale factor below 100%). This is achieved by 
changing the position of the events (starting from the first selected event) 
and adjusting the length of the notes accordingly.

➜ The buttons [*2] and [/2] are “shortcuts” to Scale factors 200% and 
50%, respectively.
These are probably the most common values used, simulating double 
tempo and half tempo.

! This function affects all types of events: notes, controllers and pat-
tern changes! 

Alter Notes

This function alters the properties pitch, length and velocity of the selected 
notes in a random fashion. 

➜ The function will only “use” values that already exist among the se-
lected notes.
For example, if you have selected notes within a specific pitch interval, 
the altered notes will remain within this pitch interval. Similarly, only ve-
locity values and note lengths that were already used in the selection will 
be applied by the Alter function. You could say that the function “shuffles” 
the existing properties in a selection and redistributes them among the 
notes.

! This means that the less variation there is among the selected 
notes, the less the effect of the Alter function.

➜ You can adjust the amount of Altering with the Amount value.

✪ This function is especially useful for experimenting with REX loops. 
Select some notes on a Dr.Rex track and use Alter Notes to create 
instant variations, without losing the timing and rhythmic feel of the 
loop!
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Preferences – General

Mouse Knob Range

This lets you adjust the response sensitivity of the various knobs in Reason 
when manipulating them with the mouse. A higher sensitivity gives a higher 
degree of precision. You can choose between Normal, Precise and Very 
Precise.

Show Song/ReFill Splashes

This option allows you to decide whether the Browser should display the 
Splash Pictures or not when Browsing for a song or a ReFill. Furthermore, if 
this option is deactivated, song splashes will not be shown when you open 
songs.

Cable Animation

Cables in Reason are animated in a lifelike fashion when flipping the Rack 
and making connections. Should you so wish, you can choose to disable the 
cable movement animation by deactivating this checkbox.

Show Parameter Value Tool Tip

Normally, if you hold the mouse pointer over a parameter on a device panel 
for a moment, a Tool Tip appears displaying the name and the current value 
of the parameter. If you uncheck this option, Tool Tips will not be displayed.

Show Automation Indication

If a parameter is automated in the sequencer, this is, by default, indicated by 
a colored square around the parameter on the device panel. If you uncheck 
this option, automation will not be indicated.

CPU Usage Limit

Reason is a powerful program but also demanding in terms of processing 
power. The more devices you add to your rack, the more of your computer’s 
resources it will use.

Furthermore, as you use more and more of your computer resources for cre-
ating audio, less will be available for the user interface, resulting in slower 
performance in terms of graphics and overall responsiveness.

The CPU Usage Limit setting allows you to set a limit on how much of the 
CPU (computer processor) that can be used for creating audio. The remain-
ing capacity is reserved for the user interface and the graphics.

Set this so that you feel comfortable using the program, even when a very 
demanding song document is played back.
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Preferences – Audio

Master Tune

This lets you adjust the global tuning in Reason. Standard tuning is “middle 
A” at 440 Hz. You can adjust this by +/- 100 cents.

Audio Card Driver

This menu lists all the available Audio Card Drivers on your system, and lets 
you select which one Reason should use. Which option to select depends on 
the platform and the audio hardware:

➜ If you are using audio hardware for which there is a specific ASIO 
driver, you should select this.
With an ASIO driver written specifically for the audio hardware you will 
get lower latency (see below) and possibly better support for additional 
hardware features such as multiple outputs.

➜ Mac OS: If you are using the built-in audio hardware on the Mac, se-
lect “Sound Manager Default Output”.
This makes Reason communicate with the audio hardware using Apple 
Sound Manager (the sound driver protocol that comes with the MacOS).

➜ Windows: If there is no specific ASIO driver, you should select the 
Direct Sound driver for the audio hardware.
This makes Reason communicate with the hardware via Direct Sound (a 
part of the Microsoft DirectX package). For this to be possible, you need 
to have DirectX installed on your computer, and there must be a Direct 
Sound driver for the audio hardware.

➜ Windows: If the audio hardware doesn’t support Direct Sound (i.e. 
there is no Direct Sound driver for the audio hardware), select the 
MME driver for the audio hardware.
This makes use of Windows Multimedia Extensions, the part of Windows 
that handles audio, MIDI, etc. Using MME often results in larger latency 
values (see below).

Number of Channels

This displays the number of audio channels (outputs) the currently selected 
audio hardware supports. For a regular stereo card, this number will be “2”.

Control Panel

If you have selected an ASIO driver, this button brings up a control panel win-
dow specifically for that audio hardware. This may contain buffer settings, 
routing options, synchronization alternatives etc.

Sample Rate

This lets you specify the playback sample rate. The options available on this 
menu depends on which sample rates are supported by your audio hard-
ware.

Play in Background

When this is activated, Reason will not “release its grip” on the audio hard-
ware when another application is active.

• The advantage is that Reason will keep playing while you work in 
the other application.

• The disadvantage is that other audio applications may not be able 
to play any audio, depending on the type of driver used.



MENU AND DIALOG REFERENCE 185

Output Latency

The Output latency is the delay between when audio is “sent” from the pro-
gram and when you actually hear it. The latency in an audio system depends 
on the audio hardware, its drivers and their settings. 

If the latency is large, you will notice that the sound is delayed when you play 
a device from a MIDI keyboard. You may also notice that reactions are de-
layed when adjusting controls on the device panels (for example, if you lower 
the volume of a device, you will not hear this immediately but after the la-
tency time). Therefore, you want to get as low a latency value as possible.

When you select a driver, its latency value is automatically reported and dis-
played in the lower left corner of the Preferences-Audio dialog. Depending 
on the audio hardware and the driver, you may be able to adjust this value:

➜ If you are running Reason under Windows using a Direct Sound or 
MME driver, you can adjust the latency value by using the slider or 
the up/down arrow buttons.
The highest and lowest possible values depend on the driver.

➜ If you are using an ASIO driver specifically written for the audio 
hardware, you can in most cases make settings for the hardware by 
clicking the Control Panel button.
This opens the hardware’s ASIO Device Control Panel, which may or 
may not contain parameters for adjusting the latency. Usually this is done 
by changing the number and/or size of the audio buffers - the fewer and 
smaller the audio buffers, the lower the latency. Please consult the docu-
mentation of your audio hardware and its ASIO drivers for details!

➜ If you are running Reason on a Mac using the Sound Manager De-
fault Output driver, you cannot change the latency.

OK, so why not just set the latency to the lowest possible value? The prob-
lem is that selecting too low a latency is likely to result in playback problems 
(clicks, pops, dropouts, etc.). There are several technical reasons for this, 
the main one being that with smaller buffers (lower latency), the average 
strain on the CPU will be higher. This also means that the more CPU-inten-
sive your Reason song (i.e. the more devices you use), the higher the mini-
mum latency required for avoiding playback difficulties.

Latency Compensation

This control should normally only be adjusted when synchronizing Reason to 
external MIDI Clock.

Because of the latency problem, you might need to adjust Reason’s play-
back in relation to the MIDI Clock sync master, so that they are in perfect 
time. The tempo will not differ between the two, but Reason might play ahead 
or behind the other application. You might need to adjust this. However, this 
is something you only need to do once. The setting is stored with your other 
preferences, so you don’t need to adjust it again.

Proceed as follows:

1. Set up the other application so that it generates a solid click, on for 
example quarter or eighth notes, preferably with a special sound on 
the downbeat.
This click can either come from an internal metronome or from a MIDI 
source. If you use a MIDI source, make sure you pick one that has solid 
MIDI timing.

2. Set up Reason so that it plays a similar rhythm as the other applica-
tion.
You might for example use the Redrum drum computer for this.

3. Start the two applications in sync.

4. Make sure you hear both applications at approximately equal level.

5. Open the Preferences dialog in Reason and select the Audio page.

6. Trim the “Latency compensation” setting until the “clicks” from the 
both sources sound at exactly the same time.

7. Close the Preferences dialog in Reason.
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Preferences – MIDI

Sequencer Input

The Sequencer is the “standard” port for receiving MIDI input. This is what 
you should be using if you intend to use the Reason sequencer.

Once you have selected your MIDI interface on the Sequencer Port pop-up 
(and which channel it should receive on), you can direct incoming MIDI to 
any device by just clicking the “In” column to the left of a track name in the 
track list.

External Control Bus Inputs

The External Bus inputs provide up to 64 MIDI input channels divided into 
four buses, each with 16 channels.

➜ These MIDI inputs are primarily for controlling Reason Devices from 
an external sequencer.

This could be an external hardware sequencer or sequencer software that is 
installed on the same computer as Reason. You should preferably use a 
multiple port MIDI interface, so you can select separate ports for Reason and 
the other MIDI devices to use, although this isn’t strictly required.

Remote Control Input

The Remote Control input is used for assigning a MIDI port for receiving MIDI 
Controller messages. How to use Remote Control is described in the elec-
tronic documentation in the chapter “MIDI and Keyboard Remote Control”.

MIDI Clock Input

Using MIDI Clock, you can slave (synchronize) Reason to hardware devices 
(tape recorders, drum machines, stand alone sequencers, workstations etc.) 
and other computer programs running on the same or another computer. 
MIDI Clock is a very fast “metronome” that can be transmitted in a MIDI Ca-
ble. As part of the MIDI Clock concept there are also instructions for Start, 
Stop and locating to sixteenth note positions.

➜ By first selecting the appropriate MIDI input using the MIDI Clock 
pop-up and then selecting “MIDI Clock Sync” on the Options menu, 
Reason is ready to receive MIDI Clock sync. 
See the “Synchronization” chapter for more information.

Disable MIDI Priority Boost

Reason normally tries to trim your computer system so that MIDI Input gets a 
higher priority than it normally does. This is to ensure best possible perfor-
mance when for example recording notes via MIDI.

However, we can not guarantee that this attempt to boost MIDI priority will 
work on all systems and with all MIDI Interfaces. If you run into problems with 
your MIDI, try activating this switch.
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Preferences – Sound Locations

Sound and Patch Search Paths

Reason songs and patches can contain references to other files on your hard 
disk, such as samples. To keep track of all files, Reason makes use of a “da-
tabase”. If you keep your Reason files within the database, Reason can up-
date file paths, automatically search for missing files, etc.

This database consists of up to four different folders on disk (and all their 
subfolders). You specify which folders to use as database in the following 
way:

1. Click the “1” folder button below the heading “Sound and Patch 
Search Paths”.
A file dialog appears.

2. Navigate to the desired folder and select it.
You can select a folder on any drive (including mapped network drives 
under Windows).

3. Click OK.
The folder is added as the first search path in the database.

4. If you like, specify search path 2 to 4 in the same way.
It is normally enough to specify a single path, since all underlying folders 
are automatically included in the database. Use the additional paths if 
you use more than one hard drive, CD-ROM drives etc.

When you add sound files or save Reason files, you should place them 
within the database (under one of the specified search path folders).
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Create Menu
Sequencer Track
Tracks are automatically created when you create instrument devices in the 
rack. Still, you may need to create additional tracks (e.g. for recording effect 
device automation):

➜ To create a new sequencer track, pull down the Create menu and 
select Sequencer Track.
The new track will appear below the currently selected track in the track 
list. Initially, it will not be connected to any device.

➜ You can also create a new sequencer track specifically for a device 
by using the Create Sequencer Track for Device item on the de-
vice’s context menu.
This works the same as when creating a new device, i.e. the new track is 
connected to the device and has the same name.

Device List
To create a new device, select the desired item on the Create menu.

➜ The new device is added directly below the currently selected de-
vice in the rack.
If no device is selected, the new device is added at the bottom of the 
rack.

➜ When you add a new device, Reason attempts to route it in a logical 
way.

➜ A new track will automatically be created in the sequencer, and 
routed to the new device.
The track will have the same name as the device. MIDI input will also au-
tomatically be set to the new track, allowing you to immediately play the 
created device via MIDI. 

! By default, this only applies to instrument devices, not to mixers or 
effect devices. If you hold down [Option] (Mac) or [Alt] (Windows) 
when you create the device, the opposite is true, i.e. mixers and ef-
fect devices get new tracks but instrument devices don’t.

Options Menu
Internal Sync/MIDI Clock Sync/ReWire Sync
These three options are used to specify which type of tempo synchronization 
you prefer:

Internal Sync

When this is activated, the program is not synchronized to any external 
source. It plays in the tempo set on the transport panel.

MIDI Clock Sync

When this is activated, the program is synchronized to external MIDI Clock, 
as set up in the Preferences dialog. The tempo setting on the Transport is of 
no relevance, Reason plays in the tempo of the incoming MIDI Clock signals.

ReWire Sync

When this is activated, Reason is synchronized to another application via 
ReWire. This is not a setting that you can activate yourself, it is automatically 
enabled when the program is in ReWire slave mode.

Enable Keyboard Remote
When this is activated, keyboard keys can be used to control devices, as set 
up with the Edit Keyboard Remote feature.
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Edit Keyboard Remote
➜ To get an overview of which parameters are remote controllable se-

lect “Edit Keyboard Remote” from the Options menu. 
When done, each device you select will show a yellow arrow symbol be-
side every parameter that can be assigned a keyboard remote.

➜ If you click on an assignable parameter, a dialog appears allowing 
you to select a key command for that parameter.
You may use any key or a combination of [Shift] + any key.

➜ Simply press the key (or key combination) you wish to use to re-
mote control the parameter.
The “Key Received” field momentarily indicates that it is “learning” the 
keystroke(s), and then the dialog displays the name of the key you have 
pressed. If [Shift] was used, the box beside the word Shift in the dialog is 
ticked. 

! Note that the transport panel uses the numeric keypad for various 
commands. If you assign a parameter to a single numeric key, the 
corresponding transport functionality will be overridden!

About the two Edit Keyboard Remote Modes

If Edit Keyboard Remote is enabled (ticked) on the Options menu, assigned 
parameters are “tagged”, showing the remote key for that parameter. In this 
mode, however, you cannot operate Reason normally, as every parameter 
you click on will open the Key Remote dialog. This mode is primarily for over-
view of available parameters and the current assignments.

➜ Another way to assign keyboard remote commands is to have “Edit 
Keyboard Remote” deselected on the Options menu, and to simply 
[Ctrl]-click (Mac) / right-click (Windows) the parameter you wish to 
remote control.
This opens a pop-up menu, where one of the options will be “Edit Key-
board Remote”. Selecting this opens the Key Remote dialog. Thus, you 
do not have to enable/disable Edit mode from the Options menu if you 
know that a parameter is assignable.

! If you try to assign a Remote Key that is already in use, you will get 
an alert asking if you wish to change the current assignment.

Clear All Keyboard Remote
This menu command removes all keyboard mapping you have set up for the 
song.

Enable MIDI Remote Mapping
When this is activated, MIDI messages can be used to control devices, as 
set up with the Edit MIDI Remote feature.

Edit MIDI Remote Mapping
1. To get an overview of which parameters are MIDI remote controlla-

ble select “Edit MIDI Remote Mapping” from the Options menu. 
When done, each device you select will show a green arrow symbol be-
side every parameter that can be assigned a MIDI remote.

2. If you click on a assignable parameter, a dialog appears allowing 
you to select a MIDI controller (or a Note number) to control that pa-
rameter.
Note numbers function exactly like Keyboard remote - they can only con-
trol on/off or min/max values.

3. Make sure that the “Learn from MIDI Input” box is ticked.

4. Simply turn the knob (or slider etc.) that you wish to use to remote 
control the parameter.
The “MIDI Received” field momentarily flickers as you turn the knob, and 
then the dialog shows the controller number and the channel it is trans-
mitted on.

5. Click “OK” to exit the dialog.
The selected parameter now has a tag, displaying the controller number, 
and the MIDI channel used.

6. To exit Edit MIDI Remote Mapping mode, deselect it from the Op-
tions menu.
You do not always have to use this method - see below.

About the two Edit MIDI Remote Mapping Modes

If Edit MIDI Remote Mapping is enabled (ticked) on the Options menu, as-
signed parameters are “tagged”, and the arrow indicators show the assign-
able parameters. In this mode, however, you cannot operate Reason 
normally, as every parameter you click on will open the MIDI Remote dialog. 
The Edit mode is primarily for overview of available parameters and the cur-
rent assignments.

➜ Another way to assign keyboard remote commands is to have “Edit 
MIDI Remote Mapping” deselected on the Options menu, and to 
simply [Ctrl]-click (Mac) / right-click (Windows) the parameter you 
wish to remote control.
This opens a pop-up menu, where one of the options will be “Edit MIDI 
Remote Mapping”. Selecting this opens the MIDI Remote dialog. Thus, 
you do not have to select Edit mode from the Options menu if you already 
know that a parameter is free and assignable.
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Clear All MIDI Remote Mapping
This menu command removes all MIDI Remote mapping that you have set 
up for the song.

Toggle Rack Front/Rear
This switches the rack between the front and rear views. A quicker way to do 
this is to press [Tab].

Show Cables
If you have made many connections in Reason, the cables can sometimes 
obscure the view, making it difficult to read the text printed on the back pan-
els of the devices. You can hide/show all cables in the following way:

➜ Select “Show/Hide cables” on the Options menu to hide all cables.
When cables are hidden, connections are indicated by a colored connec-
tor. Repeating the above procedure makes the cables appear again.

➜ When hidden, you can still connect or disconnect cables in the 
same way as when they are shown.

Checking Connections

It is possible to check to which device a jack is connected, which is useful if 
the cables are hidden, or if the connected devices are located far apart in the 
rack:

➜ Positioning the pointer over a connector makes a tool tip appear af-
ter a moment, showing the device and the specific connector at the 
other end.

Follow Song
When this is activated, the sequencer Arrange and Edit views will scroll with 
the song pointer, on playback. When this item is deactivated, the view will not 
scroll automatically.

Windows Menu 
(Windows Version)
Stay on top
When this is activated, the Reason window will always stay on top of other 
program’s windows.

Adjust frame to clients
This changes the size of the application window so that it exactly fits the doc-
ument windows.

Cascade
This moves and resizes the open song documents, so that they are arranged 
in an overlapping pattern.

Tile Horizontally
This moves and resizes the open song documents, in a horizontal pattern.

Tile Vertically
This moves and resizes the open song documents, in a vertical pattern.

Arrange Icons
If you have minimized windows and moved them around in the application 
window, this command cleans up their positions on screen.

Window List
This lists all open song documents. Selecting one makes it the active win-
dow.
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Windows Menu (MacOS 
Version)
Window list
This lists all open song documents. Selecting one makes it the active win-
dow.

Help/Contacts Menu 
Contents (Windows only)
This menu item opens up the Help system with the Contents tab selected.

Index (Windows only)
This menu item opens up the Help system with the Index tab selected.

Search (Windows only)
This menu item opens up the Help system with the Search tab selected.

Internet Page Menu Options

About the Internet menu alternatives

Regardless of which of the Internet options you select, you will be connected 
to the Internet using your preferred browser. The browser will then take you 
to the page specified in the dialog.

Go to the Propellerhead Homepage
This takes you to the main entrance on the Propellerheads web site.

Download Reason Songs
This takes you to our archives of song files that you can download and use. 
You can also contribute with your own creations!

Download Reason ReFills
This takes you to ReFill archives with the latest offerings in free sounds for 
Reason!

Reason Tech Info and Support
If you have a problem or a technical question, this is the place to go!

Order Reason Now
This allows you to purchase your own personal copy of this exquisite applica-
tion!
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Register Reason Now
This takes you to the Propellerhead Software registration pages. Once regis-
tered you can download free sounds, chat with other Reason users and up-
load songs for others to hear!

About Reason (Windows only)
This menu item opens up a dialog that informs you about the version of the 
program and the people behind it.
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General Information
Audio Quality
The general audio quality in a computer based synthesizer system depends 
on two things:

➜ The quality of the software calculating the audio.

In our case, this is the Reason DSP (Digital Signal Processing) code.

• Reason uses 32-bit floating point arithmetic for all internal audio op-
erations which ensures the highest possible resolution throughout 
the signal chain.

• The program supports 16, 20, and 24 bit audio output.
• The program supports sampling frequencies from 22kHz to 96kHz.
• A number of digital audio techniques are implemented that reduce 

the risk of “aliasing”, background noise, unwanted distortion and 
“zipper noise”.

There is no technical reason why this program should not sound as good as 
or better than dedicated, professional hardware.

➜ The quality of the hardware playing back the sound.

In a PC this is the sound card. In the Mac it is the built in audio circuitry or any 
audio card you have installed. Don’t be fooled by the “16 bit, 44.1kHz, CD 
quality” tags. How good some audio hardware actually sounds depends on a 
number of things, its frequency range and frequency response curve, the sig-
nal to noise ratio, the distortion under various circumstances, etc. Further-
more, some designs are more prone to disturbance from the other 
electronics in the computer, than other. Such disturbance might add hum or 
high pitched noise to the signal.

As you probably understand by now, this is a big subject and there’s no way 
we can help you find the right solution in this manual. There are a number of 
text books and magazines covering this subject and any music dealer spe-
cializing in computers will happily help you out. The only advice we can give 
is that if you are serious about sound, choose your audio hardware carefully! 

About Latency
On any personal computer system, there is a delay between the moment you 
“ask” the hardware to play a sound and when it actually does it. This delay is 
referred to as the “latency” of the design. This imposes a problem for any 
system where you want real time user input to affect the sound.

! See the Getting Started book for basic information on adjusting 
Output Latency!

Why is there latency?

Any audio application creates its audio in chunks. These chunks are then 
passed on to the audio card where they are temporarily stored before being 
converted into regular audio signals.

The storage place for these chunks are called “buffers” (an analogy would be 
a bucket brigade, where a number of people each have a bucket, and water 
is poured from one bucket to another to reach its final destination).

The smaller the buffers and the fewer they are, the more responsive the sys-
tem will be (lower latency) However, this will also raise the demands on the 
computer and its software. If the system can’t cope up with moving the data 
to and from the buffers fast enough, there will be problems that manifest 
themselves as glitches in audio playback.

To make things worse, audio playback always competes with other activities 
on your computer. For example, under Windows, an Output Latency setting 
that works perfect under normal circumstances might be far too low when 
you try to open files during playback, switch over to another program while 
Reason is playing or simply play back a very demanding song.

What is acceptable?

Normally, hardware synthesizers provide you with a latency of 3 to 7 ms (mil-
liseconds – thousands of a second), at least if the instrument is targeted to-
wards a “professional” audience.

On a regular PC or Mac, the latency can vary from anything from 2ms to 
750ms! This wide range of values is an effect of the fact that computers and 
their operating systems were created for many purposes, not just playing 
back audio. For multimedia and games, a latency of a 100ms or more is per-
fectly acceptable, but for playing a musical instrument it is not!

• The internal audio under MacOS provides an output latency of 
11ms. This is deemed acceptable by most users.

• A regular PC “SoundBlaster” type audio card with an MME driver 
(see later in this chapter) might at best give you a latency of around 
160ms.

• The same card with a DirectX driver provides at best around 40ms.
• The best possible situation is a card specifically designed for low 

latency, with an ASIO driver, which can give you figures as low as 3 
ms under both MacOS and Windows. This is just as good as any 
dedicated hardware synthesizer!

Reason’s built in sequencer is not affected by latency!

When Reason’s sequencer is playing back a song, the timing between notes 
is perfect! Once playback of a Reason pattern or song is up and running, la-
tency isn’t a consideration at all. The computer clocks the audio between the 
steps and does this with perfect quartz accuracy! The timing is immaculate!
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ReWire and Latency

When you run Reason as a ReWire slave, it is the other program, the Rewire 
master that is responsible for actually creating the audio and playing it back 
via the audio card. This means that it is the master program’s latency you will 
get as a final result.

! When Reason runs as a ReWire slave, what audio card you have, 
what driver you use, and settings you have made in the Preferences 
dialog are of no importance at all! All audio card settings are then 
instead done in the ReWire master application!

For information on ReWire, see the chapter “Using Reason as a ReWire 
Slave”.

Reducing latency

✪ Please note that internal audio under MacOS has a fixed latency of 
11ms which is very stable under all normal circumstances. The tips 
below are for Windows users and for MacOS users with additional 
audio cards.

There are a few general methods for making sure latency is as low as possi-
ble:

➜ Use a card with an ASIO driver.
While this in itself is no guarantee for low latency, ASIO drivers generally 
perform better than MME or DirectX.

➜ Select an audio card that supports low latency (small buffers) and 
which is known for well written ASIO drivers.

➜ Remove background tasks on your computer.
This might be any background utility you have installed as well as net-
working, background internet activities etc.

➜ Optimize your songs.
You might run into situations where you have to raise the Output Latency 
setting to be able to play back a very demanding song on your computer. 
Another option would be to actually optimize the song. See the chapter 
“Optimizing Performance” for details.

➜ Get a faster computer.
This is related to the point above and only required if you find that you 
need to increase Output Latency because your computer can’t really 
cope with the songs you try to play.

PC Specific Information
About ASIO DirectX, MME and the Sound Buffer 
setting
There are three ways for Windows to access an audio card:

Via an MME (MultiMedia Extensions) driver

This system has been around since Windows 3.0, and it is this type of driver 
that is normally installed in the Control Panel and via Plug’n’Play. Most regu-
lar sound playback (like when Windows goes “bing” on startup) happens via 
MME.

• Practically all cards come with an MME driver. If your card appears 
in the System part of the Control Panel, you have an MME driver in-
stalled.

• Using a card via an MME driver gives you the worst latency figures, 
especially under Windows 98.

• Only one program at a time can use a card accessed via MME.

Via a DirectX driver

DirectX is a later system developed by Microsoft to provide developers with 
more efficient routines to access audio.

• Not all cards come with DirectX drivers. However, drivers for some 
cards are included with DirectX itself.

• Using a card via a DirectX driver gives you a shorter latency, be-
tween 40 and 90 milliseconds under Windows 98.

• If you use DirectX 3 or later, all programs that access the card via 
DirectX and make use of the DirectX “secondary buffer” feature can 
use it at the same time, and Reason can play in the background.

! Only use DirectX if you are sure that there is a “certified” DirectX 
driver installed for your sound card.

• If in doubt, contact your audio card vendor to check whether there’s 
a DirectX driver for your card or not.

✪ More information about DirectX can be found on Microsoft’s DirectX 
web pages, at www.microsoft.com/directx.
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Via an ASIO Driver

This is your best option if it is available. More and more audio cards designed 
for serious music and audio use come with ASIO drivers.

As stated above, ASIO does not guarantee low latency, but it allows for it if 
the audio card designers take advantage of its possibilities.

• Not all cards come with ASIO drivers. If in doubt check with the au-
dio card manufacturer.

• Using a card via an ASIO driver can give latency figures as low as 
3ms.

• When you use ASIO, only one program at a time can access the 
card.

✪ More information about ASIO can be found on Steinberg Media 
Technologies’ web pages, www.steinberg.net.

Intel vs. Other Processors
When you run Reason under Windows, the clock speed of the processor is a 
major factor determining how many devices you can use at the same time. 
However, there are other factors that should be take into account, and one 
important such factor is “floating point arithmetic performance”.

All audio operations in Reason are done with floating point calculations 
(counting with decimal numbers rather than with non-decimal numbers, inte-
gers) to ensure the highest possible audio quality. You can get high audio 
quality on an integer system too, but floating point is effective and accurate 
when it is available.

Intel Pentium processors are fast at floating point mathematics. Some other 
lower priced processor have taken shortcuts which reduce their performance 
in this particular aspect. This will have noticeable effect on the performance 
of the program. Our advice is:

✪ If you plan to buy a computer specifically for Reason, you can play 
it safe and choose an Intel processor. Alternatively, make sure you 
select a processor that is renowned for high floating point arith-
metic performance!

Macintosh Specific 
Information
Under Mac OS there are two ways you can play back audio:

• Using the Sound Manager
• Using ASIO

What the Sound Manager does/is

The Sound Manager is a set of software routines in the MacOS. These rou-
tines take care of everything related to sound. If you are using the internal 
audio on your Macintosh computer you are using the Sound Manager, it is 
built into the system. 

One specific character of the Sound Manager is its ability to mix audio from 
several applications. This means that even when you run Reason, you can 
run other Sound Manager compatible applications at the same time, and 
they will all sound.

Mac Audio Cards that play back via the Sound Manager

There are a few rare Mac audio cards that play back via the Sound Manager.

! If you have an audio card for your Macintosh, we strongly recom-
mend you to try and find an ASIO driver for it instead of using a 
Sound Manager driver. This will give you higher reliability and per-
formance.

Mac Audio Cards with an ASIO Driver

An audio card with an ASIO driver is your best option if it is available. ASIO 
does not guarantee low latency, but it allows for it if the audio card designers 
take advantage of its possibilities.

• Using a card via an ASIO driver can give latency figures as low as 
3ms.

• When you use ASIO, only one program at a time can access the 
card.

• Note that to use ASIO you need to add an ASIO driver file to the 
ASIO Drivers folder in your Reason folder.
If several program take advantage of ASIO this means you will have to 
duplicate this driver to each program’s ASIO Driver folder.

✪ More information about ASIO can be found on Steinberg Media 
Technologies’ web pages, www.steinberg.net.
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About This Chapter
This chapter briefly describes the way various MIDI messages are imple-
mented in Reason. It is mainly intended for those who control the rack di-
rectly via MIDI, but direct MIDI input can also be put to good use when 
recording into the sequencer.

The basics on how to send MIDI to Reason is described on page 41 and 
page 43. This chapter only deals with the details on various MIDI messages.

MIDI Direct Control vs. MIDI Remote
Please do not confuse direct MIDI control of devices with MIDI Remote.

• Direct MIDI Control uses a fixed set of MIDI messages for each de-
vice whereas MIDI Remote requires you to define which MIDI mes-
sage to use for a certain control.

• MIDI Remote can not be recorded into the sequencer. If you send 
MIDI Controller messages via the sequencer input, they get re-
corded along with all other MIDI data, just as if you moved the con-
troller with the mouse.

ReWire vs. Regular MIDI
You can use ReWire 2 to send MIDI messages to Reason. This uses exactly 
the same MIDI implementation as regular MIDI. 

The MIDI Implementation Charts
In your program folder you will find a document called MIDI Implementation 
Charts.pdf. This contains tables of how all MIDI messages are implemented 
in various devices. Below follows a summary of various MIDI messages and 
their use.

How various MIDI 
messages are 
Implemented
Notes
The machines that receive MIDI notes are:

• Mixer 14:2 (for muting, soloing and activating EQ).
• Subtractor
• NN19 
• Redrum
• Dr. Rex

The exact ranges and usage can be found in the MIDI Implementation 
Charts.

Controllers
Reason makes heavy use of MIDI controllers. Practically all controls on all 
devices can be controlled via MIDI.

The exact implementation of for each device can be found in the MIDI Imple-
mentation Charts.

Modulation wheel, Expression and Breath can on some devices be routed to 
various controls by use of the device’s front panel.

Pitch Bend
This is implemented on all devices where it makes sense to be able to bend 
notes via MIDI. Where pitch bend is implemented, there is a bend range con-
trol on the front panel.

Aftertouch
This is implemented on Subtractor and NN19. It can be used to modulate 
various parameters.

Program Change and Polyphonic Aftertouch
These two MIDI messages are not implemented in any device.
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A
ADSR 110
Alter

Drum 92
Notes 30, 182
Pattern 92, 150

Arrange View 13
ASIO Driver 196
Audio Card Driver 184
Audio Out Clipping 74
Audio Outputs 79
Audio Quality 194
Automap Samples 125, 177
Automatic Quantize 29
Automation

Clearing 25
Editing 23
Pattern Changes 8
Recording 7
Resetting during recording 7
Showing and Hiding 23
Showing in Device Panels 183
Static Controller Value 6

AUX Sends and Returns 85

B
Bipolar Curves 149
Bit Depth 174
Browse Device Patches 176
Browse Samples 177
Bypass 158

C
Cables

Color 35
Deactivating Animation 183
Disconnecting 36
Dragging 36
Hiding and Showing 34

CF-101 Chorus/Flanger 164
Chaining 86
Change Events 29
Channel 8 & 9 Exclusive 95
Chorus 164
Clear All Keyboard Remote 189
Clear All MIDI Remote Mapping 190
Clear Automation 25, 27, 180
Click 74
Clipping 74
Compressor 166
Computer Power 66
Controller pop-up menu 23
Controllers see Automation
Convert Pattern Track to Notes 11
Copy 175
Copy Pattern to Track 10
CPU Meter 66, 75
CPU Usage Limit 183
Create Sequencer Track for... 188
Cubase VST 48
Curve (Matrix)

About 146
Unipolar/Bipolar 149

Cut 175
CV

About 34
Routing 37
vs. Gate 148

CV Trim knobs 37

D
D-11 Distortion 161
DDL-1 Delay 160
Decay/Gate Switch 94
Delay 160
Delete Unused Samples 124
Digital Performer 51
DirectX Driver 195
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Disable MIDI Priority Boost 186
Disconnect (Routing) 36
Distortion 161
Dr.Rex

About 134
Adding Loops 135
Editing Slices 137
Parameters 138
Playing from Sequencer 136

Drawing
Automation 24
Groups 16
Notes 21

Drum Lane 20
Duplicate Track 14
Dynamics 91

E
E Marker 174
ECF-42 Envelope Filter 161
Edit Automation 23
Edit Keyboard Remote 57
Edit MIDI Remote Mapping 56
Edit View 19
Enable Keyboard Remote 57
Enable MIDI Remote Mapping 55
Enable Pattern Section 11, 92
Envelope Filter 161
Envelopes 110
EQ

Mixer 83
Parametric 167

Export Device Patch 173
Export MIDI File 31
Export Song/Loop as Audio File 174
Ext Mod 116
External Control Bus Inputs 40

F
Filter

Dr.Rex 138
Effect Device 161
Sampler 127
Subtractor 106

Find Identical Groups 18
Flam 92
Flanger 164
FM 104
Focus switches 74
Foldback 161
Follow Song 190

G
Gate

About 34
Programming in Matrix 147
Routing 37
vs. CV 148

Gate (Matrix) 146
Gate mode (Redrum) 94
Get User Groove 29
Grooves 29
Groups 16

H
Hardware Interface 78
Help Menu (Windows) 191
Hide All Controllers 23
High Quality Interpolation 96, 142
HLD 42
Host application 46
Hubi’s Loopback Device 42

I
IAC 41
Import MIDI File 31
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Redrum 89
Sampler 121
Subtractor 100

Input meter (Effect devices) 158
Insert Bars Between Locators 15
Internet Options 191

K
Key Lane 20
Key Maps 120, 123
Key Zones 120, 122
Keyboard Remote 57
Keys (Matrix) 146

L
Lane buttons 19
Latency 66, 194
Latency Compensation 63
Locators 73
Logic 50
Loops

Creating Sequencer Notes 136
Editing Slices 137
Editing Sound 138
In Drum Samples 94
In Samples 124
Loading 135

Low BW 131, 142

M
Master Tune 184
Matrix

About 146
Application Examples 152
Programming 147

Maximize Sequencer 20
Memory Requirements 69
MIDI Clock 60

MIDI Clock Input 40
MIDI Files 31
MIDI In Device 78
MIDI Inputs

About 40
Setting Up 41

MIDI Remote
Clearing 190
Mapping 56
Selecting Input 54

MIDI Sync 74
Mixer

About 82
Chaining 86
Signal Flow 84

MME Driver 195
Mono

Considerations 67
In Effect Devices 158
Samples 121

Mouse Knob Range 183
MultiMedia Extensions Driver 195
Mute

Mixer 83
Redrum 93

N
New 170
NN-19

About 120
Loading Samples 122
Parameters 126

Notes
Altering 30, 182
Editing 21
Editing Velocity 22, 30, 182
Recording 6
Transposing 30, 181
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OMS 41
Open 170
Outputs 79
Overdub/Replace 6

P
Parametric EQ 167
Paste 175
Patch Cables 36
Patches

Browsing 176
Exporting 173
Missing Sounds 176
Redrum 89
Sampler 121

Pattern Changes
Clearing 27
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Editing 25
Recording 8

Pattern Controlled Filter 163
Pattern Shuffle 91
Patterns

Matrix 147
Muting 92
Redrum 90
Transferring between songs 176

Pencil tool
Controllers 24
Groups 16
Notes 21

PEQ-2 EQ 167
Phase Controls (Subtractor) 103
Phaser 165
Polyphony

Dr.Rex 142
Sampler 131
Subtractor 116

Preferences Dialog 183
Preview (Dr.Rex) 135
Processing Power 66
Publish Song 171
Punched In 7

Q
Quantize 28
Quantize Notes during Recording 29

R
RAM 69
Randomize

Drum 92
Pattern 92, 150

RCY files 134
Reason Hardware Interface 78
Reason Song Archive 171
ReBirth Input Machine 156
Recording

Controllers see Automation
Notes 6
Pattern Changes 8

ReCycle 134
Redo 175
Redrum

Individual Outputs 97
MIDI Notes for 96
Parameters 93
Patches 89
Programming Patterns 90

Registering Reason 192
Remote Control Input 40
Remove Bars Between Locators 15
Replace mode 6
Reset (Automation) 7
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Groups 17
Lanes in Edit View 19
Notes 22

Resolution (Audio) 174
Resolution (Pattern) 91
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ReWire
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Setting Up 47
With Cubase VST 48
With Digital Performer 51
With Logic 50
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REX files 134
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Automatic 35
Manual 36
Pop-up Menu 36

Run button 90
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S
S1/S2 controls 93
Sample Rate

For Playback 67
In Exported Audio 174

Sampler
About 120
Loading Samples 122
Parameters 126

Samples
Browsing 177
Extracting from Self-contained Songs 172
NN-19 122
Redrum 88

Save Song 170

Scale Tempo 30, 182
Select All 13
Selecting

Automation 24
Events in the Arrange View 13
Groups 17
Notes 21
Pattern Changes 26

Self-contained Songs 172
Send Out (Redrum) 93
Sends

Mixer 84
Redrum 93

Sequencer
Bypassing 44
MIDI Input 40
Transport Controls 72

Shift
Drum 92
Pattern 92, 150

Show All Automated Controllers 23
Show All Device Controllers 23
Show Parameter Value Tool Tip 183
Shuffle 91
Slices

About 134
Creating Sequencer Notes 136
Making Settings for 137
Selecting 137
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About 12
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Solo
Mixer 83
Redrum 93

Song Archive 171
Song Information 171
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Songs
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Self-contained 172
Splash Picture 171

Sound and Patch Search Paths 187
Sound Manager 196
Splash Picture 171
Stereo

Considerations 67
In Effect Devices 158
Samples 121

Subtractor
About 100
External Modulation 116
Filter 106
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Waveforms 101

Sync
About 60
Internal/MIDI Clock/ReWire 188
Latency 63
Setting Up 60

T
Tempo 73
Tie switch 149
Time Signature 73
To Track 10, 136
Toggle Rack Front/Rear 190
Tool Tips 183
Tracks

Creating 7, 188
Cut, Copy and Paste 14
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Transport Panel 72
Transpose 30, 181
Trigger buttons (Redrum) 89
Trim knobs 37

U
Undo 175
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V
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W
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Windows MME Driver 195
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